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Document History

1 Note

Before you start the implementation, make sure you have the latest version of this document, which is

available at https://support.sap.com/sltoolset#s | » System Provisioning 3System Copy Option of Software
Provisioning Manager .
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1 Introduction

1.1 Homogeneous and Heterogeneous System Copy

This document describes how to perform a homogeneous or heterogeneous system copy of an SAP system
based on SAP NetWeaver 7.0 (including Enhancement Packages) Java with source operating system Windows ,
using Software Provisioning Manager 1.0 SP22 (“installer” for short), which is part of SL Toolset 1.0 SP22.

1 Note

SAP NetWeaver 7.0x Application Server Java reached end of maintenance by the end of 2017. SAP
recommends upgrading to a more recent version. For more information, see SAP Notes 1648480 and
2595196 # .

The following target databases are supported:

e |BM Db2 for Linux, UNIX, and Windows
e |[BM Db2 for z/0S

e SAP MaxDB

e Oracle

e MS SQL Server

e SAPASE

You can use either database-specific methods or database-independent methods.

For a detailed list of SAP system products and releases covered by this guide, see SAP Note 2595196#% . For
information about supported operating system and database platforms, see the Product Availability Matrix at
http://support.sap.com/pam#te.

1 Note

As an alternative to using Software Provisioning Manager, you can copy or refresh your system with a
completely automated end-to-end framework available using SAP Landscape Virtualization Management.
For more information, see SAP Note 1709155# and https://help.sap.com/lama .

1.2 Naming Conventions

e Software Provisioning Manager 1.0
Software provisioning manager is the successor of the product- and release-specific delivery of
provisioning tools, such as SAPinst. Before you perform an installation or system copy, we recommend
that you always download the latest version of the software provisioning manager, which is part of the
Software Logistics Toolset (“SL Toolset"” for short). This way, you automatically get the latest SAPinst
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version including latest fixes in the tool and supported processes. For more information about software
provisioning manager as well as products and releases supported by it, see SAP Note 168004 5¢t .
SAPinst has therefore been renamedto software provisioning manager 1.0 (“installer” for short)
in this documentation. However, the term “SAPinst” is still used in:
o Texts and screen elements in the software provisioning manager (“installer”) GUI
o Naming of executables, for example sapinst
© Naming of command line parameters, for example SAPINST USE HOSTNAME
o Operating system user groups, for example additional group sapinst
In the following, we generally refer to software provisioning manager 1.0 asthe “installer”. We only
use the term “software provisioning manager” if this is required for technical reasons.
System Copy
Duplication of an SAP system. The SAP system ID and certain other SAP parameters might be changed in
a copy. When you perform a system copy, the tool installs all the instances again, but it uses a copy of the
source system database to set up the database.
The following use cases are possible:
o Initial System Copy
The tool newly installs all the instances of a source system, but it uses a copy of the source system
database to set up the database in the target system.
o Refresh
Overwriting of an already existing target system with the database content from a source system.
The refresh use case is not supported using the software provisioning manager.
Homogeneous System Copy
During the system copy, you use the same operating system and database platform as the original system.
Heterogeneous System Copy
During the system copy, you change either the operating system or the database system, or both.
Heterogeneous system copy is a synonym for migration.
Source System and Target System
The SAP system containing the original database is called the source system and the system to which the
database copy is to be imported is called the target system. Their SAP system names are abbreviated to
SOURCE SAPSIDand TARGET SAPSID. Theterms source database and target database are also used in
this description.
Database Copy
Database-dependent part of the system copy.
Placeholders
Placeholders such as <sAPsSID> are used in commands. They are used in the same way as in the SAP
system installation documentation. You must replace them with the values valid for your site.
The following additional placeholders are used:

Placeholder ’ Meaning

<SAPSID> SAP system ID

<S_HOST> System name of the source host (command hostname)
<T_ HOST> System name of the target host (command hostname)
<S_SAPSID> SAP system ID <sAPSID> of the source system
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Placeholder ’ Meaning
<T SAPSID> SAP system ID <sAPSID> of the target system
<S_DBSID> Database ID <DBSID> of the source system
<T_DBSID> Database ID <DBSID> of the target system
<0Ss> Operating system name within a path
<DB> Database name within a path
<Technology> ABAP, Java, or ABAP+Java

1 Note

Database ID <DBS1ID> identifies the database instance. The installer prompts you for the <DBSID> when you
are installing the database instance.

The <DBSID> can be the same as the <SAPSID>.

1.3 New Features
The sections below provide an overview of the new features in Software Provisioning Manager 1.0
(the" installer” for short).

Make sure that you also read the Release Notes for your SAP product at https:/help.sap.com# | <Search

your SAP Product>  <Select your SAP Product Version> » What's New 3.

Feature Description Availability
Installer Log Files Im- | Installer log files are now available immediately after the installer has been Software Provi-
provements started, that is before a product has been selected on the Welcome screen. sioning Manager
For more information, see Useful Information About the Installer [page 42] 1.0 SP22 (SL Tool-
and Troubleshooting with the Installer [page 46]. set 1.0 SP22)
Media Signature The signature of media is checked automatically by the installer during the S_oftyvar:/lProvi—
Check Define Parameters phase while processing the Media Browser screens. As of stoning Manager

] ) ] 1.0 SP21 (SL Tool-
now the installer only accepts media whose signature has been checked. See set 1.0 SP21)

also the description of this new security feature in SAP Note 2393060#% .

For more information, see Preparing the Media Required for Performing the
Export [page 30] and Running the Installer [page 38].
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Feature

Description

Availability

Support of Oracle Da-
tabase Vault

Caution

Although Oracle Database Vault is already available in the installer and
documented in this guide, it is not yet released to customers until further
notice. For more information, see the Current Restrictions section in SAP
Note 1680045 #r .

Oracle Database Vault 12¢ has been certified for SAP products that are based
on SAP NetWeaver technology.

You can now copy an SAP system with Oracle Database 12c and configure
Oracle Database Vault in the database of the target system.

Oracle Database Vault is supported for all system copy methods [page 18]
described in this documentation.

For more information, see Implementing Oracle Database Vault with the In-
staller [page 135].

Software Provi-
sioning Manager
1.0 SP21 (SL Tool-
set 1.0 SP21)

Support of Oracle
12.2

Software Provisioning Manager (the “installer”) now supports system copy for
SAP systems with Oracle 12.2.

Software Provi-
sioning Manager
1.0 SP21 (SL Tool-
set 1.0 SP21)

SL Common GUI with
SAPINST 7.49

With the new installer framework version SAPINST 7.49, you can now use the
new SAPUI5-based graphical user interface (GUI) “SL Common GUI". For
more information, see Useful Information About the Installer [page 42], Run-
ning the Installer [page 38].

Software Provi-
sioning Manager
1.0 SP20 (SL Tool-
set 1.0 SP20)

Verification of Integ-
rity of Data Units in
Software Provisioning
Manager

The integrity of data units extracted from the Software Provisioning Manager
archive is verified. For more information, see Downloading and Extracting the
Software Provisioning Manager 1.0 Archive [page 31].

In addition, check SAP Note 1680045#% whether additional information is
available.

Software Provi-
sioning Manager
1.0 SP19 (SL Tool-
set 1.0 SP19)

Adjust instancelD of
an SAP Java System

An inconsistency of the instanceID parameter is caused by using an unsup-
ported procedure to create or maintain the system. When instanceIDis not
consistent, future running of software logistscs scenarios, such as system
copy, system rename, dual-stack split, upgrade, and so on might fail. The op-
tion Adjust instancelD for a Java System helps you to overcome this. It is avail-

able in Software Provisioning Manager as option |} Software Life-Cycle
Options > Additional Preparation Options > Adjust instancelD for a Java
System ]

For more information, see Verifying and Adjusting the instancelD of an AS
Java Instance [page 141].

Software Provi-
sioning Manager
1.0 SP10 (SL Tool-
set 1.0 SP16)
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Feature

Description

Availability

Diagnostics Agent

The Diagnostics Agent is no longer installed automatically with the SAP sys-
tem. The Install Diagnostics Agent check box on the Install Diagnostics Agent
screen is no longer available.

You now have to install the Diagnostics Agent always separately. We recom-
mend that you install it prior to the installation of your SAP system(s).

For more information, see the Diagnostics Agent Installation Strategy at-
tached to SAP Note 1365123, to SAP Note 1833501#%, and to SAP Note
1858920#% and the attached Diagnostics Agent Setup Guide.

Software Provi-
sioning Manager
1.0 SP10 (SL Tool-
set 1.0 SP16)

Executing R3szchk in

Oracle, IBM Db2 for z/0S:

Software Provi-

sioning Manager
Parallel You can now execute R3szchk in parallel. Using this feature you can improve g g
: 1.0 SPO8 (SL Tool-
the runtime of the export.
set 1.0 SP13)
Support of Oracle 12 | You can now perform all Software Provisioning Manager 1.0 tasks (installation, | Software Provi-
database system copy, system rename, dual-stack split) for SAP systems with the sioning Manager

Oracle 12 database.

For more information, see http://support.sap.com/pam#r .

1.0 SPOS (SL Tool-
set 1.0 SP13)

Feedback Evaluation
Form available in the

Software Provisioning

Manager:

SAP SE's aim is to provide fast and efficient procedures. To evaluate the pro-
cedure you just carried out, we need information generated by the tool during
process execution and your experience with the tool itself. A new evaluation

form contains a simple questionnaire and XML data generated during the pro-

cedure.

Port 4239 is used for displaying the feedback evaluation form. For more infor-
mation, see the Prerequisites section in Running the Installer [page 38].

Software Provi-
sioning Manager
1.0 SPO7 (SL Tool-
set 1.0 SP12)

1.4 Accessing the SAP Library

The references to the SAP NetWeaver Library documentation in this guide always refer to the following on the
SAP Help Portal:
e SAP NetWeaver 7.0:
http://help.sap.com/nw70#% | » Application Help » SAP NetWeaver by Key Capability 3
e SAP NetWeaver 7.0 including Enhancement Package 1:
http://help.sap.com/nw701#%|p » Application Help » SAP NetWeaver by Key Capability 3
e SAP NetWeaver 7.0 including Enhancement Package 2:
http://help.sap.com/nw702#% | » Application Help » SAP NetWeaver by Key Capability 3
e SAP NetWeaver 7.0 including Enhancement Package 3:
http://help.sap.com/nw703#& | » Application Help » SAP NetWeaver by Key Capability 3

System Copy for SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to
7.03 on Windows

Introduction PUBLIC 13


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1365123
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1833501
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1858920
http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Fpam
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw70
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw701
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw702
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw703

1.5 Constraints

14

Only perform a system copy if you have experience in copying systems and thorough knowledge of the

operating system, the database, and the Java Dictionary . Only perform a heterogeneous system copy (of a

production, development, or test (QA) system) if you are a certified system support consultant or a

certified SAP Technical Consultant.

The target system installation consists of both the target database and target instance/application server

installations. For the scenarios below, the following holds:

o Refreshing the database is not supported. Refreshing the database means that only the database is

loaded with the content of a database of a different system. Since no migration controller is invoked in
this scenario, this is not supported.

o Option |+ Generic Installation Options j JRefresh Database Content is not supported for Java
systems.

o Copying only the database is not supported.

o Copying only the central instance of a system having dialog instances - that means the dialog
instances are preserved in the target system - is not supported. The migration controller deletes all
dialog instances in the database, so the system is not complete any longer.

Make sure that the export is consistent with the database. For example, the system must not be online
during the period between when you start exporting the source central instance and when you install
the target central instance.

o Reinstalling the central instance using option Central Instance in the Target System Installation folder
without the database is not supported . The migration controller deletes all dialog instances in the
database, so the system is not complete any longer.

This might even cause additional problems. For more information, see SAP Note 966752 ¥ .
IBM Db2 for Linux, UNIX, and Windows only:

o The option Deferred Table Creation is not supported for load-based system copies for SAP systems

that are not based on SAP NetWeaver 7.0 EHP 1 or higher.

System copy is not supported for the Diagnostics Agent.

For more information and guidance see the Diagnostics Agent Maintenance Procedures article at http://
wiki.scn.sap.com/wiki/x/n4efFg .

When you perform a system copy, all software units or usage types in the source system are copied to the
target system. This means that none of the usage types in the target system can be excluded from the
system copy, nor can you select usage types.

SAP Solution Manager only:As of Support Release 4, your SAP Solution Manager 7.0 system must be a
dual-stack system if you want to perform a system copy. If required, install a Java Add-In to your existing
ABAP system before you start the export.

SAP does not support client transport as a system copy method. Transporting production clients is not
supported at all. You can use client transport for the initial setup of an SAP system infrastructure. This
documentation does not cover the client copy procedure.

This documentation does not describe the following:

o How to export and import a database with the installation tools for reorganization purposes. Use the
appropriate tools for database reorganization, as SAP does not support this installation option.

o How to copy data from non-SAP systems to SAP systems based on SAP NetWeaver Application
Server. This documentation only describes how to copy data from one SAP system to another SAP
system.

o How to perform a duplication of a SAP system on the same host without changing the SAP system ID.
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o How to perform a system refresh using the tool.

e |f you have made modifications in your development system and want to copy your quality assurance or
production system onto the development system, see SAP Note 130906 # .

e For the development of Java applications, we strongly recommend that you follow the rules mentioned
below. Otherwise, we cannot guarantee that you can copy your Java engine later with the SAP tools to
change your underlying operating system and/or database system.

e SAP does not support all data archiving operations after a system copy.

If you used data archiving in the source or target system, access to the created archive files from the target
system may not always be possible. For more information, see SAP Note 153433 and Data Management
Landscape & Transformation Solutionshttps://support.sap.com/dmé&lt# .

Access to archived files from the target system without a dedicated archive migration project is only
supported in the following cases:

o The system copy is done to provide a source system for nonproductive purposes, for read-only access
to the previously archived data from the target system (no reloading), and you do not store archive
files using ArchivelLink/CMS.

You can either copy all archive files to file systems that are not shared between the source and the
target system, or you arrange network access for appropriate archive file sharing.

o The system copy is done to replace a productive system with a new productive system (for example,
hardware migration), assuming that the target system did not exist before and the operation of the
source system is discontinued after the system copy.

You must not change the system ID during system copy, but arrange for file access and/or
ArchiveLink/CMS connectivity.

1 Note
Only valid for SAP NetWeaver Business Warehouse:

If you use ADK-based archiving of request administration data in SAP NetWeaver Business Warehouse,
you have to copy all archive files related to archiving object BWREQARCH to the file system of the target
system. Only then write access (like deletion of requests, deletion of the complete data target content,
further upload of data to other targets, changing the quality status of requests or InfoProvider rebuild)
to requests with archived administration data is possible in the target system of the copy.

In all other cases, contact Data Management Landscape & Transformation Solutions at https://
support.sap.com/dm&lt#e or sap dmlt gce@sap.com.
e Dos and Don'ts for system copy:
o Do:
o Save configuration data and runtime data in the Java database only. If saving this data to the file

system level is unavoidable, you must use the Software Deployment Manager (SDM) to save the
data.

o Follow the Open SQL standard.
o Make sure that all communication runs through the database pool.
© Don't:

o Save any system and infrastructure-specific data in business objects. Use a pointer to the central
storage of such information, for example:
o SAP SystemID and SID (SAPSID=SID=system name)
© Hostname
o [P addresses
o Services and ports
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o Logical destinations and logical system names
o Other technical infrastructure names
o Use file system persistency.
o Set up dependencies between Java and ABAP.
o Try to copy the Java part of an ABAP+Java system to a Java standalone system or vice versa.
e |f you have implemented a federated portal network (FPN) across multiple SAP NetWeaver systems, see
SAP Note 1080080#% before starting the system copy.

System Copy for SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to
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2

Planning

This section describes how to plan your system copy.

2.1

Before You Start

e The SAP OS/DB Migration Check prepares you in an optimal way for a successful migration and supports
smooth continued operations on the new platform. The OS/DB Migration Check is mandatory, if you are
going to migrate a productive system.

For more information, see https://support.sap.com/support-programs-services/services/os-db-
migration.htmlfe. In addition to the information contained on this page, check the SAP OS/DB Migration
Planning Guide that is available in the Media Library.

e Before you start the system copy, you must read the documentation that is referenced in the following:

o

Read the following SAP Notes for up-to-date information on system copy and corrections to the
system copy documentation:

o SAP Note 1680045 — Release Note for Software Provisioning Manager 1.0

o SAP Note 1738258 — System Copy of Systems Based on SAP NetWeaver

Make sure that you have the most recent version of the SAP Notes, which you can find at:
https://support.sap.com/notes .
Guides for the target system installation
This system copy guide describes only the source system export in full detail. As for the installation of
the target system, this system copy guide describes only the system copy-specific steps in section
Setting Up the Target System [page 49], but refers for all steps that are identical with a new system
installation to the appropriate operating system and database-specific installation guide available at
http://support.sap.com/sltoolset# [ System Provisioning ¥ Installation Option of Software
Provisioning Manager 3.
SAP System Copy & Migration at:
https://wiki.scn.sap.com/wiki/display/SL/System+Copy+and+Migration .
SAP system landscape copy:

o Best Practice document SAP System Landscape Copy for SAP NetWeaver and SAP Solutions at:

https://support.sap.com/esacademy

o SAP Note 8385343 — SAP System Landscape Copy

o SAP Note 1990240 — Support of mixed landscapes (Unicode and Non-Unicode)
SAP Note 82478## SAP System OS/DB Migration

If you encounter problems during the system copy, create a customer message using the application
area BC-INS-MIG.
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2.2 Use Cases for System Copy

You can apply the system copy for the following:

Setting up system landscapes (where the SAP systems have different SAPSIDs).

Providing systems for testing, demonstration, training, and standby.

To create these systems you can either perform an initial system copy or use a database export to
overwrite the database of an already existing target system (refresh use case).

Depending on the purpose of the system, it might be advisable to use the same SAP system ID, even
though this prevents you from including the system in a system group for transports.

1 Note

o Oracle only: You cannot create standby systems with a system copy.

o You should perform system copy in a test system first. This way you can identify customer-specific
problems that might result from modifications.

Changing the operating system, the database, or both.
You can use different operating system releases or database releases for the source and target systems,
but the SAP system release of the source and target systems must be the same.

Changing the hardware.

2.3 System Copy Methods

You can choose between the following system copy methods:

18

The database-independent procedure using SAP tools.
Use this method if database-specific methods are either not available or not suitable. For more
information, see Database-Independent System Copy [page 33].
The database-specific procedure using tools provided by the database vendor
Some database vendors offer specific tools for copying a database. These tools allow you to:
o Restore a backup of one database (source database) in another one (target database) (backup
method)
o Unload the source database and load the data into the target database
For more information, see Database-Specific System Copy [page 53].

System Copy for SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to
7.03 on Windows
PUBLIC Planning



These methods are not supported for all database systems. Refer to the following table to check which copy
methods are available for your database system:

Database

SAP MaxDB

Available Methods

Use one of the following:
e System copy procedure on Windows using Jload
For more information, see System Copy Procedure [page 33].

e System copy procedure for a homogeneous system copy only
For more information, see SAP MaxDB-specific procedure [page 70].

and Windows

IBM Db2 for Linux, UNIX,

Use one of the following:

e System copy procedure using Jload
For more information, see System Copy Procedure [page 33].

e Backup of IBM Db2 for Linux, UNIX, and Windows
For more information, see IBM Db2 for Linux, UNIX, and Windows Specific Procedures
[page 74].

IBM Db2 for z/0S

Use one of the following:

e System copy procedure on Windows using Jload
For more information, see System Copy Procedure [page 33].
e Additional Information:
o For more information about the IBM Db2 for z/OS specific procedure for a homoge-
neous system copy only, see the . PDF attachment to SAP Note 680746 .
o When R3tais used to split tables, DELETE with WHERE is not performed if import
errors occur in the target system.
For more information, see SAP Note 778729 fr .

e System copy procedure on Windows using Jload
For more information, see System Copy Procedure [page 33].

e Jload method with Export/Import Monitors

Oracle Use one of the following:
e System copy procedure on Windows using Jload
For more information, see System Copy Procedure [page 33].
® Jload method with Export/Import Monitors
For more information, see Jload Procedures Using the Java Migration Monitor [page 121].
e Homogeneous system copy only: Oracle backup/restore method
For more information, see Oracle-Specific Procedure [page 55] and SAP Note 676468
i
MS SQL Server Use one of the following:

For more information, see Jload Procedures Using the Java Migration Monitor [page 121].

e Homogeneous system copy only: Backup/Restore or Detach/Attach Method
For more information, see MS SQL Server-Specific Procedure [page 73] and SAP Notes
193816/ and 151603 .
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Database Available Methods

SAP ASE Use one of the following:

e System copy procedure on Windows using Jload
For more information, see System Copy Procedure [page 33].

e Jload method with Export/Import Monitors
For more information, see Jload Procedures Using the Java Migration Monitor [page 121].

e Homogeneous system copy only: Backup/Restore or Detach/Attach method
For more information, see SAP ASE Server-Specific Procedure [page 85].

1 Note

Before you start the system copy procedure, implement SAP Note 1612437 #r .

e Development Infrastructure (DI) only:

For the migration of SAP NetWeaver Development Infrastructure (NWDI) components you can apply either

“Copy” or “Move".

© Copy
“Copy" is supported only by Design Time Repository (DTR). After a copy, both the source DTR and
target DTR can be used productively in parallel. However, Component Build Service (CBS) and Change
Management Service (CMS) do not support such a copy.

o Move
“Move" is supported by all NWDI components - DTR, CBS, and CMS. After a move, the source system
can no longer be used - that is, only the target is active after the move has been performed.

2.4 Creating a System Copy Plan

Create a plan to perform the system copy.

Procedure

1. When copying a system that contains production data, choose the moment for the copy carefully. This
could be a month-end or year-end closing.

2. Consider the downtime of the source system (for preparations and copying) when planning the system
copy.
3. Consider atest run.

Perform a test run of the system copy. You can use the time taken by the test run to calculate the system
downtime:

o If you want your target system to replace your source system, try to perform a complete test run. This
means that the entire database is exported from the source system, transferred to the target system,
and imported there. System downtime is approximately equal to the total test time (that is, time for
export, transport, and import).

System Copy for SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to
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o If you do not want to replace your source system, a partial test run (export of the entire database or
parts of it) can be sufficient to calculate the system downtime. The source system is only down for the
time of the export.

Calculating the system downtime is particularly important for very large databases (VLDB) or when
tapes are being used. The test runis also to determine the amount of export data. Choose the best
data transfer method (for example, FTP or tape). We recommend that you only perform read/write
actions on local file systems.

4. Define a schedule for the test migration and the final migration.

2.5 Basic Planning Aspects and Parameters

Support of Mixed Landscapes (Unicode and Non-Unicode)

If your system landscape is mixed with Unicode and Non-Unicode systems, or if you have third party software
in your system landscape which does not support Unicode at all, check SAP Note 1990240#% for potential
support restrictions.

Using NFS-Mounted File Systems

Note that the overall performance of the system copy depends on all links in the chain, starting from the
performance of the source database to the following:

e Performance of the server on which the export is executed
® File system to which the export data is written
e Target side that reads from the export medium and imports it into the target database

You have to make sure that all aspects are configured for optimal performance. For recommendations on NFS
configuration, see SAP Note 2093132 .

1 Note

If you want to use NFS for the system copy export, make sure that you create secure file share permissions.
Be aware that the communication protocol for NFS needs to be a safe one, for example SSFS.

Configuration Analysis and Hardware Configuration

® |nthe event of a major change in hardware configuration (for example, new machine type, new hard disk
configuration, new file system type), consult your SAP-authorized hardware partner.
® You need to determine the following:
o Number of application servers
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o Expected size of the database
o Additional disks or other hardware required
© Required memory

1 Note

Refer to the section on hardware and software requirements in the SAP system installation
documentation to determine the system requirements.

Choosing an SAP system ID

You can choose the new SAP system ID <TARGET SAPSID> freely during a new installation.

Make sure that your SAP system ID:

® |sunique throughout your organization
Do not use an existing <sApPS1D> when installing a new SAP system.
e Consists of exactly three alphanumeric characters
e (Contains only uppercase letters
® Has a letter for the first character
e Does not include any of the reserved IDs listed in SAP Note 1979280 #% .

e |f you want to install an additional application server instance, make sure that no Gateway instance with the
same SAP System ID (SAPSID) exists in your SAP system landscape.

Caution

To meet the requirements of the Workbench Organizer, you must choose different SAP system IDs for
different SAP systems.

SAP License

Once the installation is completed and the SAP system copy has been imported, you will require a new license
key for the target system. The license key of the source system is not valid for this system. For more
information about ordering and installing the SAP license, see the SAP Library for your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http://help.sap.com/nw?th'l} Application Help >
Function-Oriented View <Language> > Solution Life Cycle

Management by Key Capability > SAP Licenses }
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SAP NetWeaver Release Location

SAP NetWeaver 70 including EHP1 http:/help.sap.com/nw701#% |l Application Help ¥
Function-Oriented View <Language> # Solution Life Cycle

Management by Key Capability » SAP Licenses 4.

SAP NetWeaver 7.0 including EHP2 http:/help.sap.com/nw702 Pl Application Help
Function-Oriented View <Language> @ Solution Life Cycle

Management by Key Capability # SAP Licenses 4.

SAP NetWeaver 7.0 including EHP3 http://help.sap.com/nw703#4% |l Application Help
Function-Oriented View <Language> # Solution Life Cycle

Management by Key Capability # SAP Licenses 4.

For more information about SAP license keys, see http:/support.sap.com/licensekey i or SAP Note 94998
Pir .

Archiving files

Data that has been archived in the source system (data that does not reside in the database but was moved to
a different storage location using SAP Archive Management) must be made accessible in the target system.
Adapt the file residence information in the target system. For more information, see the SAP Library for your
release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http://help.sap.com/nw70" | Application Help ¥
Function-Oriented View <Language> # Solution Life Cycle

Management by Key Capability > Data Archiving }

SAP NetWeaver 7.0 including EHP1 http://help.sap.com/nw701#% | Application Help ¥
Function-Oriented View <Language> > Solution Life Cycle

Management by Key Capability # Data Archiving 3.

SAP NetWeaver 7.0 including EHP2 http://help.sap.com/nw702 ¥ | Application Help
Function-Oriented View <Language> > Solution Life Cycle

Management by Key Capability > Data Archiving ]
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SAP NetWeaver Release Location

SAP NetWeaver 70 including EHP3 http:/help.sap.com/nw703"% |l Application Help
Function-Oriented View <Language> # Solution Life Cycle

Management by Key Capability » Data Archiving 3

Access to archive files is platform-independent.

Special Prerequisites for SAP NetWeaver Business Warehouse (SAP
NetWeaver BW) and IBM Db2 for Linux, UNIX, and Windows (IBM Db2) 10.5
and higher

For special prerequisites and required procedures for SAP NetWeaver BW and IBM Db2, including the
implementation of DB2 BLU acceleration, see the appendix of the database administration guide SAP Business
Warehouse on IBM DB2 for Linux, UNIX, and Windows: Administration Tasks. To access this guide, use the SAP
NetWeaver Guide Finder: In the | want to column select Operate my system, in the My Database column, select
IBM Db2 for Linux, UNIX, and Windows.

2.6 System Copy and Migration Optimization

This section lists several methods that you can use to optimize the standard system copy procedure.

More information about system copy optimizations can be found in the document System Copy and Migration
- Optimization at https://archive.sap.com/documents/docs/DOC-14257# and in SAP Note 18757787 .

Related Information

Database Tuning [page 24]

Package Splitting [page 26]

Table Splitting [page 26]

Migration Monitor [page 27]
Database-Specific Central Notes [page 27]

2.6.1 Database Tuning

This is just a list of database parameters which could help you to tune your database. This list is not meant to
give you detailed recommendations about the parameter settings.
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Database Tuning Measures = IBM Db2 for z/0S

Create indexes deferred.

Database Tuning Measures — IBM Db2 for Linux, UNIX, and Windows

Refer to the documentation DB2 Optimization Techniques for SAP Database Migration And Unicode Conversion
available at: http://www.redbooks.ibm.com/abstracts/sg247774.html #

Database Tuning Measures - Oracle

e Refer to SAP Note 936441% regarding Oracle settings for R31o0ad based system copy.
® [Enlarge the number and size of redo logs experiences from other pilot projects by adding 4 additional

redo logs of 100 MB each.

e Enlarge the number of db writers.

e FEnlarge temporary tablespace psapTEMP (~20-30 GB).

® Increase sort area sizeOrusepga_ * parameters.

® |ncrease PSAPROLL (~20 GB).

Database Tuning Measures — SAP MaxDB

® You can find general documentation about tuning measures of the current SAP MaxDB release at:

SAP NetWeaver Release

SAP NetWeaver 7.0

Location

http://heIp.sap.com/nw70&|b Application Help >
Function Oriented View > English > SAP NetWeaver by
Key Capability > Database Administration > Database
Administration for MaxDB > MaxDB > Basic Information
> Concepts of the Database System > Performance ]

SAP NetWeaver 7.0 including enhancement package 1

http://help.sap.com/nw701fh-|} Application Help >
Function Oriented View # English » SAP NetWeaver by
Key Capability > Database Administration > Database
Administration for MaxDB > MaxDB > Basic Information

» Concepts of the Database System # Performance 4
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SAP NetWeaver Release Location

SAP NetWeaver 7.0 including enhancement package 2 http://heIp.sap.com/nw702l‘hr|} Application Help >
Function Oriented View ¥ English  SAP NetWeaver by
Key Capability > Database Administration > Database
Administration for MaxDB > MaxDB > Basic Information
> Concepts of the Database System > Performance ]

SAP NetWeaver 7.0 including enhancement package 3 http://help.sap.com/nw703# | Application Help p
Function Oriented View > English > SAP NetWeaver by
Key Capability » Database Administration ¥ Database
Administration for MaxDB > MaxDB > Basic Information
> Concepts of the Database System > Performance ]

® |ncrease the parameter CACHE SIZE to the maximum available size of main memory. Add the unused
main memory of non-running Application Server components to the database cache.

® |ncrease the parameter MAXCPU to the maximum available number of processors to which the database
system can distribute user tasks.

Database Tuning Measures — SAP ASE

Refer to SAP Note 1722359#% for recommendations on how to size and tune the SAP ASE database in an SAP
NetWeaver or SAP Business Suite environment.

2.6.2 Package Splitting

You can split the default packages EXPORT . XML and IMPORT . XML into several smaller and equal sized
packages using the Java Splitter tool.

Related Information

Package and Table Splitting for Java Tables [page 129]

2.6.3 Table Splitting

For copying large Java tables, you can use the Java Splitter tool.

For more information, see Package and Table Splitting for Java Tables [page 129] .
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Related Information

Package and Table Splitting for Java Tables [page 129]

2.6.4 Migration Monitor

The Java Migration Monitor is a tool that helps you to perform and control the unload and load process for the
Java stack during the system copy procedure.

More Information

For more information, see Jload Procedures Using the Java Migration Monitor [page 121]

2.6.5 Database-Specific Central Notes

For some databases there are central SAP Notes where you can find information about how to optimize system
copy and migration.

e For more information about MS SQL Server-specific migration optimization options, see SAP Note
1054852/ (Recommendations for migration to MS SQL Server).

e For more information about SAP ASE-specific migration optimization options, see SAP Note 1680803 #
(Migration to SAP Sybase ASE - Best Practice).

Related Information

System Copy and Migration Optimization [page 24]
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3 Preparations

Before you start the system copy, you must perform the following preparation steps.

3.1 General Technical Preparations

To make a consistent copy of the database, you need to prepare the source system and perform some
subsequent actions on the target system, before you start a system copy. This is not necessary when
performing a test run.

Context

The following describes the required preparations.

For more information about SAP system administration, see the SAP Library for your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http://help.sap.com/nw70¥% |l System Administration and
Maintenance Information > Technical Operations for SAP

NetWeaver <Language> 4

SAP NetWeaver 70 including enhancement package 1 http://help.sap.com/nw701"hr|} System Administration and

Maintenance Information > Technical Operations for SAP

NetWeaver <Language> 4

SAP NetWeaver 7.0 including enhancement package 2 http://help.sap.com/nw702# |l System Administration

and Maintenance Information > Technical Operations for

SAP NetWeaver <Language> 4

SAP NetWeaver 70 including enhancement package 3 http:/help.sap.com/nw703%% |+ System Administration

and Maintenance Information > Technical Operations for

SAP NetWeaver <Language> 4
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Procedure

1. Check the minimum kernel patch level required by the support package level of the source system. It might
be necessary to replace the SAP kernel delivered with the installation kit and installed during the
installation of the target system with a newer kernel patch level before starting the target system. If you
have to replace the delivered SAP kernel, you can do this after the installation of the central instance.

2. If your source system is configured against a System Landscape Directory (SLD), check the size of table
BC_SLD CHANGELOG. The size of this table might be growing very fast because of the reasons described in
SAP Note 1792134 #% . It is recommended that you clean up table BC_SLD CHANGELOG as described in SAP
Note 1799613 .

3. SAP NetWeaver Development Infrastructure (DI) only: If your SAP system is of usage type Development
Infrastructure (DI) then this system can only be moved, but not be copied. This means that it is possible to
migrate such a system from one host to another but it is not possible to keep both systems active after the
migration. If you want to move an SAP system with usage type Development Infrastructure (DI), make sure
that the following prerequisites are met:

o The users and passwords created in the source system are valid in the target system (for example,
they use the same UME).

o Check in (or revert) all open activities (of all users) in the SAP NetWeaver Developer Studio by using
the Design Time Repository perspective (DTR perspective).

o Remove all existing development configurations from the SAP NetWeaver Developer Studio.

o Verify in the DTR Web Ul that there are no pending entries in the NameReservation queue. To check
this, goto http://<dtrhost>:<port>/dtr/sysconfig/support/NameReservationList and
check that there are no entries with the state PRELIMINARY, FINALIZE PENDING Or
REVERT PENDING inthe queue.

If there are entries with the state FINALIZE PENDING or REVERT PENDING you have to wait for the
next run of the name reservation background task in the DTR server that ends these entries. This
background task runs normally every 15 minutes.

To check the frequency of this background task you can have a look at http://
<dtrhost>:<port>/dtr/sysconfig/scheduled tasks.html and check the value Periodicity for
the task ProcessNameReservationsTask. Since precondition for a successful execution of this
background task, the name server must be configured in the DTR server (http://
<dtrhost>:<port>/dtr/system-tools/administration/NameServerConfiguration. There
should be no entries with the state PRELIMINARY in the name reservation queue since they only occur
if there are open activities (which should not be the case if you followed the previous steps).

o Stop all applications of the Development Infrastructure (DI) on the source system.

4. Oracle Database only: If your source system has Oracle Database Vault, make sure that you have read
section Implementing Oracle Database Vault with the Installer [page 135].

5. Oracle Database only: Before performing System Copy from any database to Oracle, check the contents
of the TAORA and IAORA database tables and ensure that the entries are consistent.

You can use the upgrade-specific SAP Note 541542#% as a reference to check for the correct entries of the
table. If there are any inconsistencies, they must be corrected on the source system before performing the
export.

If there are inconsistent entries, system copy import fails with an error due to wrong tablespace names for
TABARTs USER and USER1 in theOracle specific tables TAORA and IAORA on the source system. These
tables are not checked for consistency on the source system if the source database is not Oracle. This
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inconsistency in the source system is caused due to the usage of both old and new tablespace layout on
the source system.

6. SAP NetWeaver 7.0 EHP2 and higher only: If you want to use the Java Migration Monitor, make sure that
the JAVA MIGMON ENABLED environment variable is set to “true” on both the source and the target
systems.

7. Bl customers: If you want to perform a system landscape copy for SAP NetWeaver BW, apply SAP Note
886102#% .

8. If you use the Integration Repository and Directory, make sure that you apply SAP Note 1345600%% to
avoid any database inconsistencies.

9. IBM Db2 for Linux, UNIX, and Windows only: JSizeCheck requires monitoring functions that are no
longer available as of IBM Db2 for Linux, UNIX, and Windows version 10.5 by default. Before you start a
Java export, you have to create these monitoring functions as follows:

a. Logonasuserdb2<dbsid>.

b. Execute the following command: db2updv<DB2 version> -r -d <DBSID> -u db2<dbsid> -p
<password>

1 Note

The name of the db2updyv. . . tool changes with each DB2 version. For example, for DB2 10.5 or
11.1, you need to use db2updv105 or db2updv111, respectively.

10. Make sure that you update the CIM data model in the system landscape directory (SLD) of the source
system as described in SAP Note 669669#% . Otherwise you might get an error during the target system
installation (see SAP Note 1840394 ).

3.2 Preparing the Media Required for Performing the
Export

For performing the export on the source system, you only need to download and extract the Software
Provisioning Manager 1.0 archive which contains the installer as such.

For the media required for performing the target system installation, refer to section Preparing the installation
Media in the installation guide for your operating system platform and database at https://help.sap.com/
sltoolset# | Area System Provisioning » Guide for Installation of Systems Based on SAP NetWeaver 7.0 / 7.0
EHPs 3 (see also Installing the Target System [page 507).

1 Note

The signature of media is checked automatically by the installer during the Define Parameters phase while
processing the Media Browser screens. As of now the installer only accepts media whose signature has been
checked. See also the description of this new security feature in SAP Note 2393060 #r .
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Related Information

Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 31]

3.2.1 Downloading and Extracting the Software Provisioning
Manager 1.0 Archive

You must request a medium with the 70SWPMJIDS<Support Package Number> <Version Number>.SAR
archive, and then extract this archive. You cannot download this archive directly from the SAP Software
Download Center..

Context

You require the SAPCAR tool to be able to unpack and verify software component archives (*SAR files). *SAR is
the format of software lifecycle media and tools that you can download from the SAP Software Download
Center. For more information about how to get this tool, see the Procedure section below.

Procedure

1. Request the medium with the Software Provisioning Manager 1.0 archive
70SWPMJIDS<Support Package Number> <Version Number>.SAR from SAP as follows:

a. Ask SAP support to create an incident on component xx-SER-SWFL-SHIP to enable you to use
medium with 70SWPMJDS<Support Package Number> <Version Number>.SAR.

b. Put the incident on component BC-INS-RMP to get support information about how to use
70SWPMJDS<Support Package Number> <Version Number>.SAR.

For more information, see SAP Note 2595196 #% .

2. Make sure that you use the latest version of the sapCaAR tool when manually extracting the Software
Provisioning Manager archive.

1 Note

An older SAPCAR version might extract archive files in a wrong way and this could prevent the installer
from working consistently.

Proceed as follows to get the latest version of SAPCAR:

a. Goto https://launchpad.support.sap.com/#/softwarecenter#|p SUPPORT PACKAGES &
PATCHES 3 and search for “sapcar’.
b. Select the archive file for your operating system and download it to an empty directory.
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c. To check the validity of the downloaded executable, right-click the executable and choose Properties.
On the Digital Signatures tab you can find information about the SAP signature with which the
executable was signed.

d. Rename the executable to sapcar. exe.

For more information about SAPCAR, see SAP Note 212876 #% .
3. Using the latest version of SAPCAR, you can verify the signature of the downloaded
70SWPMJIDS<Support Package Number> <Version Number>.SAR archive as follows:

a. Get the latest version of the SAPCRYPTOLIB archive to your installation host as follows:

1. Go to https://launchpad.support.sap.com/#/softwarecenter® | SUPPORT PACKAGES &
PATCHES 7 and search for “saperyptolib’.
2. Select the archive file for your operating system and download it to the same directory where you
have put the SAPCAR executable.
3. Use the following command to extract the SAPCRYPTOLIB archive to the same directory where
you have put the SAPCAR executable:
sapcar -xvf sapcryptolibp 84..sar -R <target directory>
4. Download the Certificate Revocation List from https://tcs.mysap.com/crl/cribag.p7s# and move
it to the same directory.
b. Verify the signature of the downloaded
70SWPMJDS<Support Package Number> <Version Number>.SAR archive by executing the
following command:

1 Note
Check SAP Notes 2178665 and 1680045 whether additional information is available.

<Path to SAPCAR>\sapcar.exe -tvVf<Path to Download Directory>
\70SWPMJDS<Support_Package Number> <Version Number>.SAR -crl<file name of
revocation list>

4. Unpack the Software Provisioning Manager archive to a local directory using the following command:

<Path to SAPCAR>\sapcar.exe -xvf <Path to Download Directory>
\70SWPMJDS<Support_ Package Number> <Version Number>.SAR <Path to Unpack
Directory>

1 Note

Make sure that all users have read permissions for the directory where you want to unpack the installer.

Caution

Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not
unpack it to the same folder as other installation media.
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4 Database Independent System Copy

You can use the installer to export and import your Java database content, file system, and all configuration in a
database-independent format. It uses the Jload tool.

Jload

1 Note

Constraints

Jload Restrictions

The installer generates a database dump of all SAP objects that are defined in the Java Dictionary (Jload).
Other objects are not exported by the installer.

For a consistent database export, no transactions on export-relevant database objects are allowed during
the export. Otherwise, the export has to be restarted. Therefore, we recommend that you shut down the
SAP system (excluding the database!) for the export. The database must still be running.

Process Flow

Proceed as described in System Copy Procedure [page 33].

4.1 System Copy Procedure

This section describes the system copy procedure using Jload .

Prerequisites

Specify an empty directory with sufficient disk space for the export dump on the host where you want to
perform the export. Make sure that this directory does not contain any files from any previous system copy
exports. If you cancelled a system copy export and want to perform the export again, make sure that you
remove all files from the previously cancelled export before you start the export from scratch.

System Copy for SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to
7.03 on Windows
Database Independent System Copy PUBLIC 33



Process Flow on the Source System (Export)

When performing the export, the installer creates a migration export media which contains the data of the
exported system, and which you use to install the target system.

Follow the sequence of steps described in the process flows below for a:

e (Central system
o Central system — Performing the Export on the Source System
o Central system — Setting Up the Target System
e Distributed system or high-availability system
o Distributed system or high-availability system — Performing the Export on the Source System
o Distributed system or high-availability system — Setting Up the Target System

Central System - Performing the Export on the Source System

To perform the export for a central system, you need to proceed as follows on the central system host:

1. Perform the export on the central system host:

1. Yourun theinstaller [page 38] to export the database instance and the central instance.
On the Welcome screen, choose the option Database and Central Instance Export.
For more information, see Running the Installer to Perform the Export [page 38].

Central System — Setting Up the Target System

Use the installer to set up the target system and import the database files that you have exported from the
source system.

1 Note

This system copy guide describes only the source system export in full detail. As for the installation of the
target system, this system copy guide describes only the system copy-specific steps in section Setting Up
the Target System [page 49], but refers for all steps that are identical with a new system installation to the
appropriate operating system and database-specific installation guide available at http://support.sap.com/

sltoolset | System Provisioning ¥ Installation Option of Software Provisioning Manager 3.

In the following, we refer to this guide as “installation guide™.

Perform the following steps on the central system host:

1. Prepare the central system host for the installation of your target system as described in the installation
guide.

2. Transfer the export files [page 49] to the central system target host.

3. Install the target system [page 50].

4. If required install additional dialog instances on dialog instance hosts as described in the installation
guide.
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Distributed System or High-Availability System - Performing the Export on
the Source System

To perform the export for a distributed system or a high-availability-system, you need to proceed as follows:

1. When exporting a distributed system using local export directories, the created export directories need to
be merged, that is copied together. Make sure that the SOURCE . PROPERTIES file is the one created when
exporting the central instance.

2. Perform the export on the database instance host:

1. You run the installer [page 38] to export the database instance. On the Welcome screen, choose the
option Database Instance Export.
For more information, see Running the Installer to Perform the Export [page 38].

3. Perform the export on the central instance host:

You run the installer to export the central instance. For more information, see Running the Installer to
Perform the Export [page 38].
On the Welcome screen, choose the option Central Instance Export.

Distributed System or High-Availability System — Setting Up the Target
System

Use the installer to set up the target system and import the database files that you have exported from the
source system.

1 Note

This system copy guide describes only the source system export in full detail. As for the installation of the
target system, this system copy guide describes only the system copy-specific steps in section Setting Up
the Target System [page 49], but refers for all steps that are identical with a new system installation to the
appropriate operating system and database-specific installation guide available at http://support.sap.com/

sltoolset#t | System Provisioning ¥ Installation Option of Software Provisioning Manager 3.

In the following, we refer to this guide as “installation guide”.

Perform the following steps on the relevant installation hosts of your target system:

1. Prepare the SCS instance host, the central instance host and the database instance host for the
installation of the corresponding instances of your target system as described in the installation guide.

2. Install the SCS instance for the target system as described in the installation guide.
3. Perform the following steps on the database instance host:
1. Transfer the export files to the database instance target host. For more information, see Transferring
the Export Files to the Target Host [page 49].
2. Install the database instance of the target system. For more information, see Installing the Target
System [page 50].
4. Onthe central instance host, install the central instance of the target system.
5. Ifrequired, install additional dialog instances on the dialog instance hosts as described in the installation
guide.
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4.1.1 Exporting the Source System

Here you can find information about how to run the installer to perform the export on the source system.

For more information about the overall sequence of steps required for exporting the source system, see
System Copy Procedure [page 33].

Related Information

Prerequisites for Running the Installer [page 36]
Running the Installer [page 38]

4111 Prerequisites for Running the Installer

Make sure you fulfil the following prerequisites before running the installer.

e Forthe SL Common GUI, make sure that the following web browser requirements are met:

o You have one of the following supported browsers on the device where you want to run the SL

Common GUI:

o Google Chrome (recommended)

© Mozilla Firefox

o Microsoft Edge

o Microsoft Internet Explorer 11 or higher.

Always use the latest version of these web browsers.

o If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new
Web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or
private browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering
with the SL Common GUI.

For more information about the SL Common GUI, see Useful Information About the Installer [page 42].

e Make sure that you use an account that is a member of the local Administrators group.
e Make sure that the following ports are not used by other processes:
o Port 4237 is used by default as HTTPS port for communication between the installer and the SL
Common GUI.
If this port cannot be used, you can assign a free port number by executing sapinst.exe with the
following command line parameter:
SAPINST HTTPS_PORT=<Free Port Number>
o Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer
processing.
The filled-out evaluation form is then sent to SAP using HTTPS.
If this port cannot be used, you can assign a free port number by executing sapinst.exe with the
following command line parameter:
SAPINST HTTP_PORT=<Free Port Number>
e |f you want to perform the export in unattended mode, see SAP Note 2230669#% which describes an
improved procedure using inifile.params.
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e Specify an empty directory with sufficient disk space for the export dump on the host where you want to
perform the export. Make sure that this directory does not contain any files from any previous system copy
exports. If you cancelled a system copy export and want to perform the export again, make sure that you
remove all files from the previously cancelled export before you start the export from scratch.

e Make sure that you shut down all SAP Application Servers before the export. The database must still be
running. Otherwise, the target system might be inconsistent.

e Before starting the export steps on the central instance of the source system, make sure that you have at
least the same amount of disk space available in \\SAPLOC\<SAPSID>\<Instance Name>\SDM
\programasis used in \\SAPLOC\<SAPSID>\<Instance Name>\root\origin.Duringthe export
some archives are written to the program subdirectories and the installer aborts if there is not enough
space.

411.1.1 Required User Authorization for Running the
Installer

Use

Although the installer automatically grants the required rights to the user account used for the installation, you
have to check whether this account has the required authorization to perform the installation. The
authorization required depends on whether you intend to perform a domain or local installation. If necessary,
you have to ask the system administrator to grant the account the necessary authorization before you start the
installation. If you attempt the installation with an account that has not the required authorization, the
installation aborts.

This section informs you about the authorization required for a domain and a local installation.

Procedure

Caution

Do not use the user <sapsid>adm for the installation of the SAP system.

Domain Installation

For a domain installation the account used for the installation needs to be a member of the local
Administrators and the domain Admins group of the domain involved. All machines in the system must
belong to the same domain. In a domain installation, the user information is stored centrally on the domain
controller and can be accessed by all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to
perform a domain installation to avoid authorization problems.
Caution

e |[fyouinstall a system distributed over several hosts as a local installation, this can lead to authorization
problems for the operating system users <sapsid>admand SAPService<SAPSID>. |t can also lead to
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problems with the transport directory, which is usually shared by several SAP systems. SAP does not
support distributed SAP systems running with a local user account..

e For performance and security reasons, SAP does not support an SAP system installation on a domain
controller.

e [f for any reason, the account used for the installation is not a member of the domain Admins group, you
can perform the installation with a domain user who is a member of the local Administrators group.
However, the domain administrator has to prepare the system appropriately for you.

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.

2. Ifrequired, obtain these rights by asking the system administrator to enter the account as a member of the
domain Admins group.

Local Installation

For a local installation the account used for the installation needs to be a member of the local
Administrators group of the machine involved. In a local installation, all Windows account information is
stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

Caution

Do not use the Windows built-in account Administrator or the renamed built-in account to install your
SAP system with the installer. The built-in account only has restricted network access rights that are
required by the installer. If you renamed the built-in account Administrator, do not create a new account
named Administrator.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.

2. Ifrequired, obtain these rights by asking the system administrator to enter the account as a member of the
local Administrators group.

4112 Running the Installer

This section describes how to run the installer to perform the export for system copy.

Prerequisites

For more information, see Prerequisites for Running the Installer [page 36].
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Context

Software Provisioning Manager (the “installer” for short) has a web browser-based GUI named “SL Common
GUI of the Software Provisioning Manager” - “SL Common GUI" for short.

This procedure describes an installation where you run the installer and use the SL Common GUI, that is you
can control the processing of the installer from a browser running on any device.

For more information about the SL Common GUI, see Useful Information About the Installer [page 42].

Procedure

1

Log on to the host where you want to run the installer.
Make sure that you log on as a user with the required authorization for running the installer.

This user must be at least a member of the local Administrators group.

Caution

Do not use an existing <sapsid>adm user.

If your security policy requires that the person running the installer is not allowed to know administrator
credentials on the host where the installer is to perform the export, you can specify another operating
system user for authentication purposes. You do this using the SAPINST REMOTE ACCESS USER
parameter when starting sapinst.exe from the command line. You have to confirm that the user is a
trusted one. For more information, see SAP Note 1745524 ¥ .

Make the required media available.

For more information, see Preparing the Media Required for Performing the Export [page 30].
Start the installer as follows:

Double-click sapinst.exe from the directory to which you unpacked the Software Provisioning Manager
archive file.

1 Note

By default, the SL Common GUI uses the default browser defined for the host where you run the
installer. However, you can also specify another supported web browser available on the host where you
start the installer. You can do this by starting the sapinst executable with command line option
SAPINST BROWSER=<Path to Browser Executable>, for example

SAPINST BROWSER=firefox.exe.

The installer GUI starts automatically by displaying the Welcome screen.
The installer is starting up.
The installer now starts and waits for the connection with the SL Common GUI. If you have a supported

web browser (see Prerequisites for Running the Installer [page 36]) installed on the host where you run the
installer, the SL Common GUI starts automatically by displaying the Welcome screen.
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If the SL Common GUI does not open automatically, you can find the URL you require to access the SL
Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program
Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from
there.
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Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html

Logon users: [<users>]
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The SL Common GUI opens in the browser by displaying the Welcome screen.

1 Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst
process on this computer could not be verified. Accept this warning to inform your browser that it can
trust this site, even if the certificate could not be verified.

On the Welcome screen, choose | <Product> j Software Life-cycle Options ¥ System Copy #

<Database> # Source System Export # <Distribution Option> # Basedon AS Java 4.
Select the corresponding system copy option from the tree structure according to the sequence of the
process flow for the database-independent system copy procedure [page 33].

1 Note

Do not perform these steps if you use a database-specific method (see Database-Specific System
Copy [page 53]).

Choose Next.

1 Note

If there are errors during the self-extraction process of the installer, you can find the log file
dev_selfex.out inthe temporary directory.

If the installer prompts you to log off from your system, log off and log on again.
The installer restarts automatically.

Follow the instructions in the installer input screens and enter the required parameters.

1 Note

To find more information on each parameter during the Define Parameters phase, position the cursor on
the required parameter input field , and choose eitheror the HELP tab. Then the available help text
is displayed in the HELP tab.

1 Note

Oracle Database only: If your source system has Oracle Database Vault, consider the additional
information in section Implementing Oracle Database Vault with the Installer [page 135].
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Caution

The signature of media is checked automatically during the Define Parameters phase while processing
the Media Browser screens.

Keep in mind that this automatic check is only committed once and not repeated if you modify artefacts
such as SAR archives or files on the media after the initial check has been done. This means that - if you
modify artefacts later on either during the remaining Define Parameters phase or later on during the
Execute Service phase - the signature is not checked again.

See also the description of this new security feature in SAP Note 2393060 .

9. After you have entered all requested input parameters, the installer displays the Parameter Summary
screen. This screen shows both the parameters that you entered and those that the installer set by default.

If required, you can revise the parameters before starting the export procedure.

10. To start the execution, choose Next.

The installer starts the export and displays its progress of the system copy export during the processing
phase.

11. If you copied installation media to your hard disk, you can delete these files when the installer has
successfully completed.

12. For security reasons, we recommend that you delete the . sapinst directory within the home directory of
the user with which you ran the installer:

$userprofile%\.sapinst\

Related Information

Useful Information About the Installer [page 42]
Interrupted Processing of the Installer [page 43]
Troubleshooting with the Installer [page 46]

4.1.1.3 Additional Information About the Installer

The following sections provide additional information about the installer.

Useful Information About the Installer [page 42]
This section contains some useful technical background information about the installer and the
installer GUI.

Interrupted Processing of the Installer [page 43]
Here you find information about how to restart the installer if its processing has been interrupted.

Troubleshooting with the Installer [page 46]
This section tells you how to proceed when errors occur while the installer is running.

Troubleshooting during the Export Process [page 47]
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If the export process aborts during the Execute Service phase (for example, due to a hardware failure,
such as power outage, operating system crash, file system full), you have to repeat the export of the
complete package.

Using the Step State Editor (SAP Support Experts Only) [page 48]
This section describes how to use the Step State Editor available in the installer.

41.1.3.1 Useful Information About the Installer

This section contains some useful technical background information about the installer and the installer GUI.

42

Software Provisioning Manager (the “installer” for short) has the web browser-based “SL Common GUI of
the Software Provisioning Manager” - “SL Common GUI" for short.
The SL Common GUI uses the SAP Ul Development Toolkit for HTML5 - also known as SAPUI5 - a client-
side HTML5 rendering library based on JavaScript. The benefits of this new user interface technology for
the user are:

o Zero foot print, since only a web browser is required on the client

o New controls and functionality, for example, view logs in web browser.
The SL Common GUI connects the web browser on a client with the sapinst executable - which is part of
Software Provisioning Manager - running on the installation host using the standard protocol HTTPS.

For the SL Common GUI, the installer provides a pre-generated URL in the Program Starter window. If you
have a supported web browser installed on the host where you run the installer, the SL Common GUI starts
automatically.

By default, the SL Common GUI uses the default browser defined for the host where you run the installer.
However, you can also specify another supported web browser available on the host where you start the
installer. You can do this by starting the sapinst executable with command line option
SAPINST BROWSER=<Path to Browser Executable>, for example
SAPINST BROWSER=firefox.exe.
Alternatively you can open a supported web browser on any device and run the URL from there.

For more information about supported web browsers see Prerequisites for Running the Installer [page 36].
If you need to run the SL Common GUI in accessibility mode, apply the standard accessibility functions of
your web browser.

As soon as you have started the sapinst.exe executable, the installer creates a . sapinst directory
underneath the <Drive>:\Users\<User> directory where it keeps its log files. <User> is the user which
you used to start the installer.

After you have reached the Welcome screen and selected the relevant installer option for the SAP system
to be exported , the installer creates a directory sapinst instdir, where it keeps its log files, and which
is located directly in the $ProgramFiles% directory. If the installer is not able to create
sapinst_instdir there, it tries to create sapinst instdir in the directory defined by the TEMP
environment variable.

All log files which have been stored so far in the . sapinst folder are moved to the sapinst instdir
directory as soon as the latter has been created.

= Recommendation

We recommend that you keep all installation directories until the system is completely and correctly
installed.
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The installer extracts itself to a temporary directory called sapinst exe.xxxxxx.xxxx, Which is located
in $TEMP%, $TMP%, $TMPDIR%, Or $SystemRoot%. These files are deleted after the installer has stopped
running.

The temporary directory sapinst exe.xxxxxx.xxxx sometimes remains undeleted. You can safely
delete it.

The temporary directory also contains the log file dev_selfex.out from the self-extraction process of
the installer, which might be useful if an error occurs.

Caution

If the installer cannot find a temporary directory, the installation terminates with the error FC0O-00058.

To see alist of all available installer properties, open a command prompt and start the installer with
command line parameter -p:

sapinst.exe -p

If you want to perform the export in unattended mode, see SAP Note 2230669#% which describes an
improved procedure using inifile.params.

Before starting the export steps on the central instance of the source system, make sure that you have at
least the same amount of disk space available in \\SAPLOC\<SAPSID>\<InstanceName>\<SAPSID>
\programas is used in \\SAPLOC\<SAPSID>\<InstanceName>\<SAPSID>\root\origin. During the
export some archives are written to the program subdirectories and the tool aborts if there is not enough
space.

If required, stop the installer by choosing the Cancel button.

1 Note

If you need to terminate the installer, choose ||» File » Exit 3 in the menu of the Program Starter window.

411.3.2 Interrupted Processing of the Installer

Here you find information about how to restart the installer if its processing has been interrupted.

Context

The processing of the installer might be interrupted for one of the following reasons:

An error occurred during the Define Parameters or Execute phase:

The installer does not abort the installation in error situations. If an error occurs, the installation pauses
and a dialog box appears. The dialog box contains a short description of the choices listed in the table
below as well as a path to a log file that contains detailed information about the error.

You interrupted the processing of the installer by choosing Cancel in the SL Common GUI.
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Caution

If you stop an option in the Execute phase, any system or component installed by this option is
incomplete and not ready to be used. Any system or component uninstalled by this option is not
completely uninstalled.

The following table describes the options in the dialog box:

Option Definition

Retry The installer retries the installation from the point of failure without repeating any of
the previous steps.
This is possible because the installer records the installation progress in the
keydb.xml file.
We recommend that you view the entries in the log files, try to solve the problem, and
then choose Retry.
If the same or a different error occurs, the installer displays the same dialog box
again.

Stop The installer stops the installation, closing the dialog box, the installer GUI, and the
GUI server.
The installer records the installation progress in the keydb . xm1 file. Therefore, you
can continue the installation from the point of failure without repeating any of the
previous steps. See the procedure below.

Continue The installer continues the installation from the current point.

View Log Access installation log files.

The following procedure describes the steps to restart an installation, which you stopped by choosing Stop, or
to continue an interrupted installation after an error situation.

Procedure

1. Logontothe installation host as a user with the required permissions as described in Running the Installer
[page 38].

2. Make sure that the media required for the export are still available.

For more information, see Preparing the Media Required for Performing the Export [page 30].

= Recommendation

Make the installation media available locally. For example, if you use remote file shares on other
Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from
media mounted with NFS might fail.
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3. Restart the installer by double-clicking sapinst.exe from the directory to which you unpacked the
Software Provisioning Manager archive.
By default, the SL Common GUI uses the default browser defined for the host where you run the installer.
However, you can also specify another supported web browser available on the host where you start the
installer. You can do this by starting the sapinst executable with command line option
SAPINST BROWSER=<Path to Browser Executable>, for example
SAPINST BROWSER=firefox.exe.

4. Theinstaller is restarting.

The installer now starts and waits for the connection with the SL Common GUI. If you have a supported
web browser (see Prerequisites for Running the Installer [page 36]) installed on the host where you run the
installer, the SL Common GUI starts automatically by displaying the Welcome screen.

If the SL Common GUI does not open automatically, you can find the URL you require to access the SL
Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program
Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from
there.

kA hkkhkhhkhk Ak h bk hhkrhhkhkhhkh kA hh bk hhkrhhkhkhhkhhkhkhhhkhhkrhhkhkhhkrkhkhhkrhhkrhkkhkhhkrkkxkkx*x*k

Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html

Logon users: [<users>]
Ak hkhkhkhkhkhhkhkhhkhhkhhhkhr kb hkhkhhrhkhhkhhdhkhhkhkhhk kb h kb bk ok bk bk dh ko hkhhkhkhkkhkhkhkhk ok hkkkhkhkkx*k

The SL Common GUI opens in the browser by displaying the Welcome screen.

1 Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst
process on this computer could not be verified. Accept this warning to inform your browser that it can
trust this site, even if the certificate could not be verified.

5. From the tree structure on the Welcome screen, select the installation option that you want to continue and
choose Next.

The What do you want to do? screen appears.

6. Onthe What do you want to do? screen, decide between the following alternatives and continue with Next:
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Alternative

Perform a new run

Behavior

The installer does not continue the interrupted export for system copy option.
Instead, it moves the content of the old installer directory and all installer-spe-
cific files to a backup directory. Afterwards, you can no longer continue the old
option.

The following naming convention is used for the backup directory:

log <Day> <Month> <Year> <Hours> <Minutes> <Seconds>

Example

log 01 Oct 2016 13 47 56

1 Note

All actions taken by the export for system copy before you stopped it (such
as creating directories or users) are not revoked.

Caution

The installer moves all the files and folders to a new log directory, even if
these files and folders are owned by other users. If there are any processes
currently running on these files and folders, they might no longer function
properly.

Continue with the existing one

The installer continues the interrupted export for system copy from the point of
failure.

411.3.3 Troubleshooting with the Installer

This section tells you how to proceed when errors occur while the installer is running.

Context

If an error occurs, the installer:

e Stops processing

® Displays a dialog informing you about the error
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Procedure

1. Check SAP Note 1548438#% for known installer issues.
2. If anerror occurs during the Define Parameters or the Execute Service phase, do one of the following:

o Try to solve the problem:

o To check the installer log files (sapinst.logand sapinst dev.log) for errors, choose the LOG
FILES tab.

1 Note

The LOG FILES tab is only available if you have selected on the Welcome screen the relevant
installer option for the SAP system to be exported .

If you need to access the log files before you have done this selection, you can find the files in
the . sapinst directory underneath the <Drive>:\Users\<User> directory, where <User> is
the user which you used to start the installer.

Fore more information, see Useful Information About the Installer [page 42].

o To check the log and trace files of the installer GUI for errors, go to the directory Suserprofile%
\.sapinst\

©  Then continue by choosing Retry.

o If required, abort the installer by choosing Cancel in the tool menu and restart the installer. For more
information, see Interrupted Processing of the Installer [page 43].

3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*,

For more information about using subcomponents of BC-INS* see SAP Note 1669327 ¥ .

41134 Troubleshooting during the Export Process

If the export process aborts during the Execute Service phase (for example, due to a hardware failure, such as
power outage, operating system crash, file system full), you have to repeat the export of the complete package.

Procedure

e System Copy — export (common issues)
a. Remove the <Package>.<nnn>dump files, the <Package>.TOC file, and the <Package>. log file.
b. Make sure that all tables in the <Package>. *TSK* file have the status flag xeq or err set.

c. Repeat the export of the complete package.
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41135 Using the Step State Editor (SAP Support Experts
Only)

This section describes how to use the Step State Editor available in the installer.

1 Note

Only use the step State Editor if the SAP Support requests you to do so, for example to resolve a
customer incident.

Prerequisites

e SAP Support requests you to use the Step State Editor.

e Make sure that the host where you run the installer meets the requirements listed in Prerequisites for
Running the Installer [page 36].

Procedure

1. Start the installer from the command line as described in Running the Installer [page 38] with the
additional command line parameter SAPINST SET STEPSTATE=true

2. Follow the instructions on the installer screens and fill in the parameters prompted during the Define
Parameters phase until you reach the Parameter Summary screen.
3. Choose Next.

The step State Editor opens as an additional dialog. Within this dialog you see a list of all steps to be
executed by the installer during the Execute Service phase. By default all steps are in an initial state.
Underneath each step, you see the assigned installer component. For each step you have a Skip and a
Break option.

o Mark the checkbox in front of the Break option of the steps where you want the installer to pause.
o Mark the checkbox in front of the Skip option of the steps which you want the installer to skip.

4. After you have marked all required steps with either the Break or the Skip option, choose OK on the Step
State Editor dialog.

The installer starts processing the Execute Service phase and pauses one after another when reaching
each step whose Break option you have marked. You can now choose one of the following:

o Choose OK to continue with this step.

o Choose Step State Editor toreturnto the Step State Editor and make changes, for example you
can repeat the step by marking the checkbox in front of the Repeat option.

o Choose Cancel to abort the installer.

5. Continue until you have run through all the steps of the Execute Service phase of the installer.
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4.1.2 Setting Up the Target System

Related Information

Transferring the Export Files to the Target Host [page 49]
Installing the Target System [page 50]

412.1 Transferring the Export Files to the Target Host

This section describes how to transfer the complete export directory with its structure and the generated
DBSIZE.XML file to the target host.

Context

As an alternative, you can also share the complete export directory so that it can be accessed from the target
host.

Procedure

1. Onthe target host, create a directory <ExpPDIR> with sufficient space for the database export files
available.

Caution

Do not create this directory under the installation directory or another directory that contains
installation information (such as the installation media or other export files).

Otherwise, the installer does not ask you to specify the export directory and automatically chooses one
that you may not want to use. In this case, the installer does not display the export directory and you
cannot change it.

2. Transfer all files and directories (recursively) that are located on the source host in the migration export
directory <ExPDIR> from the source host to the target host.

You can choose one of the following methods:

o Use the migration monitor with the file transfer protocol (FTP) copy option.

1 Note

Make sure that you use binary mode for transferring the files.
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o Copy the export dump directory manually to the target host.
o The export dump directory can be shared and thus made accessible on the target host (network
share).

3. Check the permissions of the transferred files on the target host. All files have to be accessible for user
<sapsid>adm of the target system.

1 Note

If your source system is a distributed system, the files created by the export of the central instance and
the files created by the export of the database instance have to be located in the same <EXPDIR>
directory for the installation of the target system.

If you have not exported into the same <EXPDIR> already, then you have to merge the two <EXPDIR>
directories from the central instance export and from the database instance export before starting the
target system installation.

Make sure you use the SOURCE . PROPERTIES file from the central instance export when merging the
two export folders.

41.2.2 Installing the Target System

This section describes how to set up the target system using the installer.

Prerequisites

There is enough free space on the target system for the database load. To find out the size of the export and the
sizes of the tablespaces or dbspaces that will be created, look at the file DBSIZE . xML, which is located in the
following directory:

Windows: <DRIVE>:\<EXPDIR>\DB\<DATABASE>
UNIX, IBM i: <EXPDIR>/DB/<DATABASE>

SAP MaxDB only: If the database platform of your target system is SAP MaxDB, you must reserve at least two
times the amount of space specified in the DBSIzE . XML file. During the import, monitor the remaining free
space in the database using the SAP MaxDB administration tools Database Manager or Database Studio
and increase it if required.

1 Note

The compression information is not available in the life-cycle of a Java system. Therefore, there is no
information about the source system contained in the DBSIZE . XML file.

You can set the compression in the target system by creating compressed tablespaces during the Define
Parameters phase of the target system installation. However, compression is not set automatically in the
DBSIZE.XML during a system copy.
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Procedure

1. Prepare the target system host as described in the installation guide for the operating system and
database platform intended for the target system. You can find this installation guide at:

http://support.sap.com/sltoolset® |+ Area System Provisioning # Guide for Installation of Systems Based
on SAP NetWeaver 7.0 / 7.0 EHPs

1 Note
IBM DB2 for Linux, UNIX and Windows only:

Make sure that you read the information provided in section Setup of Database Layout in the installation
documentation.

2. Start the installer as described in the installation guide for the operating system and database platform
intended for the target system.

Caution

If you plan to use Advanced Configuration options during the SAP System Database Import, make sure
you have installed the most current version of the installer to avoid performance problems during the
dialog phase. You can find the latest version of the installer on the SAP Service Marketplace.

3. Onthe Welcome screen, navigate to the following folder according to the requirements of your target
system: [ <Product> » Software Life-Cycle Options ¥ System Copy » <Database> » Target System
Installation » <System Variant> » Based on <Technical Stack> J.

4. Runthe installation options required for your system copy in the sequence they are listed in the specific
folder and according to process flow in Setting Up the Target System Using the Installer [page 49].

5. Toinstall the target system, follow the instructions in the installer input screens (Define Parameters phase)
and enter the required parameters.

Caution

Heterogeneous system copy: When installing the database instance, you either have to choose
parameter mode Custom or have to check the SAP System > Database Import dialog on the summary
screen and then revise this dialog. Only then appears the dialog screen where you can enter the
migration key, which is required for a heterogeneous system copy. If you forget to revise this dialog
setting during the dialog phase, the installer will abort in the processing phase when checking the
migration key and will ask you for a valid migration key.

1 Note

Oracle Database only: If your source system has Oracle Database Vault, consider the additional
information in section Implementing Oracle Database Vault with the Installer [page 135].

o Onthe SAP System > Database screen, choose the option Standard System Copy/Migration (load-

based):
The SAP data dump from the migration export media that was created during the export is loaded into
the newly installed SAP system database.
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o When the installer prompts for the migration export, enter the path to the export directory <EXPDIR>.

Caution

IBM DB2 for Linux, UNIX and Windows only:
o Make sure that you take the information about automatic storage that is provided in the Running the
Installer section in the appropriate installation guide into consideration.
o The option Deferred Table Creation is not supported for load-based system copies for SAP systems
that are not based on SAP NetWeaver 7.0 or higher.
o Do not create the installation directory (for example, sapinst instdir) under the following
directories:
o UNIX, IBMi: /usr/sap/<SAPSID>
Windows: \usr\sap\<SAPSID>
o UNIX, IBMi: /sapmnt/<SAPSID>
Windows: \ sapmnt\<SAPSID>

6. Complete the installation as described in the installation documentation for your SAP component.

1 Note

If you have to restart the import after an error, just restart the installer. The import continues with the
table that has not yet been successfully imported.

System Copy for SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to
7.03 on Windows
52 PUBLIC Database Independent System Copy



5 Database-Specific System Copy

The following sections describe the database-specific methods for the system copy.

Process

Follow the sequence of steps described in the process flows below for a:

e (Central System
e Distributed System
e High Availability System

Central System

Process Flow on the Source System (Export)

1 Note

When performing the export, the installer creates a migration export media which contains the data of the
exported system, and which you use to install the target system.

1. Oracle only: Generate the control file structure for the target database [page 59].
2. Oracle only: If required, create an offline backup of the source database [page 68].

3. Runtheinstaller [page 38] to create the export directory structure with labels and to archive SDM and
application-specific file system content.
In the installer, choose the option that corresponds to your database, SAP system, and technology, and
then Database and Central Instance Export.

Example

Choose |# SAP NetWeaver including <Enhancement Package> » Software Life-Cycle Options »
System Copy # <Database> #» Source System Export » Central System » Based on AS ABAP and AS

Java » Database and Central Instance Export 3

Process Flow on the Target System

1 Note

For the target system installation, you use the installation guide for your target operating system and
database, available at http:/support.sap.com/sltoolset® |+ System Provisioning ¥ Installation Option of

Software Provisioning Manager ¥ Installation Guides - Application Server Systems 3. In the following we refer

to this documentation as “installation guide”.
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1. Install the database software as described in the installation guide.

2. Start the installer as described in the installation guide and follow the instructions on the installer screens
until you are requested to perform the database backup/restore.

1 Note

If required, restart the installer as described in the installation guide for your operating system and
database, available at http:/support.sap.com/sltoolset# | System Provisioning ¥ Installation Option

of Software Provisioning Manager # Installation Guides - Application Server Systems 3.

3. To complete the system copy, you perform the follow-up activities [page 87].

Distributed System or High Availability System

Process Flow on the Source System (Export)

1 Note

When performing the export, the installer creates a migration export media which contains the data of the
exported system, and which you use to install the target system.

1. Oracle only: On the database instance host of the source system, generate the control file structure for
the target database [page 59].

2. Oracle only: If required, on the database instance host, create an offline backup of the source database
[page 68].

3. Onthe central instance host, run the installer [page 38] to create the export directory structure with
labels and to archive SDM and application-specific file system content.
In the installer, choose the option that corresponds to your database, SAP system, and technology, and
then Central Instance Export.

Example

Choose | SAP NetWeaver including <Enhancement Package> # Software Life-Cycle Options
System Copy # <Database> # Source System Export ¥ Distributed System ¥ Based on AS ABAP and
AS Java ¥ Central Instance Export J

Process Flow on the Target System

1 Note

For the target system installation, you use the installation guide for your target operating system and
database, available at http:/support.sap.com/sltoolset® |+ System Provisioning ¥ Installation Option of

Software Provisioning Manager » Installation Guides - Application Server Systems 3. In the following we refer
to this documentation as “installation guide”.

1. Onthe database instance host, install the database software as described in the installation guide.
2. On the database instance host start the installer as described in the installation guide, follow the
instructions on the installer screens until you are requested to perform the database backup/restore.
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1 Note

If required, restart installer as described in the installation guide.

3. To complete the system copy, you perform the follow-up activities [page 87].

5.1 Oracle-Specific Procedure

Purpose

In an SAP system environment, you can create a homogeneous copy of an Oracle database by copying
database files. This method is suitable for creating an exact copy of an existing database. The source of the
copy can be an online or offline backup, or the file system of your source host.

You use the installer for the installation on the target system host as described in the installation
documentation for your SAP component. Only the installer steps for setting up and loading the database steps
are different.

Advantages

e You can use existing offline backups (provided that redo logs were cleaned up with forced log switches).
® This method is faster than the Jload method.

Disadvantages

e (Offline backup/copy of database files in a heterogeneous environment is not possible because the
hardware of the source and target systems must be binary-compatible.

e Source system host and target system host must be different.
e You must shut down the SAP system and the database during offline backup/copy of database files.
® You cannot change the database schema and the tablespace names.

Prerequisites

e You must use the same Oracle release and patch level for your database in the source and target system.
® The source and target systems must run on different hosts for security reasons.
® The source and target systems must be binary compatible.
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1 Note

You can also perform a system copy from 32-bit systems to 64-bit systems and the other way around
(same operating system assumed) even if source and target system are not binary compatible.

e |f your source system uses the US7ASCIT character set, you must choose this character set when
installing the target system. The installer prompts for the character set during the installation (key:
Database Character Set). Theinstallation defaultis wE8DEC or UTF8 for Unicode systems. To find out
the character set used by the source system, connect to the source database as user sap<schemaid> or
sapr3 with sqlplus and enter: SELECT * FROM V$NLS_ PARAMETERS;

e |f your source system has Oracle Database Vault, consider the additional information in section
Implementing Oracle Database Vault with the Installer [page 135].

Oracle Storage-Based System Copy Methods Available in the Installer

You can choose between the following methods:

e Database already recovered, continue with database-specific post activities
You have already performed backup/restore with Oracle-specific methods. In this case, the installer does
not need to perform the backup/restore. You just have to ensure that the restored Oracle database on your
target system is up and running.

e Performing Online or Offline Recovery with saphostctrl [page 56]

e Usinga CONTROL.SQL File Created by the ORABRCOPY Tool [page 59]

Related Information

Database-Specific System Copy [page 53]

5.1.1 Performing Online or Offline Recovery with
“saphostctrl”

This section describes how to perform a recovery using saphostctrl.

For the offline recovery method, we recommend that you shut down the database. Alternatively, the software
provisioning manager (the “installer” for short) can also make an instance recovery of the database if it has not
been shut down before the copy process.

For the online recovery method, you have to set the database to a backup mode and the backup control files
and the oracle archives will be copied to an existing shared directory.

A “shared directory” can be any directory path which the source system and the target system can access. The
archives and also the init<SID>.ora files from the source system will be saved in this directory
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Restrictions

You cannot change the database schemas SAP<SchemaId>and SAP<SchemaId>DB. Thereisno “move”
schema.

The <DBSID> can be changed because the rename process is able to create new control files with a new
<DBSID>.

The <sAPs1ID> can be also changed.

Related Information

Performing Online Recovery [page 57]
Performing Offline Recovery [page 58]

51.11 Performing Online Recovery

For the online recovery method, you have to proceed as follows.

Procedure

1. You can set the source database to a backup mode using the following command:
saphostctrl -user sapadm <Password> -function PrepareDatabaseCopy -dbname
<DBSID> -dbtype ora -dbconfdir <shared directory> -copymethod Online -timeout -1
Back up the data files, for example using image copy or snapshot technology.

3. After the database backup has finished, you have to set the database back to a normal mode using the
following command:
saphostctrl -user sapadm <password> -function FinalizeDatabaseCopy -dbname
<DBSID> -dbtype ora -dbconfdir <shared directory> -copymethod Online -timeout -1

4. You can copy the database from the source to the target system but alternatively, you can also install the
Oracle database software in the target system.

It is possible to copy the Oracle database software automatically with the tool when the database software
has the same <DBSID> as the database <DBSID>.
Example
<Source DBSID> = C67
<Target DBSID> = T67

The Oracle software is under c:\oracle\C67\112 and the Oracle database files are under c: \oracle
\C67 and d:\oracle\C67.
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The tool moves c:\oracle\C67toc:\oracle\T67 andd:\oracle\C67tod:\oracle\T67 with all
subdirectories.

If there are database files under the directory that contains the Oracle software and you do not want to
move the Oracle software, you have to move the database directory manually.

For more information about how to install the Oracle database software, see section Installing the Oracle
Database Software in the Installation Guide - Installation of SAP Systems Based on the Application Server
ABAP of SAP NetWeaver 7.0 to 7.03 on Windows : Oracle at https://support.sap.com/sltoolset# |»
System Provisioning ¥ Installation Option of Software Provisioning Manager ¥ Installation Guides -
Application Server Systems 1.

Start the target system installation and follow the instructions on the installer screens.

Start the target system installation as described in the Installation Guide - Installation of SAP Systems
Based on the Application Server ABAP of SAP NetWeaver 7.0 to 703 on Windows : Oracle at https://
support.sap.com/sltoolset® ||» » System Provisioning ¥ Installation Option of Software Provisioning
Manager ¥ Installation Guides - Application Server Systems 3

On the Performing Oracle Storage Based System Copy screen, select option Online or Offline Recovery
Method with saphostctrl

511.2 Performing Offline Recovery

For the offline recovery method, you have to proceed as follows.

Procedure

Shut down the source database.

2. Back up the data files, for example using image copy or snapshot technology.

3. Start the target system installation and follow the instructions on the installer screens.
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Start the target system installation as described in the Installation Guide - Installation of SAP Systems
Based on the Application Server ABAP of SAP NetWeaver 7.0 to 7.03 on Windows : Oracle at https://

support.sap.com/sltoolset# || » System Provisioning » Installation Option of Software Provisioning
Manager ¥ Installation Guides - Application Server Systems J

On the Performing Oracle Storage Based System Copy screen, select option Online or Offline Recovery
Method with saphostctrl.

Leave the dialog field of the <shared directory>empty while performing an offline recovery while no
additonal files from the source system are needed.

When the installer stops for database restore, copy all saved files to the target System.

Make sure that you also copy the source init<SID>.ora file
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5.1.2 Using a CONTROL.SQL File Created by the ORABRCOPY
Tool

Related Information

Generating the Control File Structure [page 59]

Preparing the Target System (Oracle) [page 63]

Restoring Database Files on the Target System [page 65]

Restoring the Database Files on the Target System with BR*Tools [page 66]

5.1.2.1 Generating the Control File Structure

Use

The 0raBRCopy Java tool writes a file CONTROL . SQL to the current working directory, which can be used
without further adaptations on the target system.

For more information about command line options and output files of the 0OraBRCopy tool, see Additional
Information about the OraBRCopy Tool [page 139].

Prerequisites

= Recommendation

We recommend that you shut down the SAP system before you perform the following steps. The database
must still be running.

Procedure

1. Create aninstallation directory <INSTDIR> on the source system.

2. Copy the ORABRCOPY . SAR archive from the directory to which you unpacked the
SWPM10SP<Support Package Number> <Version Number>.SAR file and extractit using SAPCAR.
You can find the archive in the following directory:
<Path To Unpack Directory>\COMMON\INSTALL\ORA\ORABRCOPY.SAR

3. Make sure that all redo log groups are archived
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4. Startthe oraBRCopy tool as an OS user with Oracle DBA privileges:
O userora<dbsid>
O user<sapsid>adm

5. Executethe ora br copy.bat scriptin one of the following ways:

o If you perform an offline manual copy, enter the following commands:
ora_br_ copy.bat -generateFiles -forceLogSwitches -targetSid <TARGET_DBSID> -
password <system password> -listenerPort <listener_ port>
The tool creates the files CONTROL.SQL, CONTROL.TRC and init<targetSID>.ora inyour
installation directory, shuts down and restarts the database and performs the required log switches.

o If you perform an offline or online backup using BR*Tools, enter the following commands:
ora_br copy.bat -generateFiles -targetSid <TARGET_ DBSID> -password
<system password> -listenerPort <listener_ port>

1 Note

During the online backup, the database must be up and running. To ensure this, this command must
not contain the parameter -forcelLogSwitches.

The tool creates the files CONTROL.SQL, CONTROL.TRC and init<targetSID>.ora inyour
installation directory, and performs the required log switches.

1 Note
If an error occurs, check the log file:
<INSTDIR>/ora.brcopy.log

6. Verify and, if necessary, update the CONTROL. SQL control file using the CONTROL . TRC trace file as follows.

Example

In the following example, entries of CONTROL. SQL written in bold should be compared and changed according
to the trace file:

REM

REM CONTROL.SQL

REM

REM SAP AG Walldorf

REM Systeme, Anwendungen und Produkte in der Datenverarbeitung
REM

REM (C) Copyright SAP AG 2004

REM

REM Generated at:
REM Fri Sep 17 08:33:25 CEST 2005
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REM for target system NEW

REM on

REM Windows 2000 5.0 x86

CONNECT / AS SYSDBA

STARTUP NOMOUNT

CREATE CONTROLFILE REUSE

SET DATABASE "NEW"

RESETLOGS

ARCHIVELOG

MAXL.OGFILES 255

MAXI.OGMEMBERS 3

MAXDATAFILES 1022

MAXINSTANCES 50

MAXLOGHISTORY 1134

LOGFILE

GROUP 1 (

'D: \ORACLE\NEW\ORIGLOGA\LOG G11M1.DBF',
'D: \ORACLE\NEW\MIRRLOGA\LOG_G11M2.DBF'
) SIZE 50M,

GROUP 2 (

'D:\ORACLE\NEW\ORIGLOGB\LOG G12M1.DBF',
'D: \ORACLE\NEW\MIRRLOGB\LOG_ G12M2.DBF"'
) SIZE 50M,

GROUP 3 (

'D: \ORACLE\NEW\ORIGLOGA\LOG G13M1.DBF',
'D: \ORACLE\NEW\MIRRLOGA\LOG G13M2.DBF'
) SIZE 50M,

GROUP 4 (

'D:\ORACLE\NEW\ORIGLOGB\LOG G14M1.DBF',
'D:\ORACLE\NEW\MIRRLOGB\LOG G14M2.DBF'
) SIZE 50M

DATAFILE

'D:\ORACLE\NEW\SAPDATAI\SYSTEM 1\SYSTEM.DATAl',
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'D:\ORACLE\NEW\SAPDATA3\IMS 1\IMS.DATAl',

'D:\ORACLE\NEW\SAPDATA3\IMS 2\IMS.DATA2',

'D:\ORACLE\NEW\SAPDATA3\IMS 3\IMS.DATA3',

'D:\ORACLE\NEW\SAPDATA3\IMS 4\IMS.DATA4',

'D:\ORACLE\NEW\SAPDATA4\IMS 5\IMS.DATAS5',

'D:\ORACLE\NEW\SAPDATA4\IMS 6\IMS.DATA6',

'D:\ORACLE\NEW\SAPDATA4\IMS 7\IMS.DATA7',

'D:\ORACLE\NEW\SAPDATA4\IMS 8\IMS.DATA8',

'D:\ORACLE\NEW\SAPDATA4\IMS 9\IMS.DATA9',

'D:\ORACLE\NEW\SAPDATA1\IMS700 1\IMS700.DATAl'

'D:\ORACLE\NEW\SAPDATAI\IMS700 2\IMS700.DATA2'

'D:\ORACLE\NEW\SAPDATAI\IMS700_ 3\IMS700.DATA3'

'D:\ORACLE\NEW\SAPDATAI\IMS700_4\IMS700.DATA4'

'D: \ORACLE\NEW\SAPDATA2\IMS700 5\IMS700.DATA5'

'D:\ORACLE\NEW\SAPDATA2\IMS700_ 6\IMS700.DATA6'

'D:\ORACLE\NEW\SAPDATA2\IMS700_7\IMS700.DATA7'

'D:\ORACLE\NEW\SAPDATA2\IMS700 8\IMS700.DATAS8'

'D:\ORACLE\NEW\SAPDATA2\IMS700_ 9\IMS700.DATA9'

: \ORACLE\NEW\SAPDATA3\IMS700 10\IMS700.DATA10Q',

:\ORACLE\NEW\SAPDATA4\IMS700 11\IMS700.DATAll"',

'D:\ORACLE\NEW\SAPDATAI\IMSUSR 1\IMSUSR.DATAl'

'D:\ORACLE\NEW\SAPDATA2\ROLL 1\ROLL.DATAl'

ALTER DATABASE OPEN RESETLOGS;

ALTER TABLESPACE PSAPTEMP ADD TEMPFILE

'D:\ORACLE\NEW\SAPDATA3\TEMP_ 1\TEMP.DATAL'

SIZE 350M REUSE AUTOEXTEND OFF;

1 Note

4

14

’

’

I4

’

r

4

I4

I4

In the above example, entries and values of CONTROL . SQL written in bold should be compared to the trace
file.

Changes to be made
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1. If you want to migrate your database from 32-bit to 64-bit or vice versa, add the following lines at the
bottom of the CONTROL. SQL file:
shutdown immediate
startup upgrade
spool utlirp.log
@?/rdbms/admin/utlirp.sql
spool off
shutdown immediate
startup
spool utlrp.log
@?/rdbms/admin/utlrp.sql
spool off
exit

2. MAXLOGFILES 255

The numbers must be greater than or equal to the corresponding numbers in the trace file.
3. GROUP 1 (

'D:\ORACLE\NEW\ORIGLOGA\LOG G11M1.DBF',

'D: \ORACLE\NEW\MIRRLOGA\LOG G11M2.DBF"

) SIZE 50M,

Group 2 (

The sizes of the respective groups must be equal to the sizes of the corresponding groups in the trace file.

4. 'D:\ORACLE\NEW\SAPDATAI\SYSTEM 1\SYSTEM.DATAl',
'D:\ORACLE\NEW\SAPDATA3\IMS 1\IMS.DATAl',

'D:\ORACLE\NEW\SAPDATAI\IMS700_1\IMS700.DATAl'

The count of the data files must be equal to the count of the corresponding data files in the trace file.

5. ALTER TABLESPACE PSAPTEMP ADD TEMPFILE
'D:\ORACLE\NEW\SAPDATA3\TEMP_ 1\TEMP.DATAL'
SIZE 350M REUSE AUTOEXTEND OFF;

The size must be equal to the corresponding size in the trace file.

6. The number of rows with ALTER TABLESPACE must be equal to the number of corresponding rows in the

trace file.

512.2 Preparing the Target System (Oracle)

This section describes how to prepare the target system for Oracle-specific system copy.

Prerequisites

Make sure that sapdata<n> file systems on the target system host are large enough.
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Procedure

1. Install the target SAP system with the installer as described in the installation documentation for your SAP
solution.

Caution

When you perform a system copy with the Oracle backup/restore method, you cannot change the
database schema and the table space names of the new target system. When installing the target
central instance, database instance, or dialog instance make sure that you enter the correct database
schema names (which are the database schema name of the source system). The schema names of the
source and target system must be identical.

a. Onthe Welcome screen, choose [r <SAP Product> § Software Life-Cycle Options ¥ System Copy #
<Database> ¥ Target System Installation  <System Variant> 3.

b. When the installer prompts for the installation type, choose Homogeneous System Copy (Backup/
Restore).

c. Proceed until the installer stops to restore the database files on the target system.
The following message is displayed:

SAPinst now stops the installation. Please proceed as follows:...
2. Ifthey do not exist, create the following directories on the target system:
O <drive>:\oracle\<TARGET DBSID>\mirrlog<x>
O© <drive>:\oracle\<TARGET DBSID>\origlog<x>
O <drive>:\oracle\<TARGET DBSID>\sapdata<x>
© <drive>:\oracle\<TARGET DBSID>\sapreorg
O <drive>:\oracle\<TARGET DBSID>\saparch
O <drive>:\oracle\<TARGET DBSID>\oraarch
O <drive>:\oracle\<TARGET DBSID>\saptrace
O <drive>:\oracle\<TARGET DBSID>\saptrace\background
© <drive>:\oracle\<TARGET DBSID>\saptrace\usertrace
O <drive>:\oracle\<TARGET DBSID>\origlogA\cntrl
O <drive>:\oracle\<TARGET DBSID>\sapdatallcntrl
0 <drive>:\oracle\<TARGET DBSID>\saparch\cntrl
O <drive>:\oracle\<TARGET DBSID>\sapcheck
3. Make sure that the following directories are empty (except the subdirectory saparch/cntrl):
O <drive>:\oracle\<TARGET DBSID>\saparch
O <drive>:\oracle\<TARGET DBSID>\oraarch
4. Set the security settings for the built-in accounts and groups SYSTEM, Administrators,
SAP <SAPSID> GlobalAdmin (domain installation), and SAP <SAPSID> LocalAdmin (local
installation) for all directories as follows:
a. Inthe Windows Explorer, right-click the Oracle root directory and choose Properties.
b. Under Security, choose Advanced.
c. Deselect Allow inheritable permissions from the parent....
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d. Inthe next dialog, choose Copy to copy the permission entries that were previously applied from the
parent to this object.

e. Choose OK.

f.  Set the permissions for the above-mentioned accounts SYSTEM, Administrators,
SAP_<DBSID> GlobalAdmin, Or SAP <DBSID> LocalAdmin to Full Control.

g. Delete all other accounts.

5. Restore the database files on the target system either manually (see Restoring Database Files on the
Target System Manually [page 65]) or with BR*Tools (see Restoring the Database Files on the Target
System with BR*Tools [page 66]), then proceed with the installer.

51.2.3 Restoring Database Files on the Target System

Use

Caution

If you do not use an offline backup, but copy the database files directly from the source to the target system
host, make sure that you shut down the database on the source system before you copy the listed files from
the source to the target directories.

Procedure

1. Copy the following files from the source to the target system host by copying the listed files from the
source directories to the target directories. For more information, see Creating an Offline Backup Manually

[page 68].

Source and Target Directory ’ Files
<drive>:\oracle\<DBSID>\sapdata<x> All files
<drive>:\oracle\<DBSID>\origlog<x> All files
<drive>:\oracle\<DBSID>\mirrlog<x> All files
Source: <INSTDIR> CONTROL. SQL

Target: <SAPINST INSTDIR>

Target (Java only): éprogramfiles%\sapinst instdir
\NWO4SR1\WEBAS_COPY\CENTRAL\ONE_HOST Or $programfiles$%
\Sapinstiinstdir\NWO4SRl \WEBASiCIOPY\DI STRIBUTED\DB
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Source and Target Directory

Source: <INSTDIR> init<TARGET_DBSID>.ora

Target: \oracle\<DBSID>\<DB VERSION> <BIT>\database

1 Note

If you use an existing offline backup, the source data files and log files are not located in the directories
shown in the table.

The installation directory of the target system is normally located in the directory:

$programfiles$\sapinst instdir\NWO4S\LM\COPY\ORACLE\SYSTEM\<system variant>

. After you have copied the database files, make sure that the files on the source and target system are not

located in different directories or drives. If required, make the corresponding changes in the files
control.sql andthe init<DBSID>.ora.

Verify that the created directories and copied files have the owner ora<target dbsid>, belongto the
group dba, and have the permissions 740.

Make sure that the control files are not restored. If necessary, remove them.
The file names are specified by the control files parameter of the init<TARGET DBSID>.ora file.

51.24 Restoring the Database Files on the Target System
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with BR*Tools

Copy the following files from the source system host to the target system host by copying manually the
listed files from the source directories to the target directories.

Source and Target Directories on Windows

Source and Target Directory ‘ Files

Source: <INSTDIR> CONTROL. SQL
Target: <SAPINST INSTDIR>

Target (Java only): éprogramfiles%\sapinst instdir
\NWO4SR1\WEBAS COPY\CENTRAL\ONE HOST or $programfiles%
\sapinst instdir\NWO4SR1\WEBAS COPY\DISTRIBUTED\DB

Source: <INSTDIR> init<TARGET DBSID>.ora

Target: \oracle\<DBSID>\<DB VERSION> <BIT>\database

Call the restore and recovery function of BR*Tools.

For more information about the required steps and prerequisites, see SAP Note 1003028 # .

The main prerequisite is that the corresponding BR*Tools logs (BRBACKUP detailed and summary log,
BRARCHIVE summary log) are copied manually from the source to the target system. In addition, the
postprocessing steps mentioned in this SAP Note are performed automatically by the installer.
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SAP Note 1003028#% also comprises information about executing restore and recovery under the control
of BRRECOVER and the exact syntax of BRRECOVER (see section Homogeneous Database Copy).
For more information about BR*Tools, see the SAP Library for your release at:

SAP NetWeaver Release

SAP NetWeaver 7.0

Location

http://help.sap.com/nw70 # |} Application Help >
Function-Oriented View <Language> > Solution Life
Cycle Management by Key Capability > General
Administration Tasks > Database Administration >
Database Administration for Oracle > SAP Database
Guide: Oracle » BR*Tools for Oracle DBA 4

SAP NetWeaver 7.0 including EHP1

http://help.sap.com/nw701 %% 3 Application Help >
Function-Oriented View <Language> > Solution Life
Cycle Management by Key Capability > General
Administration Tasks > Database Administration >
Database Administration for Oracle » SAP Database
Guide: Oracle y BR*Tools for Oracle DBA J

SAP NetWeaver 7.0 including EHP2

http://help.sap.com/nw702#% |l Application Help
Function-Oriented View <Language> > Solution Life
Cycle Management by Key Capability > General
Administration Tasks # Database Administration ¥
Database Administration for Oracle > SAP Database
Guide: Oracle » BR*Tools for Oracle DBA 4

SAP NetWeaver 7.0 including EHP3

http://help.sap.com/nw703 |} Application Help >
Function-Oriented View <Language> # Solution Life
Cycle Management by Key Capability ¥ General
Administration Tasks > Database Administration >
Database Administration for Oracle » SAP Database
Guide: Oracle  BR*Tools for Oracle DBA J

3. Shut down the Oracle database instance as follows:

sqlplus /nolog
connect / as sysdba
shutdown immediate
exit
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5.1.3 Creating a Backup

Create a backup if required. Choose between the following possibilities: Performing an offline backup manually
or an offline or online backup with BR*Tools.

Related Information

Creating an Offline Backup Manually [page 68]
Creating an Offline or Online Backup with BR*Tools [page 68]

5.1.3.1 Creating an Offline Backup Manually

There are different possibilities to prepare the actual transfer of the database files:

e |f you have an up-to-date offline backup, you can use it (provided that redo 1ogs were cleaned up with
forced log switches).

e |f you want to transport the database file (for example, on tape) or if you have to perform the database
shutdown at a certain time, stop the database (normal shutdown) and perform a complete offline backup.
You can use the trace file CONTROL. TRC created by OraBrCOPY to determine the file system trees that
have to be saved.

® You stop the database (normal shutdown) and copy the database files when the actual transfer to the
target system takes place. You do not have to perform any preparations for the actual transfer now.
Proceed with the next step.

1 Note

If you choose this manual offline backup method, you also have to restore the database files on the target
system manually. For more information, see Restoring Database Files on the Target System Manually [page
65].

51.3.2 Creating an Offline or Online Backup with BR*Tools

Use

You can use any backup strategy supported by BR*Tools as the basis for a system copy: offline or online, with
or without BACKINT, with or without RMAN, complete or incremental, and so on. The backup strategy must
simply be valid for restore and recovery. This means that a complete restore and recovery of the source
database must be possible. In addition for BACKINT and RMAN, the external backup tools must be configured
so that a restore is possible on the target host.
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Procedure

Caution

To ensure that no changes are made to the file system during backup, stop the Software Deployment
Manager (SDM).

Proceed as described in the SAP Library for your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http://help.sap.com/nw70%% |B Application Help
Function-Oriented View <Language> # Solution Life Cycle
Management by Key Capability > Database Administration
for Oracle » SAP Database Guide: Oracle » BR*Tools for
Oracle DBA > BR*Tools in Action > Backup and Database
Copy with BR*Tools 4.

SAP NetWeaver 7.0 including EHP1 http:/help.sap.com/nw701#% | Application Help ¥
Function-Oriented View <Language> # Solution Life Cycle
Management by Key Capability > Database Administration
for Oracle # SAP Database Guide: Oracle » BR*Tools for
Oracle DBA > BR*Tools in Action > Backup and Database
Copy with BR*Tools }

SAP NetWeaver 7.0 including EHP2 http://help.sap.com/nw702 % | Application Help ¥
Function-Oriented View <Language> # Solution Life Cycle
Management by Key Capability > Database Administration
for Oracle > SAP Database Guide: Oracle > BR*Tools for
Oracle DBA > BR*Tools in Action > Backup and Database
Copy with BR*Tools }

SAP NetWeaver 70 including EHP3 http:/help.sap.com/nw703% | Application Help
Function-Oriented View <Language> > Solution Life Cycle
Management by Key Capability > Database Administration
for Oracle > SAP Database Guide: Oracle > BR*Tools for
Oracle DBA > BR*Tools in Action > Backup and Database
Copy with BR*Tools 3.
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1 Note

If you choose a backup method with BR*Tools. you also have to restore the database files on the target
system with BR*Tools. For more information, see Restoring the Database Files on the Target System with
BR*Tools [page 66].

5

In

.2 SAP MaxDB-Specific Procedure

an SAP system environment, you can create a homogeneous copy of an SAP MaxDB database by using the

backup and restore method. This method is suitable for creating an exact copy of an existing database. The
source of the copy is a complete data backup of your source database.

Prerequisites

70

Byte order - little-endian or big-endian

You can use the backup and restore method to copy systems with the same byte order. That is, you can
copy a system based on little-endian to another system based on little-endian. You can also copy a system
based on big-endian to another system based on big-endian. Check SAP Note552464# to find out which
processor and operating system combination uses which byte order.

Data backup

You perform the complete data backup of your source database.

Recovery tool (manual restore)

You are using the SAP MaxDB Database Manager (DBMGUI) version 7.5.0 Build 12 or above. For more
information, see:

http://maxdb.sap.com/doc/7_6/default.htm® | Tools » Database Manager GUI 3

Alternatively, you can use Database Studio. For more information, see:
http://maxdb.sap.com/doc/7_7/default.htm# | Tools » Database Studio 3

Database Software

The database software on the target host must have the same version as the software on the source host.
The build number of the software version on the target host must be greater than or equal to the version on
the source host.

Size of the data on the target system

The size of the target system must be greater than the used space on the source system. You can find the
size of the used pages on the source system as follows:

dbmcli —d <database_name> —u <dbm_user>,<password> —n <database_server> —u SQL
sap<sid>,<password> sql_execute 'SELECT USEDPERM FROM SERVERDBSTATISTICS'

The result of this query is the amount of used space, expressed as the number of 8 KB pages. To get the
used space in MB, divide this value by 128. When the installer prompts you, configure the database data
volumes according to this value.
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Context

The installer is used for installation on the target system host as described in the installation documentation for

your SAP solution at http://support.sap.com/sltoolset | » System Provisioning ¥ Installation Option 3. In
the installer, you select the backup and restore method as the database installation method.

This description is not valid for the liveCache system copy.

Caution

Make sure that you know the password of the database system administrator (SUPERDBA) from the source
system before you start the procedure below. Otherwise, you cannot access the database contents on the
target system.

You must also know the name of the SQL database schema on the source system, SAP<SAPSID> — for
example, SAPR3.

You can perform this procedure in the following ways:

e Manual restore
The installer stops before the database instance initialization and asks you to perform the restore on the
target database. After you have performed restore and post-restore activities, you can continue the
installation in the installer.

e Automatic restore
The installer performs the restore to import the data into the target system.
In this scenario, you have to use a single file as the backup medium for the whole backup. The restore can
use any SAP MaxDB backup, as long as it is a single file.

1 Note

The minimum size of the database is calculated from the size of the backup file.

Advantages

® You can use existing offline backups.
® This method is faster than the database-independent method using R3load or Jload [page 33].

Disadvantage

You can only copy between systems with the same byte order.

Perform the following steps on the target system:

Procedure

1. Toimport the target system, start the installer as follows and then follow the prompts:

|l <Product> # Software Life-Cyle Options j System Copy # Target System Installation » <System

Variant> }
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2. Inthe Select the database copy method screen, select Homogeneous System Copy.
3. Inthe MaxDB Backup Template screen, choose one of the following, Manual Restore, or Restore by Software
Provisioning Manager:
o Manual restore
In the execution phase, you are prompted to do the following:
1. Start the data recovery wizard from DBMGUI

1. Register your database instance in the DBMGUI
2. Check the database instance in the admin state.
3. Choose|r Recovery ¥ Recovery with Initialization ... 3
4. Intype of recovery, select Restore a medium.
5. Specify the backup medium.
6. Start the restore procedure.
1 Note

The recovery wizard does not start the recovery immediately. It initializes the database instance
first. It takes some time for the database server to format the database volumes.

2. After the restore, check the state of the target database instance. Change the database state to
online if it is not already in online state.

3. Delete the entries from the following tables to make sure that information about the backup
history for update statistics in the Computing Center Management System (CCMS) from the old
system does not appear in the new system:

CNHIST, CNREPRT, CNMEDIA, DBSTATHADA, DBSTATHADA, DBSTATIADA, DBSTATTADA,
SDBAADAUPD
4. Continue with the installer or restart it if you stopped it during the recovery.
© Restore by the Installer
Enter the following information:

o Template name

o Device/file

o Wait for backup

4. After installation is completed, maintain the database connection for CCMS.
For more information, see SAP Note588515# .
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5.3 MS SQL Server-Specific Procedure

This section describes how to perform a homogeneous system copy of an MS SQL Server database by using
the backup/restore method, or the detach/attach method in an SAP environment. The installer supports both
methods.

Context

The backup/restore method and the detach/attach method have the following advantages compared to the
R3load method:

® You can use an existing backup.
® These methods are much faster than the database-independent method [page 33].

1 Note

o For more information about the system copy procedure, see SAP Notes193816#% and 151603 .

o With SQL Server, you can use backup images across the platforms 1386, IA64, x64. That is, you can
make a backup on one type of platform and use it on another type.
o You can attach SQL Server 2000 files to SQL Server 2005 but not vice versa.

Procedure

1. Onthe source system, run the installer to create an export of the Java central instance [page 38] by
choosing the following option on the Welcome screen:

| <SAP Product> » Software Life-Cycle Options » System Copy » MS SQL Server » Source System Export
» <System Variant> ¥ Based on <Technical Stack> J

o For acentral system, choose Database and Central Instance Export.

1 Note

On the installer screen SAP SystemDatabase Export, make sure that you select Use database-
specific tools for the system copy method.

o For adistributed system, choose Central Instance Export.

When performing the export, create a MIGRATION EXPORT CD image, which contains the data of the
exported system, and which you use to install the target system.

2. Detach the database files from the source system database or create a backup and copy the files to the
target system.
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For more information about backing up your SQL Server database, see the SAP Library at:

http://help.sap.com/nw70#% |+ <Enhancement Package> ¥ Application Help ¥ Function-Oriented View:
English » Database Administration » Database Administration for Microsoft SQL Server » SAP/ MS SQL
Server DBA in CCMS 3

3. Attach the database files or restore the backup of the source database on the target database server.

4. Run the installer to install the target system by choosing the following on the Welcome screen:

| <SAP Product> j» Software Life-Cycle Options # System Copy # MS SQL Server » Target System
Installation » <System Variant> » Based on <Technical Stack> 3

1 Note

o The target system is installed using the exports from the source system.

o Choose the installation services in exactly the order they appear.
For more information, see the MS SQL Server installation guide for your SAP system at:

http:/support.sap.com/sltoolset# [ System Provisioning » Installation Option of Software

Provisioning Manager 1.0 3.
o Ontheinstaller screen SAP SystemDatabase, make sure that you select Homogeneous System Copy
(MS SOQL Server-specific: Detach/Attach or Backup).

5.4 IBM Db2 for Linux, UNIX, and Windows-Specific
Procedures

The database-specific procedure for the creation of a system copy is based on a restore of an existing online or
offline backup. Therefore, this method is also referred to as backup/restore procedure. Since a Db2 backup can
be used cross-platform within certain limitations (see below), this method is not limited to the homogenous

system copy only.

1 Note

This backup/restore procedure described here only works using the installer. System copy using native Db2
backup/restore procedures without the installer are not supported for SAP systems.

Prerequisites

® |t must be possible to restore the backup of the source system on the platform of the target system.
e |[ferrors occur when restoring the backup on the target system, the complete restore must be repeated.

System Copy for SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to
7.03 on Windows
74 PUBLIC Database-Specific System Copy


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw70
http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Fsltoolset

Context

An SAP system copy with a Db2 database can be also created if more advanced techniques like file system

snapshots are available. The necessary procedure in this case is called database relocation. The database

relocation procedure differs significantly from the backup/restore procedure and is not described in this guide.

For more information, see the Database Administration Guide: SAP on IBM Db2 for Linux, UNIX, and Windows,

section db2inidb Option: as snapshot.

The installer is used for installation on the target system host as described in the installation documentation for
your SAP component. Before starting the installer on the target system make sure that all prerequisites for the

SAP system installation are met. Especially, make sure that the relevant file systems are available. For more

information, see the appropriate installation guide at http:/support.sap.com/sltoolset|p » System

Provisioning ¥ Installation Option of Software Provisioning Manager 3

You also have to run an export for the Java Engine to archive SDM and application-specific file system content.

Advantages of the Backup Method

® You can use existing online and offline backups.
e Using the backup method is faster than the database-independent method [page 33].

Disadvantages of the Backup Method

® You cannot change the name of the database schema. The name of the database schema of the target
system is the same as that of the source system. However, you can change the name of the connect user

during the Define Parameters phase of the target system installation.
® You cannot copy an individual MCOD component to another system. You can only copy the complete
system.

Procedure

1. You perform an online or offline backup.

1 Note

If you use an online backup to copy your system, a roll forward of your database is required after the
database restore on the target system. As a prerequisite, the respective database logs must be

accessible. We therefore recommend that you include the necessary log files in the backup image. To do
so, use the INCLUDE LOGS option of the BACKUP DATABASE command. Logs are by default included in

an online backup.

1 Note

To export the database content for Java, you can also use the database-specific method (backup/
restore).

During the Define Parameters phase, the installer asks you in the Database Export dialog box to specify
the system copy method. If you want to use the backup/restore method, choose Use database-specific

tools.
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2. To create the export directory structure with labels and to archive SDM and application-specific file system
content, you also have to run the installer.

On the Welcome screen, choose | <Product> j» Software Life-Cycle Options ¥ System Copy ¥ IBM Db2
for Linux, UNIX, and Windows » Source System Export » <System Variant> ¥ Based on

<Technical Stack> !

Perform the installation options in the given sequence and follow the instructions on the installer dialogs.
3. Tocreate a target system, run the installer on the target system host by choosing the following on the
Welcome screen: [ <Product> » Software Life-Cycle Options ¥ System Copy » IBM Db2 for Linux, UNIX,

and Windows » Target System Installation » <System Variant> » Based on <Technical Stack> 4

Perform the installation options in the given sequence and follow the instructions on the installer dialogs.
The installer prompts you to perform the database restore during the installation phase.

Caution

Be aware of the following constraints when using the backup method for a homogeneous system copy:

© You cannot change the name of the database schema, during the dialog phase make sure that you
enter the database schema exactly as on your source system.

o The tablespace names remain the same during the database restore. However, you can change
them after the installation.

o |f you want to change the name or the location of the Db2 container on the target system, you have
to adapt the Db2 container paths or names in the redirected restore script and then perform a
redirected restore. For more information, see the documentation Database Administration Guide:
SAP on IBM Db2 for Linux, UNIX, and Windows, section Usage of Tool brdb6brt.

4. Multi-Partition Database Environments only: Add database partitions

If you copy a system with multiple database partitions, the target system must have the same number of
partitions as the source system.

5. Restore your database.

To restore your database, you can choose between one of the following options:

o Simple database restore
To perform a database restore, use the Db2 RESTORE command. For more information, see the IBM
Db2 documentation Db2 Command Reference.

1 Note

With a simple restore, you cannot change the name or the location of Db2 containers.

o Redirected restore
This is the recommended method.
A redirected restore allows you to change the name or the location of the Db2 container. To perform a
redirected restore, you use the Db2 RESTORE DATABASE command with the REDIRECT GENERATE
SCRIPT option.
Alternatively, you can use the tool brdbébrt that retrieves a database backup and creates a CLP
script to restore this backup image. Since brdbébrt needs to connect to the source system, the
source system must be available. For more information about how to use the tool brdb6brt, see
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Redirected Restore Using brdb6brt in the Database Administration Guide: SAP on IBM Db2 for Linux,
UNIX, and Windows.

You cannot use the brdbébrt tool to perform a redirected restore.

1 Note

You do not have to export the database content for backup/restore with Jload. During the dialog
phase, the installer asks if you want to export the database content using database tools or using
Jload. If you choose the database tools, Jload is not used.

For more information, see SAP Note 1238351 % .

If you have used an online backup, you have to make sure that you have access to the log files that were
created during the online backup. You also have to perform a roll forward operation to bring the database
into a consistent state.

You can now continue with the installation.

Next Steps

After the installation on the target system, do the following:

e |f you performed a redirected restore, check all settings of the database manager and database
configuration parameters. Specifically, make sure that the following configuration parameters point to the
correct path:

© DIAGPATH (DBM)

© JDK_PATH (DBM)

o DFTDBPATH (DBM)

o Path to log files (DB)

o If set, NEWLOGPATH (DB), OVERFLOWLOGPATH (DB), FAILARCHPATH (DB) and MIRRORLOGPATH (DB)

More Information

® Database Administration Guide: SAP on IBM Db2 for Linux, UNIX, and Windows and Database
Administration Using the DBA Cockpit: IBM Db2 for Linux, UNIX, and Windows. To access this guide, use the
SAP NetWeaver Guide Finder: In the | want to column select Operate my system, in the My Database
column, select IBM Db2 for Linux, UNIX, and Windows.

e |BM Knowledge Center at https:/www.ibm.com/support/knowledgecenter/SSEPGG #*

e |BM Db2 manuals at http:/www-01.ibm.com/support/docview.wss?uid=swg27023558 #*
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5.5 IBM Db2 for z/0S Specific Procedures

In an SAP system environment, you can create a homogeneous system copy of a DB2 database using the
offline system copy method.

Prerequisites

The following prerequisites must be fulfilled to use this method:

® The permissions of the source and target systems must be completely separate. The source system must
not be able to use the resources of the target system, and the target system must not be able to use the
resources of the source system.

e RACF authorization for the target DB2 subsystem is complete.

e Source and target systems must work with DB2 managed objects.

® Procedures of the source and the target system are defined in the DB2 PROCLIB.

e Source and target systems have appropriate entries in the APF list.

e \olumes of the source and target systems are managed by SMS.

e At first source and target systems run with the same DB2 service level. After copying the source system to
a target system, you can migrate or upgrade both systems to a higher service level.

Context

This document assumes that the database schema of your SAP system is SAPR3. If you employ a different
schema, adapt the references to SAPR3 in the following SQL statements and jobs to reflect the actual schema
name.

The following section describes an offline system copy method for SAP systems on IBM Db2 for z/0S.

Advantage of the Offline System Copy Method

This method is faster than the database-independent method [page 33].

Restriction of the Offline System Copy Method
At the moment, you cannot copy an individual MCOD component to another system. You can only copy the
complete system.
1 Note
The offline system copy must be performed by an experienced database administrator.

You can find an adapted procedure for an online system copy in the IBM documentation High Availability for
SAP on zSeries Using Autonomic Computing Technologies.
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Process Flow of the Main Steps in this Procedure

The following sections contain the detailed steps involved in the homogeneous system copy procedure for Db2
for z/0S.

The offline system copy can be divided into the following steps:

Procedure

Step 1: Check the Source System and Stop it after Successful Check [page 79]
Step 2: Consider DB2 Procedures of the Target System [page 81]
Step 3: Delete All Obsolete Objects of the Target System [page 81]
Step 4: Copy All Objects of the Source System into the Target System [page 81]
Step 5: Add All DB2 Subsystem Libraries to a PARMLIB Containing Definitions Required for APF [page 81]
Step 6: Alter the BSDS of the Target System [page 82]
Step 7: Change Entries of logcopy Data Sets in the BSDS of the Target System [page 82]
Step 8: Customize DB2 Modules Using DSNTIJUZ [page 82]
Step 9: Configure the Distributed Data Facility (DDF) [page 83]
. Step 10: Start the Target System Using ACCESS(MAINT) [page 83]
. Step 11: Update the DB2 Catalog Using CATMAINT UPDATE VCAT SWITCH [page 83]
. Step 12: Stop and Restart the Target System [page 83]
. Step 13: Create DSNTEP2 and DSNTEP4 Load Modules for the Target System [page 84]
. Step 14: Alter All WLM Environments of Stored Procedures [page 84]
. Step 15: Perform Post-Offline System Copy Actions (Optional) [page 84]
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5.5.1 Step 1: Check the Source System and Stop it after
Successful Check

Procedure

1. Check the source system for active threads using the following DB2 command: DIS THD (*)
If there are active threads, stop all applications running against the source system.
2. Check the source system for authorized utilities using the following DB2 command: DIS UTIL(*)

The command shows the status of all utility jobs known to DB2. You should get the following message: NO
AUTHORIZED UTILITY FOUND FOR UTILID = *

If there are utilities, wait for their successful completion or terminate them.

3. Ensure that all DB2 objects of the source system are started in RW mode.
You can check this using the following DB2 command: DISPLAY DATABASE (*) SPACENAM(*) RES

The command displays all databases, table spaces, or indexes in a restricted status.
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You should get the following message: NO DATABASES FOUND

In all other cases do not proceed. We recommend that you repair all databases, table spaces, or indexes
identified as restricted. For more information, see the command reference of Db2 for z/0OS.

4. The source system must be stopped and restarted now in ACCESS (MAINT).
ACCESS (MAINT) prohibits access to any authorization IDs other than SYSADM, SYSOPR and SECADM.

5. Laterin this workflow all wLM ENVIRONMENTS of DB2 procedures must be altered in the target system.
Identify all created procedures and WwLM ENVIRONMENTS with the following SQL statement:

SELECT 'ALTER PROCEDURE ' CONCAT
SCHEMA CONCAT '."' CONCAT NAME CONCAT '"'
CONCAT ' WLM ENVIRONMENT '
CONCAT STRIP(WLM ENVIRONMENT) CONCAT ';'
FROM SYSIBM.SYSROUTINES
WHERE ROUTINETYPE='P';

SELECT 'ALTER SPECIFIC FUNCTION ' CONCAT
SCHEMA CONCAT '."' CONCAT SPECIFICNAME CONCAT '" '
CONCAT ' WLM ENVIRONMENT '
CONCAT STRIP(WLM ENVIRONMENT) CONCAT ';'
FROM SYSIBM.SYSROUTINES
WHERE ROUTINETYPE='F'
AND FENCED = 'Y';

The result of this query should look like the following:

1 Note

This is only an excerpt from the result.

ALTER PROCEDURE DSNADM."ADMIN TASK LIST" WLM ENVIRONMENT D990 GENERAL;
ALTER PROCEDURE DSNADM."ADMIN TASK OUTPUT" WLM ENVIRONMENT D990 GENERAL;
ALTER PROCEDURE DSNADM."ADMIN TASK STATUS" WLM ENVIRONMENT D990 GENERAL;
ALTER PROCEDURE DSNADM."ADMIN TASK STATUS" WLM ENVIRONMENT D990 GENERAL;
ALTER PROCEDURE SYSPROC."DSNACICS" WLM ENVIRONMENT D128 GENERAL;

Keep the results of this query in a safe place.
Stop the source system again.

After the source system has completely terminated, print the contents of all source system boot strap
datasets using utility DSNJU004.

Carefully save the output. The values of START RBA and END RBA of all logcopy datasets are needed later
in this workflow.

Caution

Do not start the source system until all objects (boot strap datasets, LOGCOPY, VSAM clusters and
so on) are copied into the target system. Otherwise the target system might be highly inconsistent.
Therefore it is strongly recommended to prevent the source system from being started until step 4
[page 81] of this process flow has been completed successfully.
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5.5.2 Step 2: Consider DB2 Procedures of the Target System

Consider the following cases:

Homogeneous system copy of the source system is provided in an existing target system. In this case you
can skip step 2.

Homogeneous system copy of the source system is provided in a nonexistent target system. In this case
customize and run a private copy of DSNTIJMV to update the DB2 PROCLIB.

5.5.3 Step 3: Delete All Obsolete Objects of the Target

System

Consider the following cases:

Homogeneous system copy of the source system is provided in a target system that already exists.

In this case delete all obsolete bootstrap datasets, logcopy datasets, archives, VSAM clusters. Ensure that
all obsolete objects of the target system are deleted.

Homogeneous system copy of the source system is provided in a non-existing target system.

In this case you can skip step 3. All necessary datasets are copied from the source system in step 4 [page
81] of this process flow.

5.5.4 Step 4: Copy All Objects of the Source System into the

Target System

Ensure that the source system is still stopped.
Otherwise boot strap datasets, logcopy datasets, VSAM clusters are allocated by the source
system and cannot be copied.

. Customize and run a job using, for example, program ADRDSSU.

Use ADRSSU parameter RENUNC to rename all objects to reflect the high-level qualifiers of the target
system.
Now you can restart the source system without any risk of inconsistency in the target system.

5.5.5 Step 5: Add All DB2 Subsystem Libraries to a PARMLIB

Containing Definitions Required for APF

Consider the following cases:

The target system was already up and running in the past, so that all definitions required for authorized
program facility (APF) already exist.

In this case you can skip step 5.

The target system was never up and running.
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In this case add all definitions required for APF to an appropriate PARMLIB and set APF. Otherwise the
target system cannot be started.

5.5.6 Step 6: Alter the BSDS of the Target System

Change vsaMCAT in the bootstrap data sets (BSDS) of the target system. Use the DsNJu003 utility in DB2 with
parameter NEWCAT VSAMCAT to reflect the new vSAMCAT high-level qualifier.

Repeat this step for each data sharing member BSDS of data sharing systems, .

5.5.7 Step 7: Change Entries of logcopy Data Sets in the
BSDS of the Target System

Use DB2 utility DsNgu003 to delete obsolete and invalid DSNAME entries using the DELETE DSNAME parameter.
In the same job you can define the name of the new 1ogcopy data sets with the NEWLOG DSNAME parameter.
Carefully customize the STARTRBA and ENDRBA parameters using the values of the source system.

Repeat this step for each data sharing member BSDS of data sharing systems.

5.5.8 Step 8: Customize DB2 Modules Using DSNTIJUZ

For the target system you have to customize the DB2 data-only load module DSNHMCID, the application
defaults load module (DSNHDECP), and the subsystem parameter module using DSNTIJUZ.

At least change the following parameters:

® The name of the libraries identified in STEPLIB, SYSLIB

® SYSLMOD DD statements

® The ADMTPROC parameter, if the administrative task scheduler is used
® The CATALOG parameter

® The FCCOPYDDN parameter

® The IRLMPRC parameter

® The IRLMSID parameter

® The ARCPFX1 and ARCPFX2 parameters, if the target system is to run with archiving.
If the target system is to run without archiving, identified by parameter OFFLOAD=NO, the ARCPFX2 /
ARCPFX2 parameters must not be changed. However, for security reasons it is recommended to run the
target system with archiving.

Other parameters of the target system can be modified as requested by the owner of the subsystem.
Repeat this step for each data sharing member BSDS of data sharing systems.
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5.5.9 Step 9: Configure the Distributed Data Facility (DDF)

Use the DSNJU003 stand-alone utility to change the bootstrap data sets (BSDS). Adjust LOCATION,
LUNAME, PORT, and RESPORT considering the new Distributed Data Facility (DDF) environment.

Repeat this step for each data sharing member BSDS of data sharing systems.

5.5.10 Step 10: Start the Target System Using
ACCESS(MAINT)

You must be able to start the target system with ACCESS (MAINT), otherwise the CATMAINT utility fails in the
next step [page 83] of this process flow.

If the target system does not start successfully, do not proceed with Step 11: Update the DB2 Catalog Using
CATMAINT UPDATE VCAT SWITCH [page 83].

For data sharing systems, start the first member and continue with Step 11: Update the DB2 Catalog Using
CATMAINT UPDATE VCAT SWITCH [page 83].

5.5.11 Step 11: Update the DB2 Catalog Using CATMAINT
UPDATE VCAT SWITCH

Use the CATMAINT utility with option VCAT SwWITCH to provide the new high-level qualifier of the target system

in the DB2 catalog.

For data sharing systems, run this step with the first started member.

5.5.12 Step 12: Stop and Restart the Target System

Stop and restart the target system.

When the target system is restarted, you have to check the sYS1.0G carefully for normal completion.

Caution

Do not proceed with the next step [page 84] if problems occur while the target system is being stopped or
restarted.
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5.5.13 Step 13: Create DSNTEP2 and DSNTEP4 Load Modules
for the Target System

Create, test, and run the DSNTEP2 and DSNTEP4 load modules. To be able to do this, you have to customize and
run DSNTEJ1L.

5.5.14 Step 14: Alter All WLM Environments of Stored
Procedures

Use

In step 1 [page 79] of this process flow, you ran a query to prepare all ALTER PROCEDURE statements for the
target system.

Now you have to customize the result of the query by changing the WLM ENVIRONMENT value for the WM
ENVIRONMENT names of the target system.

Procedure

1. Ensurethatthe APPLICATION ENVIRONMENT NAMES and the appropriate PROCEDURE NAMES exist in the
DB2 PROCLIB and thatthe APPLICATION ENVIRONMENTS are activated.

2. Runall ALTER PROCEDURE commands in the target system using the DSNTEP2 program.

5.5.15 Step 15: Perform Post-Offline System Copy Actions
(Optional)

1. Asall GRANTSs of the source system are still valid, check them using SPUFI by executing the following
command: SELECT * FROM SYSIBM.SYSUERAUTH;
Maintain this table according to your needs.

2. Grant new users or revoke obsolete users.

3. Ifrequired, change the user authorizations of the target system.
The IBM Db2 catalog still contains the authorizations of the source system.
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5.6

SAP ASE Server-Specific Procedure

This section describes how to perform a homogeneous system copy of a SAP ASE database by using the 1oad
database dump method, orthe attach database device methodinan SAP environment. The installer
supports both methods.

Context

The 1oad database dump methodandthe attach database device method have the following
advantages compared to the R3load method:

® You can use an existing backup.

® You can copy the complete database software and database devices (all files below <Drive>:\sybase
\<DBSID>) to the target system and use this copy to create the target system.

e These methods are faster than the database-independent method [page 33].

For more information about system copy with SAP ASE as target database, see SAP Note 1697542 ¥ .

Procedure

1. Provide the database files required for the target system setup using one of the following ways:

o

o

Suspend write operations to the database devices of the source system database together with the
creation of a database manifest file (using SAP ASE command quiesce database <DBSID>_ tag
hold <DBSID> for external dump to <manifest file>), copy all necessary files to the target
system, and enable the write operation again (using SAP ASE command quiesce database
<DBSID>_ tag release).

Create a backup (SAP ASE command dump database).

2. Copy the files to the target system.

3. Runthe installer to install the target system by choosing the following on the Welcome screen:

b <Product> » Software Life-Cycle Options » System Copy » <Database> » Target System Installation

» <System Variant> » Basedon <Technical Stack> 4

Note

Choose the installation services in exactly the order they appear. For more information, see the SAP
ASE installation guide for your SAP NetWeaver-based system at: http://support.sap.com/sltoolset
& | » System Provisioning ¥ Installation Option .

On the installer screen SAP SystemDatabase, make sure that you select Homogeneous System Copy
(SAP ASE-specific: Attach database device or Load database dump).

The installer asks you if you want to use either an already existing SAP ASE installation on the target
system or the database software from the installation media.
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o Depending on the method chosen, you have to enter either the path to the database dump files or
the location of the database manifest file. The installer tries to find the database devices mentioned
in the manifest file automatically, otherwise it asks for the files during the installer execution phase.
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6 Follow-Up Activities

To finish the system copy of your SAP system, perform the follow-up activities described in the following
sections.

1 Note

The Java engine is not started automatically. After the target system has been installed and the follow-up
activities have been performed, you have to start the Java engine manually.

Related Information

Performing Follow-Up Activities in the Target System [page 88]
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7 Performing Follow-Up Activities in the
Target System

You have to perform the following follow-up activities in the target system.

1 Note

Before you start the Java engine after the system copy, apply SAP Note 831812#% and if necessary, change
the Java VM parameters as described in SAP Note 723909#%

Related Information

Installing the License Key [page 88]

SAP Solution Manager: Connection Between SLD and LMDB [page 89]

Performing Follow-Up Activities for Java [page 90]

Checking the Database Parameters for IBM Db2 for Linux, UNIX, and Windows [page 120]

71 Installing the License Key

Once the installation of the target system is completed and the SAP system copy has been imported, you have
to install a new SAP license key.

You must install a permanent SAP license. When you install your SAP system, a temporary license is
automatically installed.
Caution

e Before the temporary license expires, you must apply for a permanent license key from SAP. We
recommend that you apply for a permanent license key as soon as possible after installing your system.

e Before installing the license key, make sure that SAP Note 831812#% is applied.

For more information about ordering and installing the SAP license, see the SAP Library for your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http://help.sap.com/nw70" |+ Application Help ¥ SAP
NetWeaver by Key Capability # Solution Life Cycle
Management > SAP Licenses 1
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SAP NetWeaver Release Location

SAP NetWeaver 70 including EHP1 http:/help.sap.com/nw701#% |+ Application Help ¥ SAP
NetWeaver by Key Capability # Solution Life Cycle
Management > SAP Licenses 1

SAP NetWeaver 70 including EHP2 http://help.sap.com/nw702 | Application Help  SAP
NetWeaver by Key Capability > Solution Life Cycle
Management > SAP Licenses 1

SAP NetWeaver 7.0 including EHP3 http://help.sap.com/nw703#% | Application Help  SAP
NetWeaver by Key Capability # Solution Life Cycle
Management > SAP Licenses }

More Information

For more information about SAP license keys, see https:/support.sap.com/en/my-support/keys.htm| .

7.2 SAP Solution Manager: Connection Between SLD and
LMDB

e Consider the following if you move parts of a system, for example the database, or the complete system to
new hardware:

o Each change in the host name generates new elements in the system landscape directory (SLD) which
can result in system duplicates.

o SAP recommends using stable (virtual) host names which remain constant over time, in the system
profiles. SAP Note 1052122 lists the profile parameters evaluated by the SLD Data Suppliers for the
host names.

e |f you omitted to use virtual host names at installation time or if you cannot use virtual host names now, the
SLD offers a possibility to prevent the creation of system duplicates. For more information, see SAP Note
1727294 ¥ .

e |f you cannot apply SAP Note 1727294#% to the SLD, and if you already found a duplicate registration for
the system in the SLD, refer to SAP Note 1694004 for guidance how to clean up such inconsistencies. SAP
Note 1747926#% describes the cleanup procedure for older SLD releases.

e |f you want to copy an SAP Solution Manager system with a filled Landscape Management Database
(LMDB), see SAP Note 1797014 #r .

e |fyou want to create a new synchronization connection between the Landscape Management Database
(LMDB) and the System Landscape Directory (SLD), see SAP Note 1699142 ¥

e |f you want to delete a synchronization connection between two SLD systems or between an SLD system
and LMDB, see SAP Note 1770691 ¥ .

System Copy for SAP Systems Based on the Application Server Java of SAP NetWeaver 7.0 to
7.03 on Windows
Performing Follow-Up Activities in the Target System PUBLIC 89


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw701
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw702
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw703
http://help.sap.com/disclaimer?site=https%3A%2F%2Fsupport.sap.com%2Fen%2Fmy-support%2Fkeys.html
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1052122
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1727294
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1727294
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1747926
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1797014
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1699142
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1770691

7.3 Performing Follow-Up Activities for Java

Depending on the usage types or software units contained in your target system, you have to perform general
and usage type or software unit-specific configuration steps.

Related Information

Usage Type or Software Unit-Specific Follow-Up Activities [page 94]
Activities at Database Level [page 90]

7.3.1 Activities at Database Level

This section includes the adaptations that you have to make at database level in your target system.

Procedure

Oracle Database only If you have chosen to enable Oracle Database Vault, make sure that you perform the
required configuration steps. For more information, see Implementing Oracle Database Vault with the Installer
[page 135].

7.4 General Follow-Up Activities

This section contains general follow-up activities for SAP systems based on AS Java.

1 Note

You can use Java post-copy automation (PCA) to perform general follow-up activities automatically. Java
post-copy automation (PCA) provides task lists with a predefined sequence of configuration tasks to
configure extensive technical scenarios automatically. For more information, see SAP Note 1807150 #&r .

To be able to use PCA, you must install the license for SAP Landscape Virtualization Management Enterprise
Edition. For more information, see SAP Note 19121107 .
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Related Information

Configuration Steps for the SAP Java Connector [page 91]
Generating Public-Key Certificates [page 92]

7.4.1 Configuration Steps for the SAP Java Connector

You need to perform these post-installation steps for a copied Java system that includes a component that has
to connect to an ABAP back end using the SAP Java Connector (SAP JCo), for example SAP NetWeaver
Business Warehouse or SAP NetWeaver Portal.

Procedure

1. Logon to the Visual Administrator as an administrator.

2. Onthe launch path on the left, choose |+ Cluster ¥ Server <server name> ¥ Services ¥ JCo RFC Provider 3.

3. Ontheright, choose Runtime and select the RFC destination that you use for the connection to the back
end.

4. Maintain the required parameters for the RFC destination and repository.
5. Remove the old JCo-destination that was copied from the source system.

6. Restart the Java server and the component.
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7.4.2 Generating Public-Key Certificates

Reconfiguring the Public-Key Certificates

After system copy, the public key certificates are wrong on the target system. You need to reconfigure them as
described in the SAP Library for your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http:/help.sap.com/nw70%% | Application Help  SAP
NetWeaver by Key Capability # Security # User
Authentication and Single Sign-On > Authentication on the
AS Java > Configuring Authentication Mechanisms > Using
Logon Tickets for Single Sign-On > Configuring the Use of
Logon Tickets > Replacing the Key Pair to Use for Logon
Tickets 4

SAP NetWeaver 7.0 including EHP1 http://help.sap.com/nw701#% | Application Help # SAP
NetWeaver by Key Capability > Security > User
Authentication and Single Sign-On > Authentication on the
AS Java ¥ Configuring Authentication Mechanisms ¥ Using
Logon Tickets for Single Sign-On > Configuring the Use of
Logon Tickets p Replacing the Key Pair to Use for Logon
Tickets }

SAP NetWeaver 70 including EHP2 http://help.sap.com/nw702#% | Application Help % SAP
NetWeaver by Key Capability > Security > User
Authentication and Single Sign-On  Authentication on the
AS Java > Configuring Authentication Mechanisms } Using
Logon Tickets for Single Sign-On # Configuring the Use of
Logon Tickets > Replacing the Key Pair to Use for Logon
Tickets ]

SAP NetWeaver 7.0 including EHP3 http://help.sap.com/nw703% | Application Help ¥ SAP
NetWeaver by Key Capability # Security # User
Authentication and Single Sign-On > Authentication on the
AS Java ¥ Configuring Authentication Mechanisms > Using
Logon Tickets for Single Sign-On > Configuring the Use of
Logon Tickets > Replacing the Key Pair to Use for Logon
Tickets 4
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Importing the Public-Key Certificates

You also need to import this public-key certificate on any systems that are to accept logon tickets from the AS
Java system. For more information, see the SAP Library for your release at:

SAP NetWeaver Release

SAP NetWeaver 7.0

Location

http://help.sap.com/nw70%% | Application Help 2 SAP
NetWeaver by Key Capability > Security > User
Authentication and Single Sign-On #» Authentication on the
AS Java > Configuring Authentication Mechanisms } Using
Logon Tickets for Single Sign-On # Configuring the Use of
Logon Tickets @ Configuring SAP Web AS ABAP to Accept
Logon Tickets from the J2EE ]

SAP NetWeaver 7.0 including EHP1

http://help.sap.com/nw701 % |} Application Help > SAP
NetWeaver by Key Capability # Security # User
Authentication and Single Sign-On > Authentication on the
AS Java ¥ Configuring Authentication Mechanisms > Using
Logon Tickets for Single Sign-On > Configuring the Use of
Logon Tickets > Configuring SAP Web AS ABAP to Accept
Logon Tickets from the J2EE 4

SAP NetWeaver 7.0 including EHP2

http://help.sap.com/nw702 #r | 3 Application Help » SAP
NetWeaver by Key Capability > Security > User
Authentication and Single Sign-On > Authentication on the
AS Java ¥ Configuring Authentication Mechanisms ¥ Using
Logon Tickets for Single Sign-On > Configuring the Use of
Logon Tickets # Configuring SAP Web AS ABAP to Accept
Logon Tickets from the J2EE 4

SAP NetWeaver 7.0 including EHP3

http:/help.sap.com/nw703%% |+ Application Help  SAP
NetWeaver by Key Capability > Security > User
Authentication and Single Sign-On  Authentication on the
AS Java > Configuring Authentication Mechanisms > Using
Logon Tickets for Single Sign-On # Configuring the Use of
Logon Tickets @ Configuring SAP Web AS ABAP to Accept
Logon Tickets from the J2EE 4
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7.5 Usage Type or Software Unit-Specific Follow-Up
Activities

This section includes the steps that you have to perform for specific usage types or software units.

Related Information

EP Core (EPC) [page 94]

Enterprise Portal (EP) [page 97]

Business Intelligence Java Components (Bl Java) [page 113]

Development Infrastructure (DI) [page 115]

Self Services (XSS) [page 117]

CRM Java Components (JCRM) / Extended E-Selling Components (XECO) [page 118]
SRM Live Auction Cockpit (SRMLAC) [page 119]

SCM Forecasting & Replenishment Processor (SCM FRP) [page 119]

7.5.1 EP Core (EPC)

Related Information

EPC: Portal [page 94]
Configuring the Portal Content [page 95]

75.1.1 EPC: Portal

After system copy, you have to perform some follow-up activities for Enterprise Portal Core.

If trust between a portal and any other system is required, then you need to replace certificates and reestablish
trust with the new system on which the portal is installed. For more information, see Generating Public-Key
Certificates [page 92].

If you have more than one portal in your landscape and the portals share content via a federated portal network
(FPN), see SAP Note 1080080 for more information about follow-up activities.
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75.1.2 Configuring the Portal Content

Use

After the system copy, the SaP<SAPSID> has changed, but the Logical System ID of the portal system object in
the system landscape still points to the old sap<sapsSID>. You have to modify it to point to the correct
SAP<SAPSID> by updating the Logical System name.

For more information about the Logical System names, see the SAP Library for your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http:/help.sap.com/nw70%% |l Application Help ¥

Function-Oriented View <Language> > Information
Integration: Key Areas ¥ Business Intelligence # Data
Warehousing } Data Acquisition > Source System >
Connection between Source Systems and BW # Logical

System Names }

SAP NetWeaver 70 including EHP1 http://help.sap.com/nw701#|p Application Help

Function-Oriented View <Language> > Information
Integration by Key Capability » Business Intelligence » Data
Warehousing > Data Acquisition > Source System >
Connection between Source Systems and BW ¥ Logical

System Names }

SAP NetWeaver 70 including EHP2 http://help.sap.com/nw702# | Application Help
Function-Oriented View <Language> # Information
Integration by Key Capability » Business Intelligence » Data
Warehousing > Data Staging > Source System >
Connection between Source Systems and BW p Logical

System Names }

SAP NetWeaver 70 including EHP3 http://help.sap.com/nw702 % |+ Application Help
Function-Oriented View <Language> # Information
Integration by Key Capability » Business Intelligence » Data
Warehousing > Modeling > Data Acquisition > Source
System } Connection between Source Systems and BW >

Logical System Names ]

Since the system alias has to be the same as the Logical System name, you have to update it, too.
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For more information about the system aliases, see the SAP Library for your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http:/help.sap.com/nw70#% |l Application Help ¥
Function-Oriented View <Language> > People Integration by
Key Capability  Portal Administration Guide ¥ System
Administration > System Configuration > System
Landscape > System Aliases 1

SAP NetWeaver 7.0 including EHP1 http://help.sap.com/nw701#% | Application Help ¥
Function-Oriented View <Language> > People Integration by
Key Capability > Portal Administration Guide > System
Administration # System Configuration & System
Landscape > System Aliases }

SAP NetWeaver 70 including EHP2 http:/help.sap.com/nw702 % |+ Application Help 3
Function-Oriented View <Language> > People Integration by
Key Capability  Portal Administration Guide ¥ System
Administration > System Configuration > System
Landscape > System Aliases 1

SAP NetWeaver 7.0 including EHP3 http://help.sap.com/nw703%% |+ Application Help
Function-Oriented View <Language> > People Integration by
Key Capability > Portal Administration Guide > System
Administration » System Configuration & System
Landscape > System Aliases }

Procedure

Proceed in one of the following ways:

e Update the information in the existing system.
All parameters that contain information about the old system have to be updated to point to the new
system. That is, if the host name or the port has been changed, the system object has to be updated
accordingly.
1. Update the Logical System name to point to the new system SAP<SAPSID>.
Update the system alias to be the same as the new Logical System name.

w N

Set the new system alias to be default.

>

Update all relevant properties of the host and the ports values of the old systems.

o

Change the ID/name of the old system.
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After the value of the alias has been updated, the old content will not work, because it still points to the old
alias. Moreover, all new role uploads from the new system will be created under a new folder and will not
overwrite the existing one.
Therefore, you also have to change the ID values of the folders of the migrated content and the system
value of the uploaded content.

e C(Create a new system that points to the new environment. For more information, see the SAP Library for
your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http://help.sap.com/nw70% | Application Help
Function-Oriented View <Language>  People Integration
by Key Capability » Portal Administration Guide # System
Administration ¥ Upload of Roles from ABAP-Based
Systems 3

SAP NetWeaver 7.0 including EHP1 http://help.sap.com/nw701$|} Application Help >
Function-Oriented View <Language> p People Integration
by Key Capability > Portal Administration Guide > System
Administration ¥ Upload of Roles from ABAP-Based
Systems ]

SAP NetWeaver 7.0 including EHP2 http://help.sap.com/nw702 Fr | Application Help »
Function-Oriented View <Language> # People Integration
by Key Capability » Portal Administration Guide # System
Administration > Upload of Roles from ABAP-Based
Systems 4

SAP NetWeaver 7.0 including EHP3 http://heIp.sap.com/nw703l‘hr|} Application Help >
Function-Oriented View <Language> > People Integration
by Key Capability > Portal Administration Guide > System
Administration > Upload of Roles from ABAP-Based
Systems ]

Make sure that you update the ID values of the folders of the migrated content and the system value of the
uploaded content.

7.5.2 Enterprise Portal (EP)
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Related Information

EP: Knowledge Management and Collaboration [page 98]

7.5.2.1 EP: Knowledge Management and Collaboration

Use

After the system copy, the Knowledge Management and Collaboration (KMC) target system still has access to
the same data as the original source system. If the source and target system have write access to the same
data, this results in serious inconsistencies in both systems. For this reason, it is essential to prevent both
systems from using the same data.

Critical items that are accessed by both systems are, for example:

® [ndexes for search and classification (TREX)
e Datain external repositories, for example, on file system shares
e Dataon groupware servers

1 Note

SAP NetWeaver 7.0 SR3/EHP1 SR1, Java only: If content exchange is configured on the source system, the
same configuration exists on the target system after the system copy. However, in most cases, it does not
makes sense to have the same configuration on both the source and target system. For this reason, you
need to remove the configuration on the target system with the help of acleanup script and then setup a
new configuration. The cleanup script is available as an attachment to SAP Note 833859 # .

Procedure

To prevent source and target system from working with the same data, reconfigure the following components
on the target system:

e TREX

® Repository Managers
® Services

e Collaboration

The tables below summarize the configuration steps for each of the components and specify where you can
find more information.

TREX

After the system copy, the target system is still connected to the same TREX installation as the source system.
For this reason you need to install a new instance of TREX and connect it to the target system.
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Caution

While KMC is still connected to the old TREX installation, do not delete any indexes, otherwise they will also
be deleted on the source system.

Detailed Information

For the target system, install a new instance of TREX. https://help.sap.com/trex
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Task

On the target system, set up the connection to the newly in-
stalled TREX system.

TREX <version> for SAP NetWeaver 7.0

Detailed Information

For more information, see the SAP Library for your release
at:

e SAP NetWeaver 7.0:
o TREX70

http://help.sap.com/nw70l‘h-|} Application Help >
Function-Oriented View <Language> » Information
Integration: Key Areas # Search and Classification
TREX # TREX 7.0 for SAP NetWeaver 70 # TREX
Configuration > Post-Installation Configuration >
Client Side > Java Application (HTTP Connection)
> Specifying the Address of the TREX Name

Server J
o TREX71

http://help.sap.com/nw70i'hr|} Application Help >
Function-Oriented View <Language> > Information
Integration: Key Areas # Search and Classification
TREX # TREX 7.1 for SAP NetWeaver 7.0 » TREX
Configuration > TREX Basic Configuration >
Connecting TREX with an Application  Connecting
TREX with a Java Application (HTTP Connection) >

Specifying the Address of the TREX Name Server }
e SAP NetWeaver including EHP1:
o TREX70

http://help.sap.com/nw701$l} Application Help
» Function-Oriented View <lLanguage> >
Information Integration by Key Capability > Search
» Search and Classification TREX » TREX 7.0 for
SAP NetWeaver 70 ¥ TREX Configuration ¥ Post-
Installation Configuration > Client Side > Java
Application (HTTP Connection) # Specifying the

Address of the TREX Name Server 4
o TREX71

http://help.sap.com/nw701!‘hr|} Application Help
» Function-Oriented View <lLanguage> p
Information Integration by Key Capability > Search
% Search and Classification TREX # TREX 71 for
SAP NetWeaver 7.0 # TREX Configuration  TREX
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Task

o

o

o

® SAP NetWeaver including EHP2:

® SAP NetWeaver including EHP3:

Detailed Information

Basic Configuration # Connecting TREX with an
Application > Connecting TREX with a Java
Application (HTTP Connection) > Specifying the
Address of the TREX Name Server }

TREX 7.0

http://help.sap.com/nw702i‘hr|} Application Help
» Function-Oriented View <lLanguage> >
Information Integration by Key Capability > Search
» Search and Classification TREX » TREX 7.0 for
SAP NetWeaver 7.0 » TREX Configuration  Post-
Installation Configuration > Client Side > Java
Application (HTTP Connection) # Specifying the

Address of the TREX Name Server 4
TREX 71

http://help.sap.com/nw702l‘hr|} Application Help
» Function-Oriented View <lLanguage> p
Information Integration by Key Capability > Search
% Search and Classification TREX » TREX 71 for
SAP NetWeaver 70 ¥ TREX Configuration » TREX
Basic Configuration > Connecting TREX with an
Application > Connecting TREX with a Java
Application (HTTP Connection) > Specifying the
Address of the TREX Name Server 4

TREX 7.0

http://help.sap.com/nw703l'hr|} Application Help
» Function-Oriented View <Language>
Information Integration by Key Capability > Search
and Operational Analytics # Other Search
Technology > Search and Classification TREX }
TREX 7.0 for SAP NetWeaver 7.0 » TREX
Configuration  Post-Installation Configuration ¥
Client Side ¥ Java Application (HTTP Connection)
> Specifying the Address of the TREX Name

Server 4
TREX 7.1
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Task

Detailed Information

http://help.sap.com/nw703l‘h-|} Application Help
» Function-Oriented View <lLanguage> >
Information Integration by Key Capability > Search
and Operational Analytics > Other Search
Technology > Search and Classification TREX >
TREX 7.1 for SAP NetWeaver 7.0 > TREX
Configuration » TREX Basic Configuration ¥
Connecting TREX with an Application > Connecting
TREX with a Java Application (HTTP Connection) >
Specifying the Address of the TREX Name Server 4

On the target system, delete old indexes that belong to the
source system. Define and generate new indexes for the tar-
get system.

1 Note

The prerequisite for this step is that all repository manag-
ers are configured correctly for the target system.

For more information, see the SAP Library for your release
at:

e SAP NetWeaver 7.0:
http://help.sap.com/nw70# |l Application Help
Function-Oriented View <Language> > Information
Integration: Key Areas > Knowledge Management >
Administration Guidel > System Administration >

System Configuration ¥ ‘Index Administration’ iView 4
e SAP NetWeaver including EHP1:

http://help.sap.com/nw701%|[» Application Help *
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
> Administration Guidelll > System Administration >

System Configuration # ‘Index Administration’ iView 4
® SAP NetWeaver including EHP2:

http://help.sap.com/nw702 P‘hvl} Application Help >
Function-Oriented View <Language> } Information
Integration by Key Capability > Knowledge Management
> Administration Guidelll > System Administration >

System Configuration > ‘Index Administration’ iView }
e SAP NetWeaver including EHP3:

http://help.sap.com/nw703l'hr|} Application Help >
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
» Administration Guide » System Administration

System Configuration # ‘Index Administration’ iView 4

Repository Managers
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Ensure that the target system does not have write access to the same repositories as the source system.

Task

On the target system, check the configuration of all external
and internal repository managers that have write access to
the same data as the source system. Make sure that the
source and target system do not have write access to the
same data. For example, check the repository manager set-
tings for:

® CM FSDBOrCM DBFS repositories

e Simple File System repositories

Detailed Information

For more information, see the SAP Library for your release
at:

e SAP NetWeaver 7.0:
http://help.sap.com/nw70fhr|} Application Help }
Function-Oriented View <Language> > Information
Integration: Key Areas > Knowledge Management >
Administration Guide ¥ System Administraton *
System Configuration > Content Management
Configuration » Repositories and Repository Managers

» External Repositories 4
e SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701$|} Application Help >
Function-Oriented View <Language> » Information
Integration by Key Capability > Knowledge Management
> Administration Guide > System Administraton >
System Configuration > Content Management
Configuration > Repositories and Repository Managers

» External Repositories 4
® SAP NetWeaver 7.0 including EHP2:

http:/help.sap.com/nw702 |+ Application Help
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
> Administration Guide > System Administraton >
System Configuration # Content Management
Configuration > Repositories and Repository Managers

> External Repositories 1
® SAP NetWeaver 7.0 including EHP3:

http://help.sap.com/nw703l‘hr|} Application Help >
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
> Administration Guide > System Administraton >
System Configuration > Content Management
Configuration > Repositories and Repository Managers

» External Repositories 3

Services
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Task

Content Exchange

If content exchange is in use, the configuration on the source
and target system is identical. However, it does not make
sense to have the same content exchange procedures con-
figured twice. For this reason, delete the configuration on the
target system and, if required, set up a new configuration.
Run a cleanup file to remove the existing configuration on
the target system:

e Download the cleanup file attached to SAP Note
1238351#% . Note that the cleanup procedure automati-
cally creates a new ID for a syndicator and subscriber.

e |mport the cleanup file into the target portal. To do this,
choose |} System Administration > System
Configuration > Knowledge Management > Content
Management ] and then, on the right, choose

|} Actions > Import 1
e [frequired, configure new content exchange settings on
the target system.

Detailed Information

For more information, see the SAP Library for your release
at:

e SAP NetWeaver 7.0:
http://help.sap.com/nw7OI'hr|} Application Help >
Function-Oriented View <Language> > Information
Integration: Key Areas > Knowledge Management >
Administration Guide ¥ System Administration >
System Configuration > Content Management
Configuration » Global Services  Content Exchange

Service ]
e  SAP NetWeaver 7.0 including EHP1:

http:/help.sap.com/nw701#% | Application Help
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
> Administration Guide > System Administration >
System Configuration » Content Management
Configuration  Global Services  Content Exchange

Service 4
® SAP NetWeaver 7.0 including EHP2:

http:/help.sap.com/nw702 |l Application Help
Function-Oriented View <Language> } Information
Integration by Key Capability > Knowledge Management
> Administration Guide > System Administration >
System Configuration } Content Management
Configuration > Global Services > Content Exchange

Service 4
e SAP NetWeaver 7.0 including EHP3:

http://help.sap.com/nw703l'hr|} Application Help >
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
» Administration Guide » System Administration
System Configuration > Content Management
Configuration  Global Services  Content Exchange
Service }
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Task

URL Generator

On the target system, check the settings for the Host and

Alternative Host parameters.

Detailed Information

For more information, see the SAP Library for your release
at:

SAP NetWeaver 7.0:
http://help.sap.com/nw70fh'|) Application Help >
Function-Oriented View <Language> } Information
Integration: Key Areas > Knowledge Management >
Administration Guide > System Administration >
System Configuration } Content Management
Configuration # Global Services # URL Generator

Service }
SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701l'br|} Application Help >
Function-Oriented View: English > Information
Integration by Key Capability # Knowledge Management
» Administration Guide ¥ System Administration b3
System Configuration > Content Management
Configuration  Global Services # URL Generator

Service }
SAP NetWeaver 7.0 including EHP2:

http://help.sap.com/nw702 P‘hrl} Application Help >
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
> Administration Guide > System Administration >
System Configuration » Content Management
Configuration } Global Services > URL Generator

Service 4
SAP NetWeaver 7.0 including EHP3:

http:/help.sap.com/nw703%r | Application Help
Function-Oriented View <Language> ¥ Information
Integration by Key Capability > Knowledge Management
> Administration Guide > System Administration >
System Configuration » Content Management
Configuration > Global Services > URL Generator
Service 4
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Task

System Landscape: On the target system, delete the old
system IDs that belong to the source system.

Detailed Information

Log on to the Portal and choose |} System Administration >
System Configuration % Knowledge Management  Content
Management > Global Services > System Landscape
Definitions > Systems > Content Management Systems }

Scheduler Service: If the target system is an SAP Java clus-
ter, then you must assign scheduler tasks to the new system
IDs of the target system. After the system copy, tasks are
still assigned to the IDs of the source system.

For more information, see the SAP Library for your release
at:

e SAP NetWeaver 7.0:
http://help.sap.com/nw70ll'h'|) Application Help >
Function-Oriented View <Language> } Information
Integration: Key Areas > Knowledge Management >
Administration Guide > Minimal Configuration for
Knowledge Management > Cluster Only: Assigning

Tasks to Nodes ]
e SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701#% | Application Help
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
> Administration Guide > Minimal Configuration for
Knowledge Management » Cluster Only: Assigning

Tasks to Nodes }
e SAP NetWeaver 7.0 including EHP2:

http://help.sap.com/nw702 P‘hrl} Application Help >
Function-Oriented View <Language> » Information
Integration by Key Capability > Knowledge Management
> Administration Guide > Minimal Configuration for
Knowledge Management > Cluster Only: Assigning

Tasks to Nodes }
e SAP NetWeaver 7.0 including EHP3:

http://help.sap.com/nw703l'hr|} Application Help >
Function-Oriented View <Language> > Information
Integration by Key Capability > Knowledge Management
» Administration Guide » Minimal Configuration for
Knowledge Management ¥ Cluster Only: Assigning
Tasks to Nodes 1

Collaboration
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Task

On the target system, adapt the room back-end properties

server address, server port,andWeb protocol.

Detailed Information

For more information, see the SAP Library for your release
at:

e SAP NetWeaver 7.0:
http://help.sap.com/nw7OI'hr|} Application Help >
Function-Oriented View <Language> > People
Integration by Key Capability > Collaboration >
Administration Guide ¥ Making Rooms Available in the
Portal > Preparing Rooms for Use > Defining the Web

Address and Automatic E-Mail Dispatch for Rooms 3
o SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701l‘hr|} Application Help >
Function-Oriented View <Language> > People
Integration by Key Capability > Collaboration >
Administration Guide > Making Rooms Available in the
Portal > Preparing Rooms for Use > Defining the Web

Address and Automatic E-Mail Dispatch for Rooms ]
® SAP NetWeaver 7.0 including EHP2:

http:/help.sap.com/nw702#r |l Application Help
Function-Oriented View <Language> } People
Integration by Key Capability # Collaboration
Administration Guide > Making Rooms Available in the
Portal Preparing Rooms for Use > Defining the Web

Address and Automatic E-Mail Dispatch for Rooms 4
e SAP NetWeaver 7.0 including EHP3:

http://help.sap.com/nw703!‘h-|} Application Help >
Function-Oriented View <Language> p People
Integration by Key Capability > Collaboration >
Administration Guide > Making Rooms Available in the
Portal ¥ Preparing Rooms for Use # Defining the Web
Address and Automatic E-Mail Dispatch for Rooms }
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Task

On the target system, generate a new index to enable search
operations in the content of rooms.

Detailed Information

SAP NetWeaver 7.0:

http://help.sap.com/nw70%% |l Application Help
Function-Oriented View <Language> > People
Integration by Key Capability ¥ Collaboration ¥
Administration Guide > Making Rooms Available in the
Portal > Preparing Rooms for Use > Configuring the

Search for Room Content 4
SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701!‘hr|} Application Help >
Function-Oriented View <Language> p People
Integration by Key Capability > Collaboration >
Administration Guide ¥ Making Rooms Available in the
Portal > Preparing Rooms for Use > Configuring the

Search for Room Content }
SAP NetWeaver 7.0 including EHP2:

http://help.sap.com/nw702 I‘hrl} Application Help >
Function-Oriented View <Language> > People
Integration by Key Capability > Collaboration >
Administration Guide > Making Rooms Available in the
Portal > Preparing Rooms for Use > Configuring the

Search for Room Content 4
SAP NetWeaver 7.0 including EHP3:

http://help.sap.com/nw703% |+ Application Help
Function-Oriented View <Language> } People
Integration by Key Capability # Collaboration
Administration Guide ¥ Making Rooms Available in the
Portal Preparing Rooms for Use > Configuring the

Search for Room Content 1
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Task

On the target system, check the properties of the
roomsearch object. Make sure that the parameter Use
TREX is set.

Detailed Information

SAP NetWeaver 7.0:

http://help.sap.com/nw70%% |l Application Help
Function-Oriented View <Language> > People
Integration by Key Capability ¥ Collaboration ¥
Administration Guide > Making Rooms Available in the
Portal > Preparing Rooms for Use > Configuring the

Search for Room Content 4
SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701!‘hr|} Application Help >
Function-Oriented View <Language> p People
Integration by Key Capability > Collaboration >
Administration Guide ¥ Making Rooms Available in the
Portal > Preparing Rooms for Use > Configuring the

Search for Room Content }
SAP NetWeaver 7.0 including EHP2:

http://help.sap.com/nw702 I‘hrl} Application Help >
Function-Oriented View <Language> > People
Integration by Key Capability > Collaboration >
Administration Guide > Making Rooms Available in the
Portal > Preparing Rooms for Use > Configuring the

Search for Room Content 4
SAP NetWeaver 7.0 including EHP3:

http://help.sap.com/nw703% |+ Application Help
Function-Oriented View <Language> } People
Integration by Key Capability # Collaboration
Administration Guide ¥ Making Rooms Available in the
Portal Preparing Rooms for Use > Configuring the

Search for Room Content 1
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Task Detailed Information
On the target system, configure the connection to the re- For more information, see the SAP Library for your release
quired groupware server. at:

e SAP NetWeaver 7.0:
http://help.sap.com/nw70fh'|) Application Help >
Function-Oriented View <Language> } People
Integration by Key Capability » Collaboration »
Administration Guide > Groupware > Installing and

Configuring E-Mail Connectivity }
e SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701l'br|} Application Help >
Function-Oriented View <Language> > People
Integration by Key Capability > Collaboration >
Administration Guide ¥ Groupware ¥ Installing and

Configuring E-Mail Connectivity }
e SAP NetWeaver 7.0 including EHP2:

http://help.sap.com/nw702 P‘hrl} Application Help >
Function-Oriented View <Language> » People
Integration by Key Capability > Collaboration >
Administration Guide ¥ Groupware # Installing and

Configuring E-Mail Connectivity }
e SAP NetWeaver 7.0 including EHP3:

http://help.sap.com/nw703!‘h-|} Application Help >
Function-Oriented View <Language> p People
Integration by Key Capability > Collaboration >
Administration Guide > Groupware > Installing and

Configuring E-Mail Connectivity 4
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Task

If the e-mailing service is active on the source system, but is
not required on the target system, you need to delete the e-
mail transport. After deletion of the transport, e-mailing is
disabled. E-mails will no longer be automatically sent, for ex-
ample, when members are excluded from a room or docu-
ments are updated and deleted.

Detailed Information

For more information, see the SAP Library for your release
at:

e SAP NetWeaver 7.0:
http://help.sap.com/nw70fh'|) Application Help >
Function-Oriented View <Language> } People
Integration by Key Capability » Collaboration »
Administration Guide > Groupware > Installing and
Configuring E-Mail Connectivity > Configuration Steps

» Creating an E-Mail Transport 4
e SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701#% |l Application Help
Function-Oriented View <Language> > People
Integration by Key Capability ¥ Collaboration ¥
Administration Guide } Groupware > Installing and
Configuring E-Mail Connectivity ¥ Configuration Steps

> Creating an E-Mail Transport }
e  SAP NetWeaver 7.0 including EHP2:

http://help.sap.com/nw702 P‘hrl} Application Help >
Function-Oriented View <Language> p People
Integration by Key Capability > Collaboration >
Administration Guide > Groupware > Installing and
Configuring E-Mail Connectivity > Configuration Steps

> Creating an E-Mail Transport }
e SAP NetWeaver 7.0 including EHP3:

http://help.sap.com/nw703l'hr|} Application Help >
Function-Oriented View <Language> > People
Integration by Key Capability > Collaboration >
Administration Guide ¥ Groupware » Installing and
Configuring E-Mail Connectivity > Configuration Steps
> Creating an E-Mail Transport 3
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Task

On the target system, reconfigure the ServerName and
ServerPort for the application sharing server.

Detailed Information

For more information, see the SAP Library for your release

at:

SAP NetWeaver 7.0:

http://help.sap.com/nw70fh'|) Application Help >
Function-Oriented View <Language> } People
Integration by Key Capability » Collaboration »
Administration Guide > Real-Time Collaboration >
Configuring Real-Time Collaboration > Configuring the
Application Sharing Server (RTC) # Setting Application

Sharing Server Parameters (RTC) }
SAP NetWeaver 7.0 including EHP1:

http://help.sap.com/nw701l'br|} Application Help >
Function-Oriented View <Language> ¥ People
Integration by Key Capability > Collaboration >
Administration Guide ¥ Real-Time Collaboration
Configuring Real-Time Collaboration > Configuring the
Application Sharing Server (RTC) # Setting Application

Sharing Server Parameters (RTC) 1
SAP NetWeaver 7.0 including EHP2:

http://help.sap.com/nw702 P‘hrl} Application Help >
Function-Oriented View <Language> > People
Integration by Key Capability > Collaboration >
Administration Guide > Real-Time Collaboration >
Configuring Real-Time Collaboration ¥ Configuring the
Application Sharing Server (RTC) > Setting Application

Sharing Server Parameters (RTC) s |
SAP NetWeaver 7.0 including EHP3:

http:/help.sap.com/nw703%r | Application Help
Function-Oriented View <Language> } People
Integration by Key Capability # Collaboration
Administration Guide > Real-Time Collaboration >
Configuring Real-Time Collaboration > Configuring the
Application Sharing Server (RTC) > Setting Application
Sharing Server Parameters (RTC) }
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7.5.3 Business Intelligence Java Components (Bl Java)

You have to perform the following follow-up activities for usage type Bl Java.

Related Information

Business Intelligence (Bl Java) [page 113]
Basic Configuration for Usage Type Bl Java [page 114]

7.5.3.1 Business Intelligence (Bl Java)

Use

Follow the instructions in this section if the entries for source system connection have not been copied to the
services file of your target system.

Prerequisites

You have performed a system copy that includes SAP NetWeaver Business Warehouse (SAP NetWeaver BW).

Procedure

Adding Entries to the Services File
You have to do the following to add the entries to the services file:

If your target host runs on a UNIX platform

1. Log on to your target system as user root.

Caution

Make sure that the user root has not set any environment variables for a different SAP system or
database.

2. Editthefile /etc/services.
3. Add the entries for your source system connection, for example sapgw47 3347.

If your target host runs on a Windows platform or on IBM i
1. Logon to your target system as a member of the local administration group.
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2. Editthefile <WwindowsDirectory>\system32\drivers\etc\services.

3. Add the entries for your source system connection, for example sapgw47 3347.

7.5.3.2 Basic Configuration for Usage Type Bl Java

As of SAP NetWeaver 7.0 Support Package 8, you can run the wizard-based configuration task Bl-Java /
Technical configuration of Bl-Java (repeatable, reproducible) using the configuration wizard to automatically
configure the required settings for portal and Bl Java integration.

For more information, see the SAP Library for your release at:

SAP NetWeaver Release

SAP NetWeaver 7.0

Location

http://help.sap.com/nw70fh-|} Application Help > SAP
Library: <Language> » SAP NetWeaver Technology
Consultant's Guide > Enterprise Reporting, Query, and
Analysis > Wizard-Based Configuration of Bl Java }

SAP NetWeaver 7.0 including EHP1

http://help.sap.com/nw701!‘hr|} Application Help > SAP
Library: <Language> » SAP NetWeaver Technology
Consultant's Guide > Enterprise Reporting, Query, and
Analysis » Wizard-Based Configuration of Bl Java b |

SAP NetWeaver 7.0 including EHP2

http://help.sap.com/nw702$|} Application Help > SAP
Library: <Language> » SAP NetWeaver » Technology
Consultant's Guide > Enterprise Reporting, Query, and
Analysis » Wizard-Based Configuration of Bl Java |

SAP NetWeaver 7.0 including EHP3

http://help.sap.com/nw703fhr|} Application Help > SAP
Library: <Language> » SAP NetWeaver » Technology
Consultant's Guide > Enterprise Reporting, Query, and
Analysis » Wizard-Based Configuration of Bl Java |
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7.5.4 Development Infrastructure (DI)

You have to perform the following manual steps on the target system after moving an SAP system with usage
type Development Infrastructure (DI). The assumption here is that all components (DTR, CBS, CMS, SLD, and
name server) were on a single host before the move and will remain on a single host after the move.

Procedure

1. If you are using an LDAP server for user management, it should be running to ensure that all the users that
were created when the Development Infrastructure (DI) was on the source system will still be valid after the
move to the target system.

2. Check the Java Engine configuration:

o SetMaxHeapSize and other engine parameters to the recommended values.
For more information, see your installation guide.
o If your database is SAP MaxDB, perform the following steps:
1. Upgrade your SAP MaxDB database to at least version 29.
2. Setthe JOIN OPERATOR IMPLEMENTATION parameter to IMPROVED (setting this value is only
possible using the DB-WebUI in SAPMMC).
3. Restart the database.
o For general recommendations for the configuration of the Development Infrastructure Servers, see
SAP Note889038#r .

3. Design Time Repository (DTR):

o Redeploy the database schema.
This is necessary to re-create the missing metadata for the database views in the dictionary. Otherwise
OpenSQL cannot see the database views.
The database schema of the DTR server is part of the NWDI SCA. This is the SCA that you have
downloaded from SAP Software Distribution Center to deploy the SAP NetWeaver Development
Infrastructure (NWDI).
To only deploy this database schema, you have to extract the SCA file. You can do this by
appending . zip to the filename. Then you can use a normal archive tool like WinZip. Under the
subfolder DEPLOYARCHIVES, you can find the SDA sap.com~tc~dtr~dbschema. sda for the
database schema. This SDA must be deployed using the Software Deployment Manager (SDM).

1 Note

During deployment, use the option Update deployed SDAs/SCAs that have any version. This option
can be set in the Deployment tab on SDM.

o Restart DTR server.

o Change the URL of the name server (in name server configuration page in Web Ul: http://
<dtrhost>:<port>/dtr/system-tools/administration/NameServerConfiguration) if you
intend to use a different name server for the moved DTR instance, or if the name server was also
moved.

o Perform Update Statistics (30%) on the database.
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1 Note

If your database is SAP MaxDB, you can use the database manager to update the database
statistics.

4. System Landscape Directory (SLD):

If you used the SLD on the source host as the name server, you need to change the CimomURL to point to
the target host. To do so, proceed as follows:

a. Logontothe SLD as administrator.

b. Choose

Administrator » Content Maintenance _J, then under Class, choose |» System Landscape

Directory ¥ <your local SLD>

c. Under CimomURL, change the host to target host.

Caution

Do not change the Objectserver attribute.

5. Component Build Service (CBS):

The service properties JDK_HOME PATHS, BUILD TOOL JDK_ HOME, rootFolder, and threadPoolSize
have to be adjusted according to the hardware and software configuration of the new system.

For more information about these parameters, see your installation guide.

6. Change Management Service (CMS):

The main steps in CMS involve resetting the fields containing URLs to other components (such as DTR,

CBS, SLD).

o |f CMS has not been configured yet, proceed as follows:

1. Copy the folder /usr/sap/trans/EPS/in/CMS<host><SAPSID>, including its content, to the
target host.

2. Rename the folder to the new host value and new SAP system ID (if changed).

3. Make sure that the engine user (<sAPSTD>adm) has write permissions in the copied folder.

o If CMS has been configured and you have used it already, proceed as follows:

1. For the domain (in the Domain Data tab):

1.

ok~ wn

Change the SLD URL to point to the target host.

Change the CMS URL to point to the target host.

Change the transport directory to the appropriate directory on the new CMS (target host).
Save the domain. You should see a status message that the data was saved successfully.

Update CMS by choosing Update CMS. You should see a status message that the CMS update
was successful.

2. Copy the contents of the transport directory of the old CMS (source system) to the transport
directory of the new CMS (target system). The transport directory is configured in the domain (see
Domain Data tab page).

3. Foreach track (in the Track Data tab page):

1

2.
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Change the CBS and DTR URLs.

For each runtime system that is defined, change the runtime system configuration to point to
the appropriate host (of the target runtime system).

If this has not changed, leave the fields unchanged.
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IDE:

e}

3. Save the track definition.
You should see a status message that the data was saved successfully.

4. Restore system state (of the DEV system). This places the software components (SCs) into
the import queue of this system.

5. Import these SCs. After the successful import, you should see a status for each SC.

Change the SLD URL in the preference page of the SAP NetWeaver Development Studio (under [» Java

Development Infrastructure » Development Configuration Pool ).
This should now point to the new SLD on the target system.

Import the development configuration that you used earlier for development.

Now you are ready to begin the development with you new (relocated) Development Infrastructure (DI).

. Verification Steps (optional)

The following steps are optional and verify that the Development Infrastructure (D) is fully functional after
the move:

1
2.

Log on to the DTR (using the browser) for all defined users and browse the repository.
Using IDE, create a new development component (DC), check it in and activate it:

o The activation should be successful.

o The name of the development component (DC) must be reserved on the name server.

Release the activity created above (from the transport view in the IDE):
The activity (change request) should appear in the import queue of the CONS system of the track.

Import the change request into the CONS system (from the CMS Transport Studio).
Assemble a new version of your software components (SCs) in one of the tracks.

7.5.5 Self Services (XSS)

Related Information

Re-Creating the JCo Destinations [page 118]
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75.5.1 Re-Creating the JCo Destinations

You must re-create the JCo destinations as described in the SAP Library for your release at:

SAP NetWeaver Release Location

SAP NetWeaver 7.0 http://help.sap.com/nw70" | Development Information

Developers's Guides: English » Fundamentals Using Java
> Core Development Tasks > Developing User Interfaces >
Web Dynpro for Java > Ensuring Quality > Web Dynpro
Content Administrator > Creating JCo Destinations }

SAP NetWeaver 7.0 including EHP1 http://help.sap.com/nw701#% |l Development Information

> Developers's Guides: English > Fundamentals } Using
Java ¥ Core Development Tasks > Developing User
Interfaces > Web Dynpro for Java > Ensuring Quality > Web
Dynpro Content Administrator > Creating JCo

Destinations 3.

SAP NetWeaver 7.0 including EHP2 http://heIp.sap.com/nw702l‘hr|} Development Information

> Developers's Guides: English > Fundamentals > Using
Java } Core Development Tasks > Developing User
Interfaces  Web Dynpro for Java # Ensuring Quality  Web
Dynpro Content Administrator > Creating JCo

Destinations 3.

SAP NetWeaver 7.0 including EHP3 http://heIp.sap.com/nw703l'hr|} Development Information

> Developers's Guides: English > Fundamentals > Using
Java > Core Development Tasks > Developing User
Interfaces  Web Dynpro for Java # Ensuring Quality  Web
Dynpro Content Administrator  Creating JCo

Destinations }

For more information, see SAP Note 899144 ¥ .

7.5.6 CRM Java Components (JCRM) / Extended E-Selling
Components (XECO)
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7.5.7 MapBox

You need to proceed as follows to restore the configuration of the CRM Java component MapBox on the target

system.

Procedure

1. Shut down the Java engine.

2. Copy the following files to the relevant directories:

a. Copy the files mapboxmeta.xml, mapboxmeta.xsl, and xmlprofiles.xml tothe directory

<J2EE root>/cluster/server/.mapboxmeta. You can find these files at the same location on the

source system.
b. Copy the file coordserver.cfgtothe <J2EE root>/cluster/server directory.

c. If youwant to have the smoketest directory on the target system, then you need to copy the smoketest

directory too.

3. Start the Java engine and MapBox from the URL.

Results

You have restored the configuration for MapBox on the target system.

7.5.8 SRM Live Auction Cockpit (SRMLAC)

7.5.9 SCM Forecasting & Replenishment Processor (SCM
FRP)

After the system copy, you must perform follow-up activities as described in SAP Note 1033225#% .
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7.6 Checking the Database Parameters for IBM Db2 for
Linux, UNIX, and Windows

Use

1 Note

This section is only valid if your database is IBM Db2 for Linux, UNIX, and Windows.

After installation has completed, make sure that you check the parameters of the database configuration and
the database manager configuration. A check of the database parameters ensures that your database
parameters conform with the latest SAP recommendations where necessary and are adapted to your needs.

Procedure

You can check the parameters of the database in one of the following ways:

e Compare the current parameters of your database with the parameters as they are recommended for SAP
systems in the following SAP Notes:

Database Version Corresponding SAP Note

IBM Db2 V9.7 1329179#%
IBM Db210.1 1692571/
IBM Db210.5 1851832
IBM Db211.1 2303771Fr

e Use the DBA Cockpit to compare the current parameters with the standard parameters. In the DBA
Cockpit (transaction DBACOCKPIT), on the Database tab page, choose |l Configuration » Parameter
Check 3.

1 Note

The parameter check in the DBA Cockpit is available as of SAP Basis 7.00 with enhancement package 2 and
support package 6. For more information about the parameter check, see the Database Administration
Guide: Database Administration Using the DBA Cockpit — IBM DbZ2 for Linux, UNIX, and Windows listed in
Online Information from SAP [page 147].
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8 Additional Information

Related Information

Jload Procedures Using the Java Migration Monitor [page 121]
Analysis of the Export and Import Times [page 128]

Package and Table Splitting for Java Tables [page 129]
Additional Information about the OraBRCopy Tool [page 139]
Using PowerShell [page 144]

Online Information from SAP [page 147]

8.1 Jload Procedures Using the Java Migration Monitor

Related Information

About the Java Migration Monitor [page 121]

Configuration for Using the Java Migration Monitor [page 122]
Starting the Java Migration Monitor [page 124]

Output Files of the Java Migration Monitor [page 126]
Restarting Jload Processes [page 127]

8.1.1 About the Java Migration Monitor

1 Note

The Java Migration Monitor tool is available only for systems based on SAP NetWeaver 7.0 EHP2 and
higher,

The Java Migration Monitor is a tool that helps you to perform and control the unload and load process during
the system copy procedure.
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The Java Migration Monitor performs the following steps:

e Starting the J1load processes to load or unload the data according to the requirements of the user

e |nforming the person performing the system copy in case of errors

1 Note

Some features described in this documentation might be not available in the JMigmon tool if you do not use
the most current version of the tool

Tool
The tool is part of the CORETOOL* . SCA archive and consists of the following:

e User Guide
O JMigrationMonitor.pdf

o Located:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools

e Scripts
© jmigmon export.sh/ jmigmon export.bat
© jmigmon import.sh/ jmigmon import.bat
o Located:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools

® jararchive
© Jmigmon.jar
o Located:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools\sharedlib
® Property files
O export.jmigmon.properties
O import.jmigmon.properties
o Located:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools

Prerequisites

® The JRE version must be at least 1.4.1.
® JAVA HOME environment variable must point to the JRE directory.
® The correct directory structure for J1oad dump files must exist on both the source and target hosts

8.1.2 Configuration for Using the Java Migration Monitor

1 Note

The Java Migration Monitor tool is available only for systems based on SAP NetWeaver 7.0 EHP2 and
higher,
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The following options can be provided via the property file or via command line. Command line parameters
take precedence over parameters specified in the property file.

Help

The tool displays the available parameters, if you call it with one of the following command line options:

® -help

o 2

Version Information

With the following command line option, the tool displays version information: -version.

General Options

Name Description Comment
mode Java Migration Monitor mode: import | Only available as command line option
or export

sid SAP system ID SAP system ID

dsn Data source name Specifies the data source name and is regis-
tered in the SecureStore; usually jdbc/pool/
<SAPSID>

ssProps Path to the SecureStore properties file | On Windows: local drive or UNC path

ssKey Path to the SecureStore key file On Windows: local drive or UNC path

exportDirs Export directories path Specifies the path or paths for exported data
and triggers the export functionality.
Separator on Windows: ;"
Separator on UNIX, IBM i: “:"

importDirs Import directories path Specifies the path or paths for imported data
and triggers the import functionality.
Separator on Windows: ;"
Separator on UNIX, IBM i: “:"
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Name Description Comment

orderBy Package order This can be the name or path of the file that
contains package names. If the option value is
omitted the package order is not determined.

jobNum Number of parallel export jobs Defaultis 3.

monitorTimeout Monitor time-out in seconds Default is 30 seconds.

disableStatistics Disables statistics logging Disables statistics logging for each Jload proc-
ess: Therefore Jload does not collect statistics
data that could later be displayed by the time
analyzer.

Additional Options (all optional)

Name Description Comment

orderBy Package order This can be the name or path of the file that
contains package names. If the option value is
omitted the package order is not determined.

jobNum Number of parallel export jobs Defaultis 3.

monitorTimeout Monitor time-out in seconds Default is 30 seconds.

8.1.3 Starting the Java Migration Monitor

Use

1 Note

The Java Migration Monitor tool is available only for systems based on SAP NetWeaver 7.0 EHP2 and
higher,

You can start the tool using one of the following:
® The Windows batch files jexport monitor.bat/ jimport monitor.bat

® Aspartofthe export / import procedure of the software provisioning manager

The application allows you to specify options in the command line or in the export or import property files. The
names of the property files are export.jmigmon.properties and import.jmigmon.properties.

Any options specified in the command line take precedence over the corresponding options in the application
property file. Options are case-sensitive; any options that are not recognized are ignored. To specify an option:

® |nthe command line, enter -<optionName> <optionValue>
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e |nthe application property file, insert the new line <optionName>=<optionValue>

Prerequisites

1 Note

We recommend that you create a certain directory and start the tool from there, because the Java
Migration Monitor produces log and trace files in the current working directory.

Before you run the Java Migration Monitor, set the following environment variables:

® SLTOOLS HOME
Set this variable to the following directory:
Windows: <Drive>:\usr\sap\<SAPSID>\SYS\global\sltools\sharedlibor <Drive>:
\<sapmnt>\<SAPSID>\SYS\global\sltools\sharedlib
® SLTOOLS SECURITY HOME
Set this variable to the directory, which contains the iaik jce.jarfile.
The default directory is:
Windows: <Drive>:\usr\sap\<SAPSID>\SYS\global\security\lib\tools Or <Drive>:\sapmnt
\<SAPSID>\SYS\global\security\lib\tools
® SLTOOLS DBDRIVER HOME
Set this variable to the directory, which contains the database driver.

Example

For MaxDB on Windows: <Drive>:\sapdb\programs\runtime\jar

Procedure

Start the Java Migration Monitor as user <sapsid>adm by executing one of the following from the command
line:
® jmigmon_export.bat -<optionName> <optionValue>

® Jjmigmon_import.bat -<optionName> <optionValue>

Example

jmigmon_export.bat -sid CE3 -dsn jdbc/pool/CE3 -ssProps D:\usr\sap\CE3\SYS\global
\security\data\SecStore.properties -ssKey D:\usr\sap\CE3\SYS\global\security\data
\SecStore.key -exportDirs D:\JPKGCTL

Start the monitor and then close the shell window or command processor. The monitor process runs in the
background. Use the monitor *.logand *.console.log filesto check monitor processing state.
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Result

What happens during the export or import:

During the import the tool starts a search in the directories specified by the -importDirs parameter for
packages in XML format and puts them into a working queue.

Next it starts a number (specified by the -5 obNum parameter) of parallel Jload importing tasks, taking tasks
from the working queue until the queue is empty.

During the export the tool starts a search in the directories specified by the -exportDirs parameter for
packages in XML format and puts them in a working queue.

Then it starts exporting all the packages containing metadata one after another (not in parallel) while removing
them from the queue. The tool then starts a number (specified by the —-§ obNum parameter) of parallel J1oad
export tasks, taking tasks from the working queue until the queue is empty.

Example

export.jmigmon.properties file with export options

# jmigmon mode: import or export mode = export # number of parallel export jobs,
default is 3 jobNum = 1 # <SAPSID> of the system sid = CE3 # name of datasource
registered in system's SecureStore; usually jdbc/pool/<SAPSID> dsn = jdbc/pool/
CE3 # path of the SecureStore properties file ssProps = D:\usr\sap\CE3\SYS\global
\security\data\SecStore.properties # path of the SecureStore key file ssKey = D:
\usr\sap\CE3\SYS\global\security\data\SecStore.key # list of export directories
exportDirs = D:\JPKGCTL # monitor timeout in seconds, default is 30
monitorTimeout = 30

import_monitor.properties file with import options

# jmigmon mode: import or export mode = export # number of parallel export jobs,
default is 3 jobNum = 1 # <SAPSID> of the system sid = CE3 # name of datasource
registered in system's SecureStore; usually jdbc/pool/<SAPSID> dsn = jdbc/pool/
CE3 # path of the SecureStore properties file ssProps = D:\usr\sap\CE3\SYS\global
\security\data\SecStore.properties # path of the SecureStore key file ssKey = D:
\usr\sap\CE3\SYS\global\security\data\SecStore.key # list of import directories
importDirs = D:\export\unpacked\JAVA\JDMP # monitor timeout in seconds, default
is 30 monitorTimeout = 30

8.1.4 Output Files of the Java Migration Monitor

1 Note

The Java Migration Monitor tool is available only for systems based on SAP NetWeaver 7.0 EHP2 and
higher,
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Export

® cxport.state.properties

® <PACKAGE>.xml.log

Import

® import.state.properties

® <PACKAGE>.xml.log
Both the export and import state files contain package state lines such as the following:
SAPUSER=+

Format of lines is <PACKAGE>=<STATE>. The following table shows the possible values for state:

Value Description

0 Package export/import not yet started.

? Package export/import in progress.

- Package export/import finished with errors.
+ Package export/import finished successfully.

8.1.5 Restarting Jload Processes

Use

1 Note
The Java Migration Monitor tool is available only for systems based on SAP NetWeaver 7.0 EHP2 and
higher,

The state file allows package states to be manually updated to restart failed J1o0ad processes.

Example

If package processing failed and the package state has the value “-", the state can be set to “0"” and
processing of the package will be started again.
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Procedure

e To restart package processing, set the package state from “-" to “0".
e To skip package processing, set the package state from “0” or “-" to “+".

Caution

This is not recommended because it can cause inconsistent data files or database content.

e |f the package is currently being processed (the package state is “?") then any manual modifications of the
package state are ignored.

8.2 Analysis of the Export and Import Times

You can reduce the runtimes by splitting the packages in question or extracting long-running tables from the
packages.

If your SAP system is based on SAP NetWeaver 7.0 EHP2 and higher, you can use the jmigtime.jar archive
to analyze the runtimes of the individual packages. The tool is part of the CORETOOL* . SCA archive and consists
of the following:

e User Guide
0 JavaTimeAnalyzer.pdf

o Located:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools

® Scripts
O jexport time.sh/ jexport time.bat
O jimport time.sh/ jimport time.bat
O jtime join.sh/jtime join.bat
o Located:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools
® jararchive
© Jmigtime.jar
o Located:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools\sharedlib
® Property files
O export.jmigtime.properties
O import.jmigtime.properties
o Located:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools
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8.3 Package and Table Splitting for Java Tables

Purpose

The Java Splitter offers the following possibilities:

Splitting the default packages EXPORT . XML and IMPORT . XML into several smaller and equal sized
packages:

Extracting large tables into packages of their own

Splitting large tables into several smaller and equal sized packages (table splitting)

The tool provides the corresponding split packages for export and import. Package splitting and table splitting
can be used combined or separately.

Tool

The tool archive consists of the following:

User Guide
o JSplitterUserGuide.pdf

o Located:
<Drive:>:\usr\sap\<SAPSID>\SYS\globall\sltools

Scripts for starting the tool standalone
O Jsplitter.sh, jsplitter.bat

o Located:
<Drive:>:\usr\sap\<SAPSID>\SYS\global\sltools

jar archive
© sdt jcopy jpkgctl.jar
o Located:
<Drive:>:\usr\sap\<SAPSID>\SYS\global\sltools\sharedlib

8.3.1 Configuration for Using the Java Splitter

The following options can be provided via the property file or via command line. Command line parameters
take precedence over parameters specified in the property file.

1 Note

To get the complete list of supported options run java com.sap.inst.<tool> -help
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Help

With the following command line option, the tool displays all parameters available:

-help

General Options

General Splitting Options

Option Description Comment
-sec List of SAP system ID and data source
. 1 Note
name[,SecureStore property file, Secure-
Store key file][,SecureStore key phrase] This option is mandatory.
Separator on Windows: “"
Separator on UNIX, IBMi: *"
-dataDir Output data director
P Y 1 Note
This option is mandatory.
If this option is missing, the split rules are taken from
the command line arguments.
-log Log file with program output messages and | Default log file name is JPkgClt.console. log.
errors » ) ) )
In addition, a trace file (JPkgCt 1. trc) with detailed
process descriptions, errors, and messages is gener-
ated.
-help Prints help options for the parametersand | non
their usage

Mandatory General Options
The following splitting options are mandatory for both package and table splitting:

sid, dsn, ssProps, ssKey, dataDir
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Package Splitting Options

Package Splitting Options

Description Comment

-split Size of the splitted package with tables | Size can be a number of bytes (for ex-
ample, 1048576, 200M, 8G, and so on)

Additional Mandatory Option for Package Splitting

Splitting option: split

Table Splitting Options

Table Splitting Options

Option Description Comment
-splitrulesfile Files that contains key fields for each | Syntax:
table

<TABLE_NAME>:<NUMBER_OF_PACK-
AGES_FOR_SPLITTING>:<[TABLE_KEY_FOR_SPLIT-
TING]>

-tablesplit Rules for splitting each table Syntax:

<TABLE_NAME>:<NUMBER_OF_PACK-
AGES_FOR_SPLITTING>:<[TABLE_KEY_FOR_SPLIT-
TING]>

-checksplitrules Checks the syntax of the Syntax:

splitrulesfile. It expectsafile as <TABLE_NAME>:<NUMBER_OF PACK-

AGES_FOR_SPLITTING>:<[TABLE_KEY_FOR_SPLIT-
TING]>

an argument.

“» Example
J2EE_CONFIG:2:
JZEE_CONFIGENTRY: 4:CID

BC_COMPVERS:
2:COMPID; HASHNUMBER; COMPONENTTYPE ; SUBS
YSTEM

/. Caution

When configuring table splitting for a table without primary key (such as J2EE_CONFIGENTRY), you have to
provide a value for parameter <COLUMN TO BE USED FOR SPLITTING>. If the table to be splithasa
primary key (PK), this parameter is optional.
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Additional Mandatory Options for Table Splitting

Splitting options: splitrulefile, tablesplit

Example

JSplitter_cmd.properties :

#

# Table Splitting options
#

# Common options

#

# List of SAPSID, data source name[,SecureStore property file, SecureStore key

file] [, SecureStore key phrase]

-sec=CEl, jdbc/pool/CE1l,D:\usr\sap\CE1\SYS\global\security\data
\SecStore.properties, D:\usr\sap\CE1\SYS\global\security\data\SecStore.key

# Size of the split package with tables

-split=200M

# Output data directory

-dataDir=C:\jsplitter export dir

# File that contains key fields for each table with the following syntax:
<TABLE NAME>:<NUMBER OF PACKAGES FOR SPLITTING>:<[TABLE KEY FOR SPLITTING]>
-splitrulesfile=C:\jsplitter export dir\splitrulesfile.txt

# Log file with program output messages and errors

_log:

# Check splitrulesfile syntax

-checksplitrules=C:\jsplitter export dir\splitrulesfile.txt
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8.3.2 Starting the Java Splitter

This section describes how to start the Java splitter.

Prerequisites

Before you run the table splitter, set the following environment variables:

® SLTOOLS HOME
Set this variable to the following directory:
<Drive>:\usr\sap\<SAPSID>\SYS\global\sltools\sharedlib Or <Drive>:\sapmnt\<SAPSID>
\SYS\global\sltools\sharedlib

® SLTOOLS SECURITY HOME
Set this variable to the directory, which contains the iaik_jce.jar file.
The default directory is:
<Drive>:\usr\sap\<SAPSID>\SYS\globall\security\lib\tools or <Drive>:\sapmnt
\<SAPSID>\SYS\global\security\lib\tools

® SLTOOLS DBDRIVER HOME
Set this variable to the directory, which contains the database driver.

Example

For MaxDB on Windows: <Drive>:\sapdb\programs\runtime\jar

Context

= Recommendation
We recommend to create a certain directory for splitting and start the tools from there, because the splitter
produces log and trace files in the current working directory.

The application allows you to specify options in the command line or in the application property file. The name

of the property file is JSplitter cmd.properties.
Any options specified in the command line take precedence over the corresponding options in the application
property file. Options are case-sensitive; any options that are not recognized are ignored.

1 Note

To check the splitting processing state, use the splitter *.trcand *.console.logfiles.
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Procedure

1. Start the table splitter as user <sapsid>adm using the following batch file:
jsplitter.bat
2. Specify options as required in one of the following ways-optionName optionValue.
o Command line:
Specify the option in the format —optionName optionValue

©  Property file:
Add an option as a new line in the format optionName=optionValue

1 Note

If you use an invalid option or you enter -help, the available options for starting the tool are displayed.

Example
Command line

jsplitter.bat -tablesplit BC COMPVERS:2 -tablesplit J2EE CONFIG:4:CID; PATHHASH -
tablesplit J2EE CONFIGENTRY:4:CID

8.3.3 Output Files of the Java Splitter

Here you find an overview of the log, trace, result, and metadata files of the Java splitter.

® JPkgCtl.console.log

Default log file of splitter tool
® JPkgCtl.trc

Trace file with additional and more detailed information
® IMPORT <PKG NUMBER>.XML

Resulting xml files for import after package splitting
® EXPORT <PKG NUMBER>.XML

Resulting xml files for export after package splitting
® TIMPORT PKG METADATA.XML

Metadata for tables
® EXPORT PKG METADATA.XML

Metadata for tables
® sizes.xml

File with list of the biggest tables with their expected package size in bytes
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8.4 Implementing Oracle Database Vault with the Installer

The installer supports Oracle Database Vault. This section provides information about implementing Oracle
Database Vault (DV) with the installer.

Prerequisites

e Your Oracle database version must be 12.1 or higher.
e Check the prerequisites, restrictions, and patch requirements as listed in SAP Note 2218115#% .

Context

For Database Independent System Copy [page 33], the installer prompts whether DV is to be installed.

For the Oracle-Specific Procedure [page 55] the DV is already installed in the source database and must be first
disabled to complete the scenario and can then be enabled before the scenario is completed.

DV requires the following addional users:

® secadmin

® secacctmgr
These users are created by the installer.

For more information about Oracle Database Vault, see the Oracle Database documentation referred to in SAP
Note 2218115#% .

Procedure

1. Start the installer and choose the export option for your system variant as described in Running the
Installer [page 38].

2. During the target system installation, on the Oracle Database screen where you are prompted to enter the
required Oracle database parameters, mark the Install Oracle Database Vault checkbox.

3. During the target system installation, on the Database Accounts for Oracle Database Vault screen, specify
the following:
o Provide the passwords for the Oracle Database Vault user accounts secadmin and secacctmgr which

are to be created by the installer.

o If you want to be enabled after the installation has completed, mark the Enable Oracle Database Vault
checkbox.
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Next Steps

Configure Oracle Database Vault as described in SAP Note 2218115#% .

8.5 IBM Db2 for Linux, UNIX, and Windows Database

Enabling Recoverability of the IBM Db2 for Linux, UNIX, and Windows Database [page 136]

Online Information from IBM [page 138]

8.5.1 Enabling Recoverability of the IBM Db2 for Linux, UNIX,
and Windows Database

Use

Caution
This section applies only to your database. You only have to perform the steps outlined in this section once —

even if you install multiple SAP systems into one database.

Roll forward recovery enables you to recover lost data due to media failure, such as hard disk failure, and
applies log file information (log journal) against the restored database. These log files contain the changes
made to the database since the last backup.

Caution
A production system must run in log retention mode.
If a system is not running in log retention mode, all changes applied to the database since the last complete

backup are lost in the event of a disk failure.

In log retention mode, the log files remain in the log directory (1og_dir). To archive the log files, you can use
Db2's own log file management solution. For more information, see the documentation Database
Administration Guide for SAP on IBM Db2 for Linux, UNIX, and Windows.

Procedure

1. Logon tothe database server as user db2<dbsid>.
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2. To activate log retention mode and to specify the log archiving method, set configuration parameter
LOGARCHMETH]1 to one of the following options:
© LOGRETAIN
No log archiving takes place. Log files remain in the log directory.
© DISK:<log archive path>
Log files are archived to a disk location. You can archive them to tape using the Db2 tape manager
(db2tapemgr) at a later point in time.
O TSM:<TSM management class>
Log files are archived to Tivoli Storage Management (TSM)
O USEREXIT
For downward compatibility with the former user exit concept, you can specify value USEREXIT for
parameter LOGARCHMETH1.
© VENDOR:<path to vendor lib>
Log files are archived to a library that is provided by your vendor storage management.
To set configuration parameter LOGARCHMETH1 for your preferred archiving method, enter the following
command:
db2 update db cfg for <dbsid> using LOGARCHMETH1 <log_ archiving method>
For more information, see the documentation Database Administration Guide for SAP on IBM Db2 for Linux,
UNIX, and Windows.
3. To activate the settings, restart the database. The database is now in backup pending mode. You need to
take an offline backup before you can continue.
4. If you plan to make a backup to tape on Windows, you have to initialize the tape drive by entering the
following command:
db2 initialize tape on \\.\<tape device>

5. To start the offline backup for a single-partitioned database, enter the following command:
db2 backup db <dbsid> to <device>
Example

For example, to perform an offline backup of database C11 to tapes in devices TAPEO and TAPEL, enter
the following command:

db2 backup database Cl1l to \\.\TAPEO, \\.\TAPEl

1 Note

On a multipartitioned database, you must activate log retention mode on all database partitions. In addition,
you also have to perform an offline backup for all database partitions.

For more information about how to start a Db2 backup, see the IBM Db2 online documentation.

More Information

e Database Administration Guide for SAP on IBM Db2 for Linux, UNIX, and Windows (see Online Information
from SAP [page 147])

e Fordirect access to online information about Db2 that is provided by IBM, see Online Information from IBM
[page 138].
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e For access to more documentation for SAP systems on IBM Db2 for Linux, UNIX, and Windows, see Online
Information from SAP [page 147].

8.5.2 Online Information from IBM

You can use the following IBM Knowledge Center welcome page as a starting point to all kinds of
documentation for yourIlBM Db2 for Linux, UNIX, and Windows version: http:/www.ibm.com/support/
knowledgecenter/en/SSEPGG #*

The following tables provide direct links to IBM Db2 online documentation and manuals, listed by database
version:

IBM Db2 Knowledge Center

Database Version Internet Address

IBM Db211.1 http:/www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/
com.ibm.db2.luw.kc.doc/welcome.html #

IBM Db210.5 https:/www.ibm.com/support/knowledgecenter/SSEPGG_10.5.0/
com.ibm.db2.luw.kc.doc/welcome.htm! #*

IBM Db210.1 https:/Z/www.ibm.com/support/knowledgecenter/SSEPGG_10.1.0/
com.ibm.db2.luw.kc.doc/welcome.htm! #*

IBM Db2 9.7 https://www.ibm.com/support/knowledgecenter/SSEPGG_9.7.0/
com.ibm.db2.luw.kc.doc/welcome.html #

IBM Manuals

Database Version Internet Address

IBM Db210.5 http:/www.ibm.com/support/docview.wss?uid=swg27038855 #*
IBM Db2 10.1 http://www.ibm.com/support/docview.wss?uid=swg27024478 #*
IBM Db2 9.7 http://www.ibm.com/support/docview.wss?rs=71&uid=swg27015148 #*

8.6 Oracle Database

Additional Information about the OraBRCopy Tool [page 139]
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8.6.1 Additional Information about the “OraBRCopy” Tool

Related Information

Configuration [page 139]
Output Files [page 141]

8.6.1.1 Configuration

Help

The tool displays the available parameters, if you call it with one of the following command line options:

® -help
e -°
Version

The tool will display the version information (release branch and build date), if you call it with the following
command line option:

® -version

Application Options

Name Description Comment

oracleHome Oracle home directory Determined automatically in script/
batch files from the ORACLE_HOME en-
vironment variable

sourceSid Source database s1D Determined automatically in script/
batch files from the ORACLE SID envi-

ronment variable

targetsSid Target database s1D
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Name Description Comment
listenerPort Listener port number Mutually exclusive with tnsaAlias. Can
be foundinthe listener.ora file of
the source database.
tnsAlias Oracle TNs alias Mutually exclusive with
listenerPort. Can be found in the
tnsnames.ora file of the source data-
base.
password Password of SYSTEM database user
generateFiles Generates control/trace and
init<TARGET DBSID>.ora files.
forcelLogSwitches Forces log switches. If this option is
specified then Oracle database will be
stopped during the tool execution. 3
Additional Options
Name Description Comment
b Enables background mode .
g g 1 Note
Takes effect only as command line
option.
If the tool is running in the background
mode, the UNIX shell window or Win-
dows command prompt can be closed
after startup.
secure Enables secure mode .
1 Note

Takes effect only as command line
option.

If the tool is running in the secure
mode, command line parameters (ex.
passwords) will be hidden for java proc-
ess. The secure mode implicitly enables
background mode.
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Description Comment

trace Trace level Possible values: all, off, 1 (error), 2
(warning), 3 (info), 4 (config, default),
5,6,7 (trace)

Mandatory Options

® Generate files mode
generateFiles, targetSid, password, listenerPort Or tnsAlias

e Force log switches mode
forcelogSwitches, password, listenerPort Or tnsAlias 4

8.6.1.2 Output Files

® CONTROL.SQL

® CONTROL.TRC

® init<TARGET DBSID>.ora
® ora br copy.log

® OraBRCopy.console.log

8.7 \Verifying and Adjusting the instanceID of an AS Java
Instance

Using option Adjust instancelD of an AS Java Instance in Software Provisioning Manager (the" installer” for
short), you can verify the correctness of the instanceIDand box number parameters of an existing AS Java
instance, and adjust them if required.

Prerequisites

e The AS Java instance can be started.

e Caution: The installer performs changes in the database which are related to J2EE Engine configuration.
Therefore it is recommended that you back up the J2EE Engine configuration using the ConfigTool. You
can do this by exporting configurations cluster data,HttpHosts, apps, jms_provider, and
WebContainer using OfflineConfigEditor and configuration of <SAPSID>/Server <xxx>/
Services/Key Storage usingthevisual Administrator.
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Context

When to Use Option Adjust instancelD of an AS Java Instance

e Software Update Manager (SUM) fails due to incorrect parameter instanceID.

Example
An error like the following occurs during the upgrade of a Java system based on SAP NetWeaver 7.0x:

The detected instance ID IDXXXXX and the one calculated from the box number
IDXXXXX do not match. A possible reason for this could be that you have
changed the box number in the central instance instance.properties file.

e The installer (7/OSWPM#*SAR) fails due to incorrect parameter instanceID.

Example

An error like the following occurs during system copy, dual-stack split, or system rename of a Java
system based on SAP NetWeaver 7.0x with Software Provisioning Manager:

The source or target cluster ID is not present on the system! The current

(source) cluster ID is XXXXX and the new (target) cluster ID is XXXXX

® You are in doubt about consistency or correctness of the instanceID parameter of an AS Java instance.

Background Information About How Adjust instancelD of an AS Java Instance Works

Software logistics tools (Software Provisioning Manager (the" installer™), Software Update Manager) verify if
the instanceID parameter corresponds to the box number of an SAP system based on SAP NetWeaver AS for
Java. If the instanceID parameter is not consistent, Software Provisioning Manager fails.

The Box number has the format <SAPSID><instance name><host name>and is used as a parameter for
the instanceID generation. instanceIDis aunique identifier generated for each instance and is stored in
the SAP system database schema when creating a new Java system.

Aninconsistency between instanceIDand box number is caused by applying an unsupported procedure to
create or maintain the system. Using Software Provisioning Manager for system copy or system rename
(changing the <sapPSID>, host name, or instance name) guarantees consistency.

Adjust instancelD of an AS Java Instance changes the box number and instanceID inthe database and
synchronizes the instance.properties file
More Information

For more information, such as troubleshooting and FAQ, see SAP Note 2259748 Fr .

Procedure

1. Stop the AS Java instance or dual-stack instance and make sure that the database is running.

2. Start the installer and choose option Adjust instancelD of an AS Java Instance from the following path in the
Welcome screen:
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3.

|+ Software Life-Cycle Options ¥ Additional Preparation Options » Adjust instancelD of an AS Java
Instance 3
Caution

If the AS Java instance uses a virtual host name, start the installer with the installer property
SAPINST USE HOSTNAME as follows:

./sapinst SAPINST USE_HOSTNAME=<Virtual Host_ Name>

Follow the instructions given on the screens.

Next Steps

Perform the following activities after applying the correction:

L
2.
3.

Calculate the box number using the SAPTL.OCALHOST profile parameter in lower case.

Calculate the correct instanceID using the tool attached to SAP Note 1987497 .

Adapt the /usr/sap/<SAPSID>/<instance name>/j2ee/cluster/bootstrap/
bootstrap.properties file: Assign the instance.prefix property to the correct instanceID.
Examine the instance profile - if j2ee/instance id exists, change it to the new instanceID.

Openthe 0OfflineConfigEditor and expand cluster data

If the per fomerID property exists, change it to the new instanceID.

If you have EP: Knowledge Management and Collaboration installed on your system, you have to do the
following adjustments for the Scheduler Service:

Assign scheduler tasks to the new system IDs of the target system. This is required because after applying

the correction, tasks are still assigned to the IDs of the source system.
For more information, see SAP Help Portal at:

Release Path

o SAP NetWeaver 7.0:

o SAP NetWeaver 7.0 including EHP1:
o SAP NetWeaver 7.0 including EHP2:
o SAP NetWeaver 7.0 including EHP3: Package> > Application Help > SAP NetWeaver by Key

https://help.sap.com/viewer/p/SAP_NETWEAVER |
SAP NetWeaver 7.0 <Including Enhancement

Capability > Information Integration: Key Areas >
Knowledge Management » Administration Guide ¥
Minimal Configuration for Knowledge Management >

Cluster Only: Assigning Tasks to Nodes 4

Related Information

Running the Installer [page 38]
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8.8 Using PowerShell

SAP uses Windows PowerShell to run and describe Windows commands.

For Windows Server 2012 (R2) and higher, SAP only uses Windows PowerShell to run and describe Windows
commands.

Windows PowerShell is a powerful tool integrated in the Windows operating system. It uses object-oriented
methodology, which allows fast and stable script development.

For more information about the Windows PowerShell, see:
http://technet.microsoft.com/en-us/scriptcenter/dd742419.aspx #*
There you can find links to the online help, online documentation, scripting repository, downloads, and blogs.

If you want to use the PowerShell feature, note the following:

e Windows Server 2016
Windows Server 2016 contains PowerShell 5.0
You can update to PowerShell 5.0 (search the internet for Windows Management Framework 5.0).
e \Windows Server 2012 R2
Windows Server 2012 R2 contains PowerShell 4.0.
o Windows Server 2012
Windows Server 2012 contains PowerShell 3.0.
You can update to PowerShell 4.0 (search the internet for Windows Management Framework 4.0).
e Windows Server 2008 R2
Windows Server 2008 R2 contains PowerShell 2.0.
For more information about PowerShell 2.0, see http:/support.microsoft.com/kb/968929 # .
You can update to PowerShell 3.0 or 4.0 (search the internet for Windows Management Framework 3.0 or
Windows Management Framework 4.0).
e Windows Server 2008

You have to activate the PowerShell feature with |» Start » Administrative Tools ¥ Server Manager ¥

Features J.
On Windows Server 2008, you can update to PowerShell 3.0 (search the internet for Windows Management
Framework 3.0).

How to Start PowerShell

Caution

Make sure that you start the PowerShell in administrator mode.

e Windows Server 2012 (R2) and higher
Open the command prompt and enter the command:
powershell.exe
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To start PowerShell on Windows Server 2008 (R2), you have the following options:

® From the command prompt, by entering the command:
powershell.exe
® From the Start Menu:
o PowerShell 1.0:
Choose |+ Start » All Programs » Windows PowerShell 1.0 » Windows PowerShell 3.
o PowerShell 2.0:
Choose |# Start » All Programs » Windows PowerShell » Windows PowerShell 3.

How to Work with PowerShell

Most commands that are used in cmd . exe are also available in the PowerShell (defined as aliases).

You can use well-known commands, such as cd, type, copy, move, mkdir, delete, rmdir. Thereis also
online help available, which you can access by typing the command: help (or help <command>).

This is a list of differences between PowerShell and cmd . exe:

e Before you can run PowerShells scripts (text files with the file extension . ps1 that contain PowerShell
statements), you might have to change the default security setting to allow the execution of non-signed
scripts as follows:
set-executionpolicy ("unrestricted")

e By default, when double-clicking PowerShell scripts (. Ps1 files) in the Windows explorer, this does not
execute the script as is the default for . cmd files, but opens the script in an editor. If you want to activate
automatic script execution after a double-click, you have to change the value HKEY CLASSES ROOT
\Microsoft.Powershellscript.1\Shell\Open\Command from notepad.exe to the full path of the
PowerShell executable.

® The output of PIPE commands is not just a stream of characters (strings) but a stream of objects. You can
easily access the properties and methods for these objects (see the process list DLL example below).

e The current working directory is not part of the directory search path that the PowerShell looks at for
scripts and programs. The PowerShell only searches directories listed in the environment variable path.
Therefore, you might have to run a local program with . /sapcontrol.exe or specify its full path.

® You can use the UNIX-like directory delimiters, such as cd /usr/sap/C11.

e You can have your current working directory ina UNC path (cd \\sapglobalhost\sapmnt).

® The shell distinguishes between environment variables and shell variables:

o Use of shell variables:
Definition: $x="hello"
Reference: write-host $x

o Use of an environment variable:
Definition: $env:x="hello"
Reference: write-host $env:x

e The PowerShell has an interesting container concept called ps-drives. Within ps-drives you can
navigate in other objects, such as the registry or shell internal lists in the same way as you typically
navigate in a file system (cd, dir, del, andsoon).
dir env:togetalist of environment variables
dir variable:to get the list of shell variables
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dir HKLM: to get alist of registry keys in HKEY_LOCAL_MACHINE

get-psdrive to get alist of available ps-drives

e \Windows PowerShell has full access to the .NET runtime. You can directly access missing functions in the

PowerShell via .NET.

e With Windows PowerShell, you can create GUI-class user interfaces using Windows forms.

PowerShell Commands

The following table lists some PowerShell commands that are available on Windows Server 2012 (R2) and

higher:

Command

stop-service sap¥*

Explanation

Stops all Windows services with service name starting with
“SAP”

get-process

Lists currently started processes on your system

get-process | sort starttime | select - | Liststhelaststarted process onyour computer

last 1

get-process | sort starttime | select - |Listsall properties of the last started process

last 1 | format-list -proper *

get-process | sort starttime | select - | Listsall process class members (properties and methods) of
last 1 | get-member the last started process

get-process | %{$_.name;"----------—- "; Lists all processes, and the executables and DLLs the proc-
$ .modules} esses loaded

$processes = (get-process | sort Defines a shell variable $processes, which contains an ar-
starttime) ray of process objects

$processes.length

The number of processes in the array (is equivalent to the
number of processes on your computer)

$processes|[$processes.length-1] .kill ()

Invokes the kill method (terminate process) of the last
started process

(dir a.txt) .set_attributes("readonly")

Sets the file a. txt to “read-only”
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More information is available online as follows:

Title

Running an SAP System on IBM Db2 <Version> with
the Db2 pureScale Feature

Online Information from SAP

Internet Address

IBM Db2 10.5:
https://help.sap.com/viewer/db6_purescale_10_5
(PDF version here)

IBM Db210.1:
https://help.sap.com/viewer/db6_purescale_10_1

(PDF version here)

IBM Db2 High Availability Solution: IBM Tivoli System
Automation for Multiplatforms

https://help.sap.com/viewer/db6_samp

(PDF version here)

Database Administration Guide for SAP on IBM Db2
for Linux, UNIX, and Windows

https://help.sap.com/viewer/db6_admin

(PDF version here)

Database Administration Using the DBA Cockpit: IBM
DB2 for Linux, UNIX, and Windows

https://help.sap.com/viewer/db6_dbacockpit (English)
https://help.sap.com/viewer/db6_dbacockpit_de (German)

Also available in PDF format in English and German

SAP Business Warehouse on IBM Db2 for Linux,
UNIX, and Windows: Administration Tasks

https://help.sap.com/viewer/db6_bw

PDF version here

Enabling SAP Business Warehouse Systems to Use
IBM Db2 for Linux, UNIX, and Windows as Near-Line
Storage (NLS)

https://help.sap.com/viewer/db6_nls

(PDF version here)

Database Administration Guide for SAP on IBM Db2
for z/0S

https://help.sap.com/viewer/db2_administration_guide

Planning Guide for SAP on IBM Db2 for z/0S

https://heIp.sap.com/viewer/de_pIanning_guidefhr

SAP Security Guide for SAP on IBM Db2 for z/0S

http://help.sap.com/viewer/db2_security_guide P

SAP on Db2 for z/0S Community

https://www.sap.com/community/topic/db2-for-zos.htm|#
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https://help.sap.com/viewer/db6_purescale_10_5
https://help.sap.com/doc/37af60fafca14647a0628e5ca8ba1362/10_5/en-US/DB6_pureScale_10_5.pdf
https://help.sap.com/viewer/db6_purescale_10_1
https://help.sap.com/doc/ea8092cbdcc94a908c154f2136fb03b7/10_1/en-US/DB6_pureScale_10_1.pdf
https://help.sap.com/viewer/db6_samp
https://help.sap.com/doc/a7ba6b8cc8dc46309c2f93bcfc417133/CURRENT_VERSION/en-US/DB6_SAMP_Guide.pdf
https://help.sap.com/viewer/db6_admin
https://help.sap.com/doc/7367f81b468e4480b3c550669b3534aa/CURRENT_VERSION/en-US/DB6_Admin_Guide.pdf
https://help.sap.com/viewer/db6_dbacockpit
https://help.sap.com/viewer/db6_dbacockpit_de
https://help.sap.com/doc/8080298708d34d05a90b169e8442c39d/CURRENT_VERSION/en-US/dbacockpit_db6_en.pdf
https://help.sap.com/doc/8080298708d34d05a90b169e8442c39d/CURRENT_VERSION/de-DE/dbacockpit_db6_de.pdf
https://help.sap.com/viewer/db6_bw
https://help.sap.com/doc/d2b083b3327149deb93880831cf94555/CURRENT_VERSION/en-US/db6_bw_admin_en.pdf
https://help.sap.com/viewer/db6_nls
https://help.sap.com/doc/93a02f775ae4414f81069117ddd5a84e/CURRENT_VERSION/en-US/db6_nls_guide.pdf
http://help.sap.com/disclaimer?site=https%3A%2F%2Fhelp.sap.com%2Fviewer%2Fdb2_administration_guide
http://help.sap.com/disclaimer?site=https%3A%2F%2Fhelp.sap.com%2Fviewer%2Fdb2_planning_guide
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fviewer%2Fdb2_security_guide%20
http://help.sap.com/disclaimer?site=https%3A%2F%2Fwww.sap.com%2Fcommunity%2Ftopic%2Fdb2-for-zos.html

Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:

e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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go.sap.com/registration/
contact.html

© 2018 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any
form or for any purpose without the express permission of SAP SE
or an SAP affiliate company. The information contained herein may
be changed without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company
for informational purposes only, without representation or warranty
of any kind, and SAP or its affiliated companies shall not be liable for
errors or omissions with respect to the materials. The only
warranties for SAP or SAP affiliate company products and services
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